
ÄKTAcrossflow™
User manual

gelifesciences.com

http://gelifesciences.com


Table of Contents

1 Introduction .............................................................................................................. 5
1.1 Abbreviations and terminology ............................................................................................................ 6
1.2 Important user information ................................................................................................................... 7

2 ÄKTAcrossflow applications and crossflow processes ................................... 9
2.1 Principles of crossflow filtration ........................................................................................................... 10
2.2 ÄKTAcrossflow applications .................................................................................................................. 12

2.2.1 Ultrafiltration ......................................................................................................................................... 13
2.2.2 Microfiltration ....................................................................................................................................... 15

2.3 The ÄKTAcrossflow system ................................................................................................................... 17
2.3.1 Description of system operation ..................................................................................................... 18
2.3.2 Control modes ....................................................................................................................................... 19
2.3.3 Sensors and valves .............................................................................................................................. 23

2.4 Filters .............................................................................................................................................................. 24
2.5 Associated documentation ................................................................................................................... 25

3 System Preparation ................................................................................................ 26
3.1 Start the instrument ................................................................................................................................. 27
3.2 Start UNICORN and connect to the instrument ............................................................................. 28
3.3 Assembling filters ...................................................................................................................................... 33
3.4 The pump rinsing system ........................................................................................................................ 37
3.5 Selecting type of Retentate valve block ............................................................................................ 43
3.6 Calibrate the level sensor ....................................................................................................................... 46

3.6.1 Calibrate the level sensor using the Method Wizard ............................................................ 47
3.6.2 Manual calibration of the level sensor ........................................................................................... 50

3.7 Calibrate the transfer pressure sensor ............................................................................................. 52
3.8 Calibrate the pH electrode ..................................................................................................................... 53
3.9 Calibrate the conductivity cell .............................................................................................................. 55

4 Handling methods in the ÄKTAcrossflow .......................................................... 58
4.1 A UNICORN method .................................................................................................................................. 59
4.2 Creating a new method ........................................................................................................................... 61

4.2.1 Create crossflow methods using the Method Wizard ............................................................. 62
4.2.2 Create crossflow methods using Text Instructions .................................................................. 73

5 Perform crossflow runs manually ........................................................................ 85
5.1 Executing text instructions .................................................................................................................... 86
5.2 Monitoring the run ..................................................................................................................................... 89

6 Create preproduct steps using the Method Wizard ......................................... 92
6.1 Preproduct steps: Introduction ............................................................................................................ 93
6.2 Preproduct steps: Description .............................................................................................................. 94
6.3 Preproduct steps: Method Wizard dialogs ....................................................................................... 99

6.3.1 Basic settings dialog ........................................................................................................................... 100
6.3.2 Preproduct step dialog ....................................................................................................................... 106
6.3.3 Visualization of the preproduct steps ............................................................................................ 109

Table of Contents

2  ÄKTAcrossflow User manual 29360935 AA



7 Create product steps using the Method Wizard ............................................... 125
7.1 Ultrafiltration ............................................................................................................................................... 126

7.1.1 Introduction ........................................................................................................................................... 127
7.1.2 Basic settings dialog ........................................................................................................................... 128
7.1.3 Product steps dialog ............................................................................................................................ 129
7.1.4 Concentration step dialog ................................................................................................................. 132
7.1.5 Diafiltration step dialog ..................................................................................................................... 137
7.1.6 Recovery dialog .................................................................................................................................... 141

7.2 Microfiltration ............................................................................................................................................. 144
7.2.1 Introduction ........................................................................................................................................... 145
7.2.2 Basic settings dialog ........................................................................................................................... 146
7.2.3 Product steps dialog ............................................................................................................................ 147
7.2.4 Concentration step dialog ................................................................................................................. 150
7.2.5 Diafiltration step dialog ..................................................................................................................... 155
7.2.6 Recovery dialog .................................................................................................................................... 159

7.3 Visualization of product steps .............................................................................................................. 163

8 Create postproduct steps using the Method Wizard ....................................... 176
8.1 Introduction ................................................................................................................................................. 177
8.2 Postproduct steps: Description ............................................................................................................ 178
8.3 Postproduct steps: Method Wizard dialogs .................................................................................... 182

8.3.1 Postproduct step dialog ..................................................................................................................... 183
8.3.2 Visualization of the postproduct steps ......................................................................................... 187

9 Process optimization in Ultrafiltration ............................................................... 202

10 Running ÄKTAcrossflow methods ....................................................................... 209
10.1 Final preparations ..................................................................................................................................... 210
10.2 Start a run ..................................................................................................................................................... 213
10.3 During the run ............................................................................................................................................. 215
10.4 Manual sampling during the run ........................................................................................................... 216

11 Post run procedures ................................................................................................ 217
11.1 System sanitization .................................................................................................................................. 218
11.2 Viewing and printing the result ............................................................................................................. 224

12 Evaluating ÄKTAcrossflow results using Filtration Analysis ......................... 227
12.1 Open a result file in the Evaluation module .................................................................................... 228
12.2 Analysis operations ................................................................................................................................... 234

12.2.1 Process optimization .......................................................................................................................... 235
12.2.2 Diafiltration time optimization ........................................................................................................ 242
12.2.3 Normalized Water Flux (NWF) .................................................................................................... 245
12.2.4 Capacity plots ....................................................................................................................................... 249
12.2.5 Any vs Any ............................................................................................................................................ 254

13 Feedback tuning and PID parameters ................................................................. 257
13.1 PID control .................................................................................................................................................... 258
13.2 Description of the PI parameters and regulators .......................................................................... 262
13.3 Setting up feedback tuning .................................................................................................................... 263
13.4 Optimizing the PI parameters ............................................................................................................... 264

Table of Contents

ÄKTAcrossflow User manual 29360935 AA 3



14 Strategy instructions .............................................................................................. 268
14.1 System settings and instruction boxes ............................................................................................. 269
14.2 Recirculation instructions ...................................................................................................................... 272
14.3 Permeate instructions ............................................................................................................................. 280
14.4 Transfer instructions ................................................................................................................................ 289
14.5 Alarms, Warnings, and Monitors .......................................................................................................... 292
14.6 Fraction collector instructions .............................................................................................................. 310
14.7 Monitor UPC-980 ....................................................................................................................................... 311
14.8 Watch instructions ................................................................................................................................... 313
14.9 Calibration .................................................................................................................................................... 314

15 System components ............................................................................................... 317
15.1 Pump P-982 and P-984 ............................................................................................................................ 318
15.2 Valves ............................................................................................................................................................. 321
15.3 Reservoirs ..................................................................................................................................................... 326
15.4 pH electrode and cell holder .................................................................................................................. 328
15.5 Monitor UPC-980 and UV cell ................................................................................................................ 329
15.6 Conductivity cell ......................................................................................................................................... 330
15.7 Sensors .......................................................................................................................................................... 331

A Appendix A: Membrane and cartridge selection ............................................... 333

B Appendix B: Tubing specifications ....................................................................... 334

C Appendix C: Technical specifications .................................................................. 340

Index ................................................................................................................................... 346

Table of Contents

4  ÄKTAcrossflow User manual 29360935 AA



1 Introduction

About this manual
The ÄKTAcrossflow™ User Manual provides instructions for performing crossflow fil-
tration, also called tangential flow filtration, using the automatic ÄKTAcrossflow in-
strument and UNICORN™ software.

In addition to this manual, all users must also read the entire contents of the
ÄKTAcrossflow Operating Instructions before installing, operating or maintaining the
ÄKTAcrossflow system.

In this chapter

Section See page

1.1 Abbreviations and terminology 6

1.2 Important user information 7

1 Introduction
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1.1 Abbreviations and terminology
This section explains the abbreviations that appear in the user documentation for
ÄKTAcrossflow.

Term Explanation

Cartridge Also referred to as “Module” or “Cassette”; the unit encapsulat-
ing the membrane. The membrane can have different formats,
such as flat-sheet cassette or hollow fiber cartridge.

Flat sheet cas-
sette

Example of a unit encapsulating the membrane. A cassette has
at least one inlet (feed) and two outlets (retentate and perme-
ate).

Hollow fiber Example of a unit encapsulating the membrane, with a tube-
like structure made from a membrane and sealed inside a
crossflow cartridge, with one inlet (feed) and two outlets (re-
tentate and permeate).

Crossflow Also called tangential flow filtration. In crossflow filtration, the
feed solution flows parallel to the surface of the membrane.

Driven by pressure, some of the feed solution passes through
the membrane filter. Most of the solution is circulated back to
the feed tank or reservoir. The movement of the feed solution
parallel to the membrane surface helps to remove the buildup
of foulants on the surface.

Cut-off The effective pore size of the membrane. This is given in MWCO
(molecular weight cutoff) for ultrafilters and µm for microfilters.
The MWCO size designation for ultrafilters is given in Daltons (D
or Da) or kiloDaltons (kD or kDa), referring to the molecular
weight of an ideal globular protein that is 90% retained by the
membrane. No industry standard exists; hence the MWCO rat-
ings of different manufacturers are not always comparable.

Retentate The portion of the feed solution that does not pass through a
crossflow membrane filter and is returned to the feed tank or
reservoir.

Permeate Also called the filtrate. The portion of a process fluid that passes
through a membrane.

1 Introduction
1.1 Abbreviations and terminology
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1.2 Important user information

Read this before operating the
product

All users must read the entire Operating Instructions before installing, operat-
ing or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not operate the product in any other way than described in the user documenta-
tion. If you do, you may be exposed to hazards that can lead to personal injury and
you may cause damage to the equipment.

Intended use
ÄKTAcrossflow is intended for research use only, and shall not be used in any clinical
procedures, or for diagnostic purposes.

Safety notices
This user documentation contains WARNINGS, CAUTIONS and NOTICES concerning
the safe use of the product. See definitions below.

Warnings

WARNING
WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to pro-
ceed until all stated conditions are met and clearly understood.

1 Introduction
1.2 Important user information
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Cautions

CAUTION
CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly under-
stood.

Notices

NOTICE
NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your
procedures.

Typographical conventions
Software items are identified in the text by bold italic text. A colon separates menu
levels, thus File →Open refers to the Open command in the File menu.

Hardware items are identified in the text by bold text (e.g., Power switch).

1 Introduction
1.2 Important user information
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2 ÄKTAcrossflow applications and
crossflow processes

About this chapter
This chapter describes ÄKTAcrossflow applications and the principles of crossflow
filtration.

In this chapter

Section See page

2.1 Principles of crossflow filtration 10

2.2 ÄKTAcrossflow applications 12

2.3 The ÄKTAcrossflow system 17

2.4 Filters 24

2.5 Associated documentation 25

2  ÄKTAcrossflow applications and crossflow processes
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2.1 Principles of crossflow filtration

Normal flow filtration versus
crossflow filtration

The ÄKTAcrossflow system is designed for crossflow (also known as tangential flow
or “TFF”) operation. Unlike normal flow filtration, or dead-ended filtration, crossflow
methodology continuously sweeps the membrane surface by recirculating the feed
flow parallel to the surface. This sweeping action minimizes blinding of the mem-
brane and promotes consistent, long-term productivity. It also allows units to be
cleaned, stored, and re-used as needed. The illustration below shows the difference
between normal flow filtration and crossflow filtration.

Feed flow Crossflow

Permeate flowFiltrate flow

System flows
As the feed is pumped through the cartridge, the retentate (the material excluded by
the membrane pores) continues through the recirculation loop. The permeate, in-
cluding solvent and solutes, is transported through the membrane pores and is col-
lected separately. The illustration below shows the principle of crossflow filtration.

Retentate

Permeate

Feed

Permeate Individual 
membrane lumen

2  ÄKTAcrossflow applications and crossflow processes
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Filtration effects

Term Definition

QF, QR, QP Feed, retentate, and permeate flow, respectively (mL/min)

PF, PR, PP Feed, retentate, and permeate pressure, respectively (bar or psi)

The filtration effect in crossflow filtration is a result of the applied "transmembrane
pressure" (TMP).

The deltaP (ΔP) is the pressure drop between the feed (inlet) and the retentate (out-
let) of the cartridge:ΔP = PF - PR

The crossflow is proportional to the ΔP, if the permeate flow is zero.

QPermeate

QPermeate PP

PRPF

QFeed QRetentate
Crossflow

2  ÄKTAcrossflow applications and crossflow processes
2.1 Principles of crossflow filtration
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2.2 ÄKTAcrossflow applications

About this section
This section describes the processes of Ultrafiltration and Microfiltration.

In this section

Section See page

2.2.1 Ultrafiltration 13

2.2.2 Microfiltration 15

2  ÄKTAcrossflow applications and crossflow processes
2.2  ÄKTAcrossflow applications
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2.2.1 Ultrafiltration
Ultrafiltration (UF) is a pressure-driven, convective process that uses semipermeable
membranes to separate species by molecular size or shape. Removing solvent from
the solution results in solute concentration or enrichment. In ultrafiltration, species
that are smaller than the membrane pores pass through the membrane while spe-
cies that are larger are retained. UF membranes may also be used for diafiltration
(buffer exchange) to remove salts or other microspecies from a solution via continu-
ous dilution and re-concentration. The typical membrane cutoffs used in UF are 1 to
1000 to kD.

Concentration
A concentration step uses ultrafiltration membranes to reduce the volume of sample
in the reservoir. The target product, such as protein, is retained at the retentate side
of the membrane.

If the sample volume is larger than the reservoir volume, the reservoir can be contin-
uously fed with sample solution (“fed batch” concentration).

Ultrafiltration

Retentate Proteins

Permeate Small peptides and salts

Cutoff 1 to 1000 to kD

Diafiltration
A diafiltration step uses ultrafiltration membranes to remove salts or other microso-
lutes from a solution. Small molecules are separated from a solution while larger
molecules are retained in the retentate. Diafiltration is often also called buffer ex-
change, whereby the feed solution is continuously, or repeatedly, filled up with a buf-
fer. One buffer is removed and replaced with an alternative buffer.

A diafiltration or buffer exchange is typically run after a UF concentrating step using
the same filter as for the concentration step. The product is retained at the retentate
side, in the reservoir. Typical membrane cutoffs used for a diafiltration are 1 to 1000
to kD.

2  ÄKTAcrossflow applications and crossflow processes
2.2  ÄKTAcrossflow applications
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Ultrafiltration

Retentate Proteins (in new buffer)

Permeate Small peptides and salts (old buf-
fer)

Cut-off 1 to 1000 to kD

2  ÄKTAcrossflow applications and crossflow processes
2.2  ÄKTAcrossflow applications
2.2.1 Ultrafiltration
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2.2.2 Microfiltration
Microfiltration is a pressure driven convective process, intended to separate larger
insoluble particles (submicron size species) resulting in solution concentration or
clarification.

Microfiltration is usually an upstream recovery process where cells and cell debris
are separated from the other components in the solution, such as recombinant pro-
teins. The product can be the cells in the retentate or the clarified protein solution in
the permeate.

Typical cut-offs are 0.1 μm to 10 μm.

Microfiltration

Retentate Intact cells, cell debris

Permeate Colloidal material, viruses, proteins, and salts

Cut-off 0.1 μm to 10 μm

Cell harvesting
Cell harvesting is the process of concentrating or dewatering the cell mass after fer-
mentation. With cell harvesting, the cells are the target material and are recovered
as product in the retentate.

The concentration factor that can be achieved is based on the starting concentration
which can, in the case of yeast cells, be as high as 70% to 80% by cell weight. Typical
concetration factors are as follows:

• E. coli cells: 5× concentration

• Yeast cells: 2× concentration

• Mammalian cells: 10× to 20× concentration

Cell washing
The cells can also be prepared by diafiltration or washing, for example, for transfer in-
to a specific buffer for further processing, such as freezing or lysing. A cell washing
step can be performed together with cell harvesting.

The washing process is commonly a constant volume diafiltration process, in which
buffer is added to the cell suspension at the same rate as the permeate flow. After
washing, the ideal end product would consist of the concentrated cells suspended in
the buffer used to wash the cells. However, in practice the harvested cells and buffer
can contain varying levels of unwanted elements such as precipitated proteins, en-
zymes, and cell debris.

2  ÄKTAcrossflow applications and crossflow processes
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Lysate clarification
In a clarification step, cells, cell debris, or other insoluble matter are retained by the
membrane and the target product passes through the membrane into the permeate.
Clarification is often performed on lysed cells (lysate) to separate the cell debris from
the target product (usually recombinant proteins). Together with lysate clarification,
a diafiltration step can be performed to maximize target product recovery from the
lysate.

Membrane and cartridge
selection

In cell harvesting, microfiltration membranes will easily retain all cells. The key to
membrane selection is not based on retention, but on process optimization. For ex-
ample, smaller pore size membranes often provide the highest permeate flux once
the system is in a steady state. For more information on cartridge and tubing specifi-
cations, see Section B Tubing specifications, on page 334.

2  ÄKTAcrossflow applications and crossflow processes
2.2  ÄKTAcrossflow applications
2.2.2 Microfiltration
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2.3 The ÄKTAcrossflow system

About this section
This section describes the ÄKTAcrossflow system including the flow path, the sen-
sors and valves along the flow path, and the different control modes.

In this section

Section See page

2.3.1 Description of system operation 18

2.3.2 Control modes 19

2.3.3 Sensors and valves 23

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system
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2.3.1 Description of system operation
In the ÄKTAcrossflow system, the sample solution is loaded into the reservoir with
the transfer pump. The feed pump transports the solution to the filter unit. The flow
through the membrane is regulated by adjusting the transmembrane pressure via
the retentate pressure control valve (R-PCV). The remaining retentate flow, flowing
parallel to the membrane surface, is recirculated back to the reservoir. During a con-
centration step, the volume in the reservoir is allowed to decrease. If the entire feed
volume does not fit into the reservoir at the start of the concentration step, the
transfer pump continually transports extra feed material to the reservoir. This main-
tains a constant retentate volume. During a diafiltration step, the transfer pump
transports the new buffer to the reservoir continually to maintain a constant reten-
tate volume.

Flow path overview

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system
2.3.1 Description of system operation
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2.3.2 Control modes

Terminology

Term Definition

QF, QR, QP Feed, retentate, and permeate flow, respectively (mL/min)

PF, PR, PP Feed, retentate, and permeate pressure, respectively (bar)

TMP

Transmembrane pressure (bar or psi)

DeltaP Pressure drop (bar):ΔP = PF - PR

Flux (LMH) Permeate flow per membrane area:[l/h*m2 or LMH]QP = Per-
meate flow (l/h)A = Membrane area (m2)Flux =

Shear rate
(sec-1)

QF = Feed flow (mL/min)n = Number of fibersr = Fiber radius
(mm)Shear = 169.76527 × QF/n × r3

There are four filtration control modes on the ÄKTAcrossflow system:

• TMP control mode

• Flux control mode

• Permeate unrestricted flow

• Normal flow filtration

TMP Control mode

Control Mode:TMP Control Control Element:

Feed Pump Permeate
Pump

R-PCV

TMP control with constant feed
flowrate

QF > 0 Offset TMP

TMP control with constant retentate
flowrate

QR > 0 Offset TMP

TMP control with constant DeltaP PF - PR > 0 Offset TMP

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system

2.3.2 Control modes
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TMP control is usually used in ultrafiltration where the system must force the small
components in the feed through the relatively small pores of the membrane. The
control mode keeps one of the following options constant:

• constant feed flow

• constant retentate flow

• constant shear rate (hollow fibers only)

• constant deltaP

The TMP is mainly controlled by the retentate pressure control valve (R-PCV). The
TMP control mode adjusts the retentate control valve and permeate pump to main-
tain the chosen TMP. Before the activation of TMP control, deltaP must be stable.

During TMP control, the permeate pump acts as a flow meter, with a pressure offset
of 0.2 bar created by the permeate pressure control valve (P-PCV). This offset pres-
sure is used to avoid low or negative pressure on the permeate side, which may affect
the permeate pump’s function as a flow meter.

If TMP < ΔP/2, the permeate pump offset will automatically be changed. The TMP
control mode resets the other filtration control modes.

Note: The TMP must be optimized for different applications (filter and sample).

Flux control mode

Control Mode:flux
Control

Control Element:

Feed Pump Permeate
Pump

R-PCV

Flux control with con-
stant feed flowrate

QF > 0 Flux > 0 Offset, unrestric-
ted for PP > offset

Flux control with con-
stant retentate flowrate

QR > 0 Flux > 0 Offset, unrestric-
ted for PP > offset

Flux control with con-
stant shear rate (hollow
fibers only)

shear rate > 0 Flux > 0 Offset, unrestric-
ted for PP > offset

Flux control with con-
stant deltaP

PF - PR > 0 Flux > 0 Offset, unrestric-
ted for PP > offset

Flux control is usually used in microfiltration processes where the system restricts
the permeate flow through the relatively large pores of the membrane to prevent
rapid blinding of the membrane. The control mode keeps one of the following options
constant:

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system
2.3.2 Control modes
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• constant feed flow,

• constant retentate flow,

• constant shear rate (hollow fibers only),

• constant deltaP

In this mode, the TMP value is a function of the permeate flux.

If the permeate pressure is < 0.2 bar, the R-PCV closes to increase the retentate
pressure. When the permeate pressure is above 0.2 bar, the permeate pump can
start. A constant ramping during 60 sec. from flux 0 to the flux set point is performed.
During the ramping, the function for the R-PCV is to maintain the permeate pressure
above 0.2 bar.

Note: If the permeate pressure drops below 0.2 bar during the process, the R-PCV
valve will close to increase the permeate flow rate. A TMP limit alarm can be
set. If the system reaches the TMP limit when active, the system will pause.

Flux control resets the other filtration control modes.

Note: The flux control rate must be optimized for difference applications (filter
and sample).

Permeate unrestricted flow

Control Mode:permeate unre-
stricted flow

Control Element:

Feed Pump Permeate Pump R-PCV

With constant feed flowrate QF > 0 PR = PP (≥ = offset) PR

With constant retentate flowrate QR > 0 PR = PP (≥ = offset) PR

With constant shear rate (hollow
fibers only)

shear rate > 0 PR = PP (≥ = offset) PR

With constant deltaP PF - PR > 0 PR = PP (≥ = offset) PR

Permeate Unrestricted Flow (PUF) is a filtration control mode designed to mimic a
manual system, in which the PR and PP = 0. PUF starts the flow on the permeate pump
at the offset permeate pressure (0.2 bar default). If the retentate pressure > offset,
the retentate pressure value is used as a new offset. If retentate pressures < offset,
the retentate control valve lifts the retentate pressure to the offset value.

PUF is typically used only for nonproduct steps, for example, in the Method Wizard
created preproduct method (see Chapter 6 Create preproduct steps using the Method
Wizard, on page 92)

Permeate unrestricted flow resets the other filtration control modes.

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system
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Normal flow filtration
In normal flow filtration mode, the flow and pressure over the filter are controlled by
the feed pump only. In the permeate line, the permeate pressure control valve (P-
PCV) is fully opened. Because of this, liquid can move through the permeate pump
even though the check valves of the permeate pump are not active. To allow for a ho-
mogeneous flushing of the permeate pump heads during normal flow filtration, the
permeate pump is running idle at a low flow rate (20% of the feed flow rate) while liq-
uid is transferred by the feed pump.

The pressure over the normal flow filter (pNFF) is the difference between the feed
pressure and the permeate pressure.

pNFF = feed pressure - permeate pressure

Control Mode:normal
flow filtration

Control Element:

Feed Pump Permeate
Pump

R-PCV

NFF control with constant
feed flow

100% 20% of feed
flow

R-PCV: closed
P-PCV: open

NFF control with constant
feed pressure

Pump ramps up
to desired feed
pressure set
point (pNFF)

20% of feed
flow

R-PCV: closed
P-PCV: open

The normal flow filtration control mode is used to test the clean water flux or normal-
ized water filtration (NWF) for hollow fibers with a pore size cut off of 0.1 μm and
larger.

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system
2.3.2 Control modes
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2.3.3 Sensors and valves
The system contains several valves and sensors. There are sensors for:

• pressure

• conductivity

• UV absorbance

• pH

• temperature

• reservoir level

• air

The output from the sensors are monitored by the UNICORN control software during
the process run.

The sensors and valves are described in Chapter 15 System components, on page 317

Detailed illustration of the
system flow path

2  ÄKTAcrossflow applications and crossflow processes
2.3 The ÄKTAcrossflow system

2.3.3 Sensors and valves
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2.4 Filters
The ÄKTAcrossflow system supports the two most common crossflow filter designs,
hollow fibers and flat sheet cassettes, with surface areas suitable for flow rates up to
600 mL/min.

Hollow fibre filters
GE manufactures a complete selection of crossflow ultrafiltration and microfiltration
hollow fiber membranes. In addition, the Start AXM and AXH hollow fiber cartridges,
with a surface area of 40 or 50 cm2, are especially designed for the ÄKTAcrossflow in-
strument. These cartridges are configured for convenient linear scaling and to opti-
mize any candidate application around reproducible and predictable fluid mechan-
ics.

In the hollow fiber cartridge, the tube-like structure is made from a membrane and
sealed inside a crossflow cartridge. When in use, the feed stream flows into the inner
diameter of one end of the hollow fiber and the retentate flows out the other end.
The permeate passes through the membrane (the walls of the hollow fiber) and is
routed out of ports at the side of the cartridge.

Figure 2.1: Schematic of a hollow fiber filter

Hollow fibre filters with UNF fittings recommended for use with ÄKTAcrossflow are
shown in the following table.

For assembling instructions and ordering information, see the ÄKTAcrossflow Oper-
ating Instructions.

Flat sheet cassettes
In addition to hollow fiber cartridges, the ÄKTAcrossflow system has been designed
to work with flat sheet crossflow filter cassettes from a variety of manufacturers,
with surface areas up to approximately 1000 cm2.

2  ÄKTAcrossflow applications and crossflow processes
2.4 Filters
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2.5 Associated documentation
For a list of all associated system-specific and software documentation, refer to the
ÄKTAcrossflow Operating Instructions.

2  ÄKTAcrossflow applications and crossflow processes
2.5 Associated documentation
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3 System Preparation

About this chapter
This chapter contains information for preparing the ÄKTAcrossflow system and con-
necting it to UNICORN, as well as how to calibrate component parts.

In this chapter

Section See page

3.1 Start the instrument 27

3.2 Start UNICORN and connect to the instrument 28

3.3 Assembling filters 33

3.4 The pump rinsing system 37

3.5 Selecting type of Retentate valve block 43

3.6 Calibrate the level sensor 46

3.7 Calibrate the transfer pressure sensor 52

3.8 Calibrate the pH electrode 53

3.9 Calibrate the conductivity cell 55

3 System Preparation
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3.1 Start the instrument
To start the ÄKTAcrossflow system:

Step Action

1 Switch on the instrument at the mains power switch located on the rear
panel.

 

Mains power switch

Note:

The Power indicator on the front panel flashes slowly until the internal
communication with the CU (Control Unit) is established.

 

Power indicator

2 Switch on the power to the PC and the monitor.
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3.2 Start UNICORN and connect to the instrument
Follow the instructions to start UNICORN and log on to the program. A valid e-license
must be available for the workstation. See UNICORN Administration and Technical
Manual for more information about e-licenses.

Step Action

1 Double-click the UNICORN icon on the desktop.

Result:

The Log On dialog box opens.

Note:

If there is no connection to the database, it is still possible to log on to
UNICORN and control a running system. The Log On dialog box will give the
option to start System Control without a database. Click Start System
Control to proceed to the next Log On dialog box.

3 System Preparation
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Step Action

2 In the Log On dialog box:

a. Login as default user with password default.

Either

• Click a user name in the User Name list and enter the password in the
Password field.

Note:

It is also possible to select the Use Windows Authentication check box
and enter a network ID in the User Name box.

or
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Step Action

3 Select which UNICORN modules to start.

4 Click OK.

Result:

The UNICORN modules open.

Follow the instructions to connect the instrument to UNICORN.
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Step Action

1 In the System Control module either:

• Click on the Connect to Systems button,

or

• click Connect to Systems on the System menu.

Result:The Connect to Systems dialog box opens.
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Step Action

2 In the Connect to systems dialog box:

• Select the checkbox in front of the system name.

• To control the selected system, click Control.

Note:

Instruments that are turned off or disconnected from the network
appear dimmed and cannot be connected.

Tip:

To view the users currently connected to systems, either in control or
view

mode, click the Connected Users button.

3 When the communication between UNICORN and the instrument unit
is established:

• There is a constant light on the Power indicator on the instrument
unit.

• The Connection box shows Yes.

• The System state box shows Ready.
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3.3 Assembling filters

Prepare the filter for use

• UltrafiltrationUF filter units are shipped with an appropriate storage solution
within the pore structure to prevent drying of the membrane (see filter manufac-
turer for details). GE hollow fiber ultrafilter cartridges are shipped in an isopropa-
nol/glycerol solution. This mixture enhances wetting but may cause the fibers to
appear wavy. Trace amounts of isopropanol may remain when the cartridges are
shipped.

The glycerol must be thoroughly rinsed from the cartridge prior to use. In addition
to preventing drying, the glycerol minimizes entrained air within the pore struc-
ture of the membrane wall which may become “locked-in”, reducing permeability
until the air has been displaced by liquid.

• MicrofiltrationAlthough MF membrane cartridges are shipped dry, without pres-
ervative solutions (such as GE hollow fiber microfilter cartridges), it is recommen-
ded to rinse cartridges before first process exposure or heat sterilization.

For instructions on cleaning a hollow fiber filter cartridge and system prior to a filtra-
tion run, refer to Chapter 6 Create preproduct steps using the Method Wizard, on page
92.

Connect the Start AXM hollow
fibre cartridge

The Start AXM hollow fiber cartridge can be installed by connecting it to the hollow fi-
ber cartridge holder.

The holder is spring-loaded, and can be rotated 360° without loosening any screws. It
has fixed positions separated by 90°, (i.e., vertical or horizontal position). The holder
allows cartridge diameters from 3 to 23 mm.
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Install the filter on the instrument unit as follows:

Step Action

1 Attach the block to the holder.

Locking screw

Block

Holder

2 Carefully attach the cartridge in the holder by tightening the locking screw.

Connect tubing to the hollow
fibre cartridge

Connect the cartridge to the retentate, permeate and feed lines.

Note: To minimize holdup and working volume, the recommended tubing length
and diameter for use with the Start AXM hollow fiber cartridge, refer to Ap-
pendix A.
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UNF 5/16" 
Male

O-ring 3 x 1 mm
11-0025-47

 

Permeate

Retentate

P1L
R1L
F1L

  

F1L

Feed

Stop plug
UNF 5/16”

R1L

P1L
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Connect the Start AXH cartridge
The Start AXH cartridge can be installed by connecting it to the retentate, permeate
and feed lines, as shown in the illustration below. There is no need for a holder.

 

  

Retentate R1S

Feed F1S

Permeate P1S

Stop plug
UNF 5/16”

O-ring 3 x 1 mm

UNF 5/16”
Male

F1L
R1L
P1L

For details of recommended tubing, refer to Appendix A.

Connect a flat sheet cassette
For guidance on connecting a flat sheet cassette and holder, contact your local GE
representative.
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3.4 The pump rinsing system

Introduction
Leakage between the pump chamber and the pump drive mechanism is prevented
by a seal that is continuously lubricated by the presence of eluent. To prevent any
deposition of salts from aqueous buffers on the pump pistons and to prolong the life
of the seals, the low pressure chamber behind the piston is flushed continuously with
a low flow of 20% ethanol prepared in ultra pure water or equivalent.

The piston rinsing system tubing is connected to the rearmost ports on the pump
heads. The following illustration shows the tubing configuration of the piston rinsing
system.
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S8

S3S7S3

S6
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Rinsing
solution

Waste

Feed pump P-984

A B

Transfer & Permeate pump P-982

S4/S5

S3

S1/S2

Optional Path

Rinsing
solution

Waste

Although the seal prevents leakage between the pump chamber and the drive mech-
anism, “active transport” or movement of a very small amount of liquid between the
product to the rinse side is possible. To eliminate the risk of re-introducing proteins/
cells into subsequent batch runs, replace the rinse solution with fresh solution either
every day or between crossflow runs.When running the System Sanitization pro-
gram, the rinsing solution should be exchanged with 1M NaOH, followed by careful
rinsing with water and replacement of the solution with 20% ethanol.

The illustration below indicates the different components of the pump rinsing sys-
tem.
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Permeate bottles

Buffer bottles

Rinsing system bottle
Transfer & Permeate Pump

Rinsing system bottle
Feed pump

Retentate bottle

Using the pump rinsing system

To use the piston rinsing system:

Step Action

1 Fill the rinsing system bottles with 20% ethanol.

2 Insert the rinsing inlet and outlet tubing ends into the rinsing solution.

Note:

To eliminate the risk of re-introducing bacteria or other contaminants, use
the optional path with a separate waste bottle.

3 Fill the tubing with solution using a syringe that is connected to the outlet
tubing end.

4 Repeat steps 1 to 3 for all pumps.

Cleaning the pump piston rinsing
system

To clean the pump piston rinsing system use the following procedure

Step Action

1 Remove the rinsing solution bottles and empty them. Place the tubing in
waste containers.

2 Fill the bottles with freshly prepared rinsing solution (20% ethanol) and in-
sert the rinsing system tubing.
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Step Action

3 Connect the 3-way connector is connected to the feed, retentate, and
permeate lines in place of a filter.

4 In System Control, select Manual/Execute Manual Instructions.

5 Under Permeate/Total_Membrane_Surface_Area, set the membrane
area to 50 cm2 and click Execute.

6 Place transfer inlet 1 tubing into a 500 mL bottle of distilled water. Under
Manual, select this port under Transfer/Transfer_Valve_Block, and click
Execute.

7 Start the transfer pump at a flow rate of 200 mL/min to bring distilled wa-
ter into the reservoir. At the same time that the transfer flow starts, start a
FeedFlow of 400 mL/min

3 System Preparation
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Step Action

8 Stop the transfer pump after 1 minute when approximately 200 mL is in
the reservoir.

9 Open permeate valve block out 2.

10 Under Permeate/Flux_Control, set a flux rate of 800 LMH and pump for
two minutes.

3 System Preparation
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Step Action

11 Under Recirc/EmptyReservoir, select R-VB-Out1 as RetValveOutlet, set
MaxFeedPressure to 3.0 bar, and click Execute.

12 The system will stop when the reservoir is empty.
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3.5 Selecting type of Retentate valve block
The Retentate valve block type, old type or new type, must be selected in UNICORN.
If you are unsure which type of retentate valve block your system has, contact your
local GE office for support.

To select the Retentate valve block type, use the following procedure.

Step Action

1 In UNICORN Administration, select System Properties.
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Step Action

2 Select a system and click Edit.

3 Under Component types, select type of retentate valve block used from
the following options. either old type or new type.
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Step Action

4 Click OK to close the Edit System dialog.

5 Click Close to close the System Properties dialog.
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3.6 Calibrate the level sensor

About this section
This section provides instructions on how to calibrate the level sensor using either
the Method Wizard or by manually running the calibration program.

In this section

Section See page

3.6.1 Calibrate the level sensor using the Method Wizard 47

3.6.2 Manual calibration of the level sensor 50
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3.6.1 Calibrate the level sensor using the Method Wizard
The Method Wizard enables the creation of a method to automatically calibrate the
level sensor, which sets the zero level on the reservoir. The calibration should be per-
formed as needed, or when the level sensor is changed.

Step Action

1 In the Method Editor click the Create New Method icon.

2 In the System drop down menu, select ÄKTAcrossflow.

3 Select Method Wizard.

4 Click OK.
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Step Action

5 In the Basic Settings dialog, select Calibrate level sensor under the
Method drop down menu.

6 Click Finish

7 To run the method, first save the method in Method Editor and then, in
System Control, run the method Section 10.2 Start a run, on page 213.

3 System Preparation
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Note: If the level sensor is out of calibration, this method may not properly cali-
brate the level sensor. At the end of the method, if the reservoir is not emp-
ty, it might be necessary to manually empty the reservoir and manually set
the zero level on the sensor in System Control.
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3.6.2 Manual calibration of the level sensor
The reservoir level sensor can be calibrated using the Method Wizard or manually.

Using the Method Wizard to calibrate the level sensor is recommended because it re-
duces the risk of error and is more convenient. To calibrate the level sensor manually,
use the following instructions:

Note: When calibrating the level sensor, the liquid used must be at ambient tem-
perature.

Empty the reservoir

To manually calibrate the level sensor, the reservoir must first be emptied. To do this,
use the following procedure.

Step Action

1 Open the reservoir lid to allow air to flow freely into the reservoir.

2 In the System control dialog, select Manual →Execute Manual Instruc-
tions.

3 Under Recirc →EmptyReservoir, set RetVavleOutlet to R-VB-Out1 and
set MaxFeedPressure to 3.0 bar.

4 Click Execute

5 Wait until the reservoir is emptied.

Note:

The EmptyReservoir instruction empties the reservoir but not the small
cavity in the bottom of the reservoir. This cavity must also be emptied before
calibration.

6 Under Recirc →Retentate_Valve_Block, select R-VB-Out1 , then press
Execute.

7 Under Recirc →FeedFlow, enter 20 mL/min, then press Execute.
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Step Action

8 Check that the cavity in the bottom of the reservoir is completely empty.
Do not stop the flow.

Run level sensor calibration

To run the level sensor calibration, use the following procedure.

Step Action

1 In the System Control module, select System →Calibrate. The Calibra-
tion dialog appears.

2 In the Monitor box, select ZeroLS. Click the Start calibrate button to re-
set the level sensor reading to 0.

CAUTION
The reservoir level sensor is highly sensitive. Do not in-
sert any objects into the cavity in the bottom end plate
of the reservoir since this can damage the level sensor.

3 Under Manual →Execute Manual Instructions, select Recirc →FeedFlow.

4 Enter 0 mL/min in the FeedFlow box to stop the feed flow, then click Exe-
cute.

5 Under Recirc →Retentate_Vavle_Block, select R-VB-recycle and click Ex-
ecute.

6 Click Close.

7 Manually fill the reservoir with 50 mL of distilled water.

8 Empty the reservoir by selecting Recirc →EmptyReservoir →R-VB-Out1,
and enter 3 in the MaxFeedPress box and 600 in the MaxFeedFlow box.

9 Click Execute.

10 Click Close.
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3.7 Calibrate the transfer pressure sensor
In pressure sensor PT, the zero pressure-reading can be calibrated. The amplification
in sensors PT, PF, PR, and PP is already calibrated at the factory.

Calibration of the pressure sensor
PT

To calibrate the zero pressure-reading on the transfer pump, use the following in-
structions:

Step Action

1 In the System Control module, under Manual →Execute_Manual_In-
structions, select Transfer →Transfer_Purge_Valve and set to Waste.
Click Execute.

2 Under Transfer →Transfer_Valve_Block 1, select T-VB-In1. Click Exe-
cute.

3 Immerse the tubing from inlet T-VB-In1 in distilled water.

4 In the System Control module, select System →Calibrate.Result: the Cal-
ibration dialog appears.

Result:

In the System Control module, select System →Calibrate. dialog ap-
pears.

5 In the Monitor box, select TrfPress.

6 Click the Start calibrate button when the pressure is stable. The transfer
pressure has now been set to 0.

7 Press Close to finish calibration.

3 System Preparation
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3.8 Calibrate the pH electrode
A good laboratory routine is to calibrate the pH electrode at least once a day, when
the electrode is replaced, or if the ambient temperature is changed. The pH electrode
is calibrated using standard buffer solutions in a two point calibration. The two buffer
solutions may have any pH value as long as the difference between them is at least 1
pH unit, and the expected pH during the run is within this interval.

Note: The pH-calibration kit can be found in the Accessory box delivered with the
ÄKTAcrossflow.

To calibrate the pH electrode, use the following procedure.

Step Action

1 In the System Control module, select System →Calibrate.

2 Select pH from the Monitor dropdown menu in the Calibration window.

3 Prepare two reference buffer solutions, the first normally pH 7.0. The dif-
ference in pH value between them must be at least 1 pH unit. The expected
pH value during the run should be within this interval.

4 Use the holder on the front panel for the reference buffer solution contain-
ers.

Containers for reference 
buffer solutions

5 Remove the pH electrode from the cell holder and immerse the electrode
in the first reference solution.

Note:

To avoid leakage from the system after removing the pH electrode, replace it
with the pH electrode dummy.

6 Enter the known pH value of the solution in the Set the reference value
field.
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Step Action

7 The pH reading is shown under Current value. When the pH value has sta-
bilized, click Read value 1.

8 Rinse the electrode tip with distilled water and then immerse the elec-
trode in the second reference solution (e.g., pH 4.0 or 9.0).

9 Enter the known pH value of the second reference solution in the second
Set the reference value field.

10 When the pH value has stabilized, click Read value 2. The calibration is fin-
ished.

11 After the calibration, values are automatically entered into the Calibrated
electrode slope; %and Asymmetry potential at pH7; mV fields.

A new electrode has a slope of typically 95% - 102% and an asymmetry potential
within ±30 mV. As the electrode ages, the slope decreases and the asymmetry po-
tential increases.

As a rule, when the Asymmetry potential at pH7; mV value is outside of ±60 mV
and the Calibrated electrode slope; % value is lower than 80%, and no improve-
ment can be achieved by cleaning, the electrode should be replaced.

An electrode is still usable at lower slopes and higher asymmetry potentials but the
response will be slower and the accuracy diminished.

Before use, rinse the pH electrode using distilled water.

3 System Preparation
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3.9 Calibrate the conductivity cell

Enter a new cell constant

After replacing the conductivity cell, the cell constant has to be set. The cell constant
is shown on the packaging of the new cell.

Step Action

1 In the System Control module, select System →Calibrate and then
Cond_Cell in the Monitor dropdown menu.

2 Enter the cell constant in the Set the reference value field.

3 Click Read value 1. The new cell constant is updated. Click Close.

Calibrate the temperature sensor

Calibration of the temperature sensor in the conductivity cell is only necessary when
the cell is used in high accuracy measurements or if the cell is replaced.

Step Action

1 Make sure that the conductivity cell together with a precision thermome-
ter are not exposed to a draft. Leave them for 15 minutes to let the temper-
ature stabilize.

2 In the System Control module, select System →Calibrate and choose
Cond_Temp in the Monitor dropdown menu.

3 Read the temperature on the thermometer.

4 Enter the temperature in the Set the reference value field.

5 Click the Read value 1 button.
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Set up conductivity temperature
compensation

The conductivity of a buffer is temperature dependent. To relate conductivity to con-
centration and/or compare conductivity values, temperature compensation should
be used. The compensation consists of a compensation factor together with a refer-
ence temperature. All conductivity values will then automatically be converted to the
set reference temperature.

Step Action

1 In the System Control module, select System →Settings and click the
Monitors button.

2 Choose the instruction CondTempComp.

3 The factor is expressed in percentage increase of conductivity per °C in-
crease in temperature. If the temperature compensation factor is un-
known, a general approximate value of 2% can be set for many common
salt buffers. If no temperature compensation is needed, enter the value 0%
in the CompFactor field.

4 Choose the instruction CondRefTemp.

5 Select the reference temperature to which the measured conductivity val-
ues will be converted (normally 20 or 25 °C).

6 Enter an appropriate temperature in the RefTemp field.

7 Click OK.

Calibrate the cell constant

Normally it is not necessary to adjust the cell constant as the cell is precalibrated on
delivery. Adjustment is only necessary when replacing the conductivity cell with a cell
whose cell constant is unknown.

Note: The conductivity temperature compensation must not be used when ad-
justing the cell constant. Set the compensation factor to 0 (see section Set
up conductivity temperature compensation, on page 56). The temperature
sensor must be calibrated before adjusting the cell constant (see section 
Calibrate the temperature sensor, on page 55).

Step Action

1 Prepare a calibration solution of 1.00 M NaCl, 58.44 g/L. Let the solution
reach room temperature.
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Step Action

2 Fill the cell completely with the calibration solution by pumping at least 15
mL through the cell with a syringe.

3 When finished, wait for 15 minutes until the temperature is constant in the
range of 20°C to 30 °C.

4 In the System Control module, select System/Calibrate. Select
Cond_Cal in the Monitor dropdown menu.

5 Read the conductivity value displayed under Current value and compare it
with the theoretical value from the graph opposite at the temperature of
the calibration solution.

If the displayed value and the theoretical value correspond, no further ac-
tion is required.

If the values differ, proceed with steps 6, 7 and 8.

6

20 25 30
77

80

85

90

95

97

7 Enter the theoretical conductivity value according to the graph in the Set
the reference value field.

8 Click the Read value 1 button. The new cell constant is automatically cal-
culated and updated.
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4 Handling methods in the
ÄKTAcrossflow

About this chapter
This chapter describes how to create ÄKTAcrossflow methods in UNICORN.

In this chapter

Section See page

4.1 A UNICORN method 59

4.2 Creating a new method 61
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58  ÄKTAcrossflow User manual 29360935 AA



4.1 A UNICORN method

Phases and blocks
The Text pane in the Method Editor of UNICORN displays the method as a list of text
instructions. The instructions are usually organized into phases, denoted by blue
square symbols, for a specific functional use, for example to load a sample or to per-
form a concentration step. A phase can contain individual instructions or substruc-
ture in the form of blocks. The phases and blocks can be expanded to show the in-
structions within the block.

A method always starts with the Methods Settings phase.

To create a method, either

• use the Method Wizard creator, see Section 4.2.1 Create crossflow methods us-
ing the Method Wizard, on page 62 (recommended) or

• Use the User Defined phase in the Predefined Phase library to create new pha-
ses, see Unicorn User Manual for more information.

Note: User Defined is an empty phase designed for text editing methods.
Such phases may be saved in the personal or global phase library for
reuse in other methods.

4 Handling methods in the ÄKTAcrossflow
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Base
Every phase and block must start with a Base instruction, which defines the parame-
ter for calculating breakpoints. Different phases and blocks can use different bases.
In the ÄKTAcrossflow, the base can be one of the following:

• Volume (mL)

• Time (minutes)

• SameAsMain (all blocks apart from the main block), which means that the block
will use the base defined in the main block.

Note: Do not use Column Volume (CV) as base in ÄKTAcrossflow methods as it
is not relevant and will lead to incorrect methods.

Calls
To execute the instructions contained within a phase or block in a method, the phase
or block must be called by the program. When a phase or block is called, the instruc-
tions in the phase or block are executed in the order written until the phase or block
ends, or the End_Block instruction is executed. There are two types of calls:

• Unconditional calls, which are made with a Phase or Block instruction.

• Conditional calls, which are made with a Watch instruction. Watch instructions
allow a specified block or instruction to be called when a chosen monitor signal
meets a given condition.

Watch and Hold_Until
The breakpoint when the Watch instruction is issued determines when the watch
begins. A watch remains active until the condition is met or a new Watch instruction
is issued for the same monitor. The watch is cancelled automatically when the condi-
tion is met. A watch can also be turned off with the Watch_off instruction.

The Hold_Until instruction is a special kind of Watch instruction. The method is put
on hold until a specific condition is met (signal, test, or value), or the time-out is
reached. Afterwards, the remaining instructions in the method are executed.

4 Handling methods in the ÄKTAcrossflow
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4.2 Creating a new method

About this section
This section describes how to create a new ÄKTAcrossflow method in UNICORN by
using both the Method Wizard and the Text Instructions settings.

To create a new method, there are two alternatives:

• In the Method Wizard, customized methods for most purposes are made by set-
ting appropriate values for the method variables.

• In the Text Instructions editor in the Method Editor module, more advanced
editing facilities are available.

In this section

Section See page

4.2.1 Create crossflow methods using the Method Wizard 62

4.2.2 Create crossflow methods using Text Instructions 73
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4.2.1 Create crossflow methods using the Method Wizard
ÄKTAcrossflow methods are complex and include many steps which are best separa-
ted into phases, sub-blocks, and instructions. Therefore, using the Method Wizard to
build methods for different applications is recommended.

Create a new method

To create a new method using the Method Wizard in the Method Editor, use the fol-
lowing steps:

Step Action

1 Click the Create a new method icon in the UNICORN Method Editor.

4 Handling methods in the ÄKTAcrossflow
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Step Action

2 Select the ÄKTAcrossflow system, choose Method Wizard, and click OK.

Result:

A dialog of Basic Settings will be displayed.
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Step Action

4 Handling methods in the ÄKTAcrossflow
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Step Action

3 To obtain default values in the Method Wizard:

a. Click Set Default. This is only possible in the first dialog.

b. Choose between two filter types, either Hollow Fibre or Flat Sheet.

c. In the Method list, the type of process is selected

Note:

The system defaults to a Concentration/Diafiltration method, but other
methods are also available:

• Calibrate level sensor

• Installation Test

• System Sanitization

These methods are discussed in Section 3.6 Calibrate the level sensor, on
page 46, Section 11.1 System sanitization, on page 218, and the ÄKTAcross-
flow Installation Test Guide (11001235).
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Step Action

4 If Filter Type →Hollow Fibre has been selected, the Filter List will display
available GE hollow fibre filters.

a. Concentration/Diafiltration creates a standard ultrafiltration meth-
od.

b. UF Process Optimization creates a TMP and crossflow rate scouting
method. This process is discussed further in Chapter 9 Process optimi-
zation in Ultrafiltration, on page 202.

If Filter Type →Flat sheet has been selected, the filter type User-defined
filter is displayed in the Filter List window.
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Step Action

An additional choice of method type is available for flat sheet cassettes:

5 Below the Filter List, select the type of steps (Preproduct, Product,
and/or Postproduct) to include in the method.

6 If Filter Type →Hollow Fibre has been selected, the specifications are pre-
populted. These can be edited by the user.

If Filter Type →Flat sheet has been selected, the user must fill in the speci-
fication values for:

a. Surface area

b. Pore size

c. Filter hold-up volume

d. Feed pressure limit

e. TMP limit
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Step Action

7 In the System setup section:

a. Select the number of filters (only necessary when using several filters
assembled together in parallel).

b. Input any extra tubing volume used in the recirculation loop (e.g., when
connecting in a separate filter holder).

c. Select the reservoir size (350 mL or 1100 mL) and tubing kit (large i.d. or
small i.d.) used in the recirculation loop.

The inputs for filter hold-up volume, tubing i.d., and extra tubing volume are
used by the system to calculate the recirculation hold-up volume.

To get help instructions for each Method Wizard dialog, click Help or press
the F1 key.

To go back to the previous dialog, click Back.

To stop the Method Wizard, click Cancel.

To proceed with the next dialog, click Next.
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Step Action

8 In each dialog, select the appropriate parameter values and click Next to
continue. Continue with inputs on all dialog pages.

Finalize the method

After a series of dialogs (depending on the choice of preproduct, product, and post-
product), a Summary dialog is shown.

A list of calculated volumes of required solutions is displayed.

The sample volume includes 6 mL extra for priming, which will go to waste.

The diafiltration buffer volumes are not given; in cases where the sample load is ter-
minated by the air sensor, it is not possible to estimate these volumes. The end user
should calculate the required volumes and ensure that there is enough diafiltration
buffer to meet this requirement.
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Note: To prepare a run with correct solutions, it is recommended to print this list
using the Print button. This list will also be displayed in Method Notes.

To finish and save the method, use the following steps:

Step Action

1 Click Finish in the Summary dialog to finalize the creation of the new
method. UNICORN will create a complete method, with each step con-
tained with a sub-block of a User Defined phase.
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Step Action

2 To display the text instructions of the created method, click the Text In-
structions tab.

3 To view and expand the method, click on any plus sign.

Note:

The method can be edited in the Text Editor as described in Section 4.2.2
Create crossflow methods using Text Instructions, on page 73.

4 To save the method, select File →Save.

5 Select save location and enter a method name.

6 Select System.
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Step Action

7

Click OK.
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4.2.2 Create crossflow methods using Text Instructions
The Text Instructions editor in the Method Editor can be used to build methods
step by step. The editor can also be used to modify instructions in methods created
by the Method Wizard.

The first line of the empty method contains the main Base. The base provides a way
to progress to new instructions via breakpoints. Individual instructions can be added
into the method, but can only be added from inside a Phase. Methods are built up us-
ing phases, where each phase corresponds to a step in a filtration run. See UNICORN
Method Manual for more information about method structure, definitions, and con-
cepts of methods in UNICORN.

The principle of inserting an instruction in a method is as follows:

1. Enter the Breakpoint in minutes or volume (depending on base) for the instruc-
tion.

2. Select an individual instruction under the Instructions group.

3. Select the macro instruction in the dropdown list or enter the parameter.

4. Click Insert to add the instruction to the method.

Note: All Strategy instructions for the ÄKTAcrossflow are listed in Chapter 14
Strategy instructions, on page 268.

Create a new method

Use Text Instructions to create a method as follows:

Step Action

1 Select the Method Editor module in UNICORN.

2 To create the new method. click on the Create a new method icon in the
UNICORN Method Editor.
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Step Action

3 Select the ÄKTAcrossflow system, choose Empty Method, and click OK.

Result:

UNICORNwill create an empty method with a main base and mandatory
Method Settings phase.

4 Select the Text instructions tab to start building up the method.
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Step Action

5 Select the parameters for the base. Highlight the Main Base instruction
row.

UNICORN will automatically select the Instruction group Other and in-
struction Base in the Instruction Box.

6 From the drop-down menu, select the base type. For ÄKTAcrossflow, the
first base parameter can be either:

a. Time or

b. Volume

Note:

By default in UNICORN, Column Volume (CV) is set as the base. This is not
useful in ÄKTAcrossflow methods and will lead to incorrect methods.

Click Change.
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Add instructions to a method

To add instructions to the method, create a new phase using the following steps:

Step Action

1 Drag the User Defined phase in the Predefined Phases Library into the
Method Outline pane. Rename the phase if desired.

Result:

UNICORNinserts a new, empty phase into the method.

Note:

A separate base can be set for every phase. By default it will be set as Same
As Main, which refers to the base set in the first line of the method.
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Step Action

2 To insert instructions into the phase, highlight Base →SameAsMain and
select instructions from the Instruction Box at the bottom of the Method
Editor page.

3 Select the group of instructions, for example Transfer.

Note:

Instructions are grouped according to functionality: for example, Recirc
contains all of the relevant instructions for the recirculation pathway; Per-
meate contains the instructions to start the filtration process and control
the permeate pathway; and Transfer contains the instructions to bring liq-
uid into the reservoir. (See Chapter 14 Strategy instructions, on page 268 for
a description of the instructions).
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Step Action

4 Select an instruction within the group.

5 Enter a parameter value or select valve position from the dropdown menu.

6 Click Insert to place the instruction in the method.

7 To add second instruction, highlight the first instruction.

8 Select the desired instruction in the Text Instructions box
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Step Action

9 click Insert.Result:The new instruction will be added below the highlighted
instruction.

Result:

click Insert.The new instruction will be added below the highlighted in-
struction.

10 To delete an instruction row, select the row and click Delete.
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Step Action

11 By default, both instructions are executed by UNICORN at breakpoint 0 mi-
nutes. To introduce a delay in the execution of instructions, change the
breakpoint for the next instruction, and click Insert.

Note:

The instruction to end the phase, End_Block, automatically adjusts to the
new breakpoint. This instruction can be changed to further introduce delay
into the method. Highlight End_Block and in the Instruction Box, change
the breakpoint to 2 minutes, and click Change.
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Step Action
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Step Action

Note:

If the base in the phase is time, all breakpoints are given in time. If volume is
selected as base, the breakpoints will be given in volume.

12 Repeat steps 1 to 5 until all instructions are inserted in the method.

13 To change a breakpoint value or parameter in an instruction, highlight the
instruction, enter a new value, and click Change or Replace.

Note:

When changing parameters, the instructions both work in the same way.
However, when changing breakpoints, Change will recalculate all following
breakpoints to maintain the length of time or volume between instructions,
whereas Replace will not recalculate the breakpoints and will only change
the breakpoint for the highlighted instruction.

Tip:

To create separate steps within the method, create new phases for each
step.
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Finalize the method

Finalize and save the new method as follows:

Step Action

1 To end the method, select Instruction group Other and the instruction
End.

UNICORN will also automatically end when no other instructions are
present to execute.

2 To save the method, select File →Save.

3 Choose folder location, and select system.
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Step Action

4 Enter a method name and click Save.

Figure 4.1: Example of a simple ÄKTAcrossflow method
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5 Perform crossflow runs manually

About this chapter
This chapter contains information on how to perform and monitor ÄKTAcrossflow
methods manually without using the Method Wizard.

In this chapter

Section See page

5.1 Executing text instructions 86

5.2 Monitoring the run 89

Introduction
The most convenient way to perform crossflow runs is to use the Method Wizard to
create methods. However, it is always possible to perform process steps using the
manual mode in UNICORN via the System Control module.

Note: All Strategy text instructions and parameters are listed in Chapter 14
Strategy instructions, on page 268.
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5.1 Executing text instructions
To manually execute text instructions, use the following procedure.

Step Action

1 In the System Control window in UNICORN, select Manual →Execute
Manual instructions.

Result:

The Manual instructions dialog is displayed.

2 Select instruction group, for example, Transfer.

3 Select instruction, for example, Transfer_Valve_Blocks.

4 Select an inlet valve position from the drop-down menu.
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Step Action

5 Click Execute.

6 Select next instruction, for example TransferFlow.

7 Enter a parameter value, for example 50 mL/min.

8 Click Execute.

Note:

It is also possible to Insert a series of instructions into the Instruction exe-
cution list and click Execute so that UNICORN executes all instructions at
once. There are, however, some limitations in executing valve and pump in-
structions simultaneously on the ÄKTAcrossflow; therefore, it is recommen-
ded to execute each instruction individually.

9 To stop the operation, click the End or Pause button in the System Con-
trol window.

Safety precautions
General
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WARNING
Do not operate the ÄKTAcrossflow system at pressures above
the specified maximum pressure (5.2 bar).

WARNING
Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

CIP method

Be very careful when running a method using a CIP (clean-in-place) solution contain-
ing sodium hydroxide (NaOH).

WARNING
NaOH is corrosive and therefore dangerous to health. Avoid spill-
age and wear safety glasses, safety gloves, and protective lab
coat.

CAUTION
Always make sure that the filters and system components are
compatible with sodium hydroxide at the concentration, time,
and temperature used.
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5.2 Monitoring the run

Introduction
This section describes the data shown in System Control during a run and the pro-
cedure to customize the view of the different panes. It also describes how to enable
alarm and error notifications. It is possible to view the ongoing method run in the
System Control module.

The current system state is shown in the System state box in the Run Data pane.
For example, it may state Method Run, Manual Run, or Hold.

Selected curves are shown in the Chart pane.

The current flow path is shown in the Process Picture pane.

Note: To find an overview of the System Control user interface, see UNICORN 7
System Control Manual.

Open the Customize dialog
To customize displayed information and data in the different panes, use one of the
following options.

1. Either click the Customize button in the tool bar

or

2. Right click in the different panes (except Process Picture) and click Customize.

Result:The Customize dialog opens.

5 Perform crossflow runs manually
5.2 Monitoring the run

ÄKTAcrossflow User manual 29360935 AA 89



Note: Further information about the settings in the Customize dialog can be
found in the Online Help and in the UNICORN System Control manual.

To rearrange the display panes, drag and drop them to the desired location.

Example of displayed information:
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6 Create preproduct steps using the
Method Wizard

About this chapter
This chapter provides information on how to create preproduct steps using the
Method Wizard. Information is also provided about how to create preproduct meth-
ods for Ultrafiltration and Microfiltration using the Method Wizard.

In this chapter

Section See page

6.1 Preproduct steps: Introduction 93

6.2 Preproduct steps: Description 94

6.3 Preproduct steps: Method Wizard dialogs 99
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6.1 Preproduct steps: Introduction
The ÄKTAcrossflow Method Wizard can create a series of steps to make sure that a
filter is in the proper condition before performing a process run. These steps include:

• Rinsing

• Filter CIP (Clean-in-Place)

• Water Flush

• Water Flux Test (also called Normalized Water Permeability, or NWP)

• Buffer Conditioning

Different combinations of the steps above may be used.

If the system has not been sanitized recently, it may be necessary to start with a sani-
tization of the system (see Section 11.1 System sanitization, on page 218). A sanitiza-
tion of the system is also recommended when introducing new products (proteins,
viruses, or cells) to the system, to avoid cross-contamination.

The following table summarizes the recommended preproduct steps.

Condition Rins-
ing

Filter
CIP 1

Water
flush

Filter
CIP 2

Water
flush

Water
flux
test

Buffer
condi-
tioning

New filter × × ×

Same filter, after recom-
mended postproduct pro-
cedure with terminal wa-
ter flush and flux test, no
storage

×

Different filter, after rec-
ommended postproduct
procedure plus storage

× × ×
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6.2 Preproduct steps: Description

Rinsing
New ultrafilters are typically delivered in a storage solution such as glycerol, which
helps to prevent the filter from drying out. Microfilters are often delivered dry. Both
types of filters should be rinsed with water prior to use.

This step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste,

• Add a small volume of water to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Refill the reservoir to a small volume and flush 2 mL water per cm2 surface area of
the filter out through permeate valve block position 1 (P-VB-Out1),

• Empty the reservoir.

Note: Some hollow fibers do not wet out very well with water. If problems occur,
for example, if you experience a failed water flux test, it might be necessary
to flush the filter manually with an alcohol solution, such as 20% to 30%
isopropanol or 20% to 30% ethanol. For more information, refer to the Hol-
low fiber operating guide.

Filter CIP
A new filter does not necessarily need to be sanitized with a CIP step. However, if a fil-
ter is re-used, depending on the postproduct processing, a preproduct CIP step may
be desirable.

The filter CIP preproduct step includes an option to perform two filter CIP procedures
with an optional water flush between.

This step will:

• Prime the CIP transfer inlet valve positions tubing to waste,

Note: If CIP 1 only is chosen, only transfer valve block 6 (T-VB-In6) is primed;
if CIP 2 only is chosen, only transfer valve block 7 (T-VB-In7) is primed.
If both CIP 1 and 2 are selected, both inlets will be primed.

• Add CIP solution to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Either fill the reservoir to the maximum volume (small reservoir) or fill to a speci-
fied fill volume (large reservoir),

• Rinse 30 mL CIP solution to waste through P-VB-Out1,
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• Recirculate the permeate back into the reservoir for the Length of Time specified
in the dialog,

• Empty the reservoir.

The process is repeated if CIP 2 is chosen, with CIP 2 solution on T-VB-In7.

If a water flush is chosen between CIP 1 and 2, the system will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste,

• Add a small volume of water to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Refill the reservoir to a small volume and flush 10 mL water out through perme-
ate valve block position recycle (P-VB-Recycle) to waste (Trans-
fer_Purge_Valve to Waste),

• Empty the reservoir.

• Note: The system will not be sanitized. For sanitization of the system, see 
Section 11.1 System sanitization, on page 218

Water flush
A water flush step is identical to the rinse step, unless a CIP step has been selected. If
CIP is chosen, the water flush step will fill the reservoir to the maximum volume (350
mL for the small reservoir and 1100 mL for the large reservoir) and empty, to make
sure that the CIP solution has been removed. It is always recommended to select a
water flush after a filter CIP step where NaOH was used. This step should also be
used if a filter has not been rinsed with water before a water flux test is performed.

With no preproduct CIP, this step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste,

• Add a small volume of water to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Refill the reservoir to a small volume and flush 2 mL water per cm2 surface area of
the filter out through permeate valve block position 1 (P-VB-Out1),

• Empty the reservoir.

If following a preproduct CIP step, this step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste,

• Fill the reservoir to maximum volume (350 mL for the small reservoir and 1100
mL for the large reservoir) and empty,

• Add a small volume of water to the reservoir to rinse the retentate loop twice,

• Empty the reservoir,
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• Refill the reservoir to a small volume and flush 2 mL water per cm2 surface area of
the filter out through permeate valve block position 1 (P-VB-Out1),

• Empty the reservoir.

Water flux test
A water flux test measures the water permeability of a filter, to control the quality
status of the filter. A permeate flux value is often normalized to 1 bar transmem-
brane pressure and corrected to a temperature of 25°C, and is then called the nor-
malized water permeability (NWP; also called normalized water flux, or NWF). By
comparing obtained water fluxes as a function of usage over time, it is possible to de-
termine the cleaning efficiency of the filter CIP and lifetime of a filter.

Note: Always perform a water flush or rinse before a water flux test, to make sure
that the filter is thoroughly flushed with water.

It is recommended to perform the test before a product step and after a product step
and filter cleaning.

The filtration control mode is dependent on the filter type used.

For flat sheet cassettes, TMP control mode is used. The default TMP value is 1 bar, but
this can be edited by the user.

For ultrafilter hollow fibers, TMP control mode is used. The default TMP value is 1 bar,
but this can be edited by the user. It is recommended to set the TMP value to 0.5 bar
or lower for high molecular weight hollow fiber ultrafilters (≤ 500 kD).

For microfilter hollow fibers (cut off larger than 0.1 µm), Normal Flow Filtration
mode is used. Feed flow or Feed pressure can be selected as a feed control and a
value is entered.

This step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste,

• Add a small volume of water to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Fill a small volume of water to the reservoir,

• Set the system to total recycle (P-VB-Recycle, Transfer_Purge_Valve to Reser-
voir),

• Set the filtration control mode and wait until the flux has stabilized,

• Measure the permeate flux and set a Set_Eval_Mark with the parameter
Normalized_Water_Flux for easy analysis in the Evaluation module.
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Data from water flux testing can be analyzed in the Evaluation module of UNICORN.
In Figure 6.1, on page 97, normalized water flux results from a series of measure-
ments are plotted against the number of performed runs with a filter. A standardized
temperature correction table compensates for temperature effects due to viscosity.
Results are compared to previous tests and provide information about the quality
status of the filter.

Figure 6.1: Example of plotted normalized water flux values

Note: Some hollow fibers do not wet out very well with water. If problems occur,
for example, if the water flux test fails, it may be necessary to flush the filter
manually with an alcohol solution, such as 20% to 30% isopropanol or 20%
to 30% ethanol. For more information, refer to the Hollow Fiber Operating
Guide.

Note: When comparing status of a filter as a function of time and number of uses,
use the same filtration mode parameter each time the water flux test is run.

Buffer conditioning
The buffer conditioning step replaces the liquid in the filter with a buffer that is suita-
ble a processing step with product. The buffer conditioning step will:

• Prime the transfer inlet valve position 2 (T-VB-In2) tubing to waste,

• Add a small volume of buffer to the reservoir to rinse the retentate loop,

• Empty the reservoir,

• Fill a small volume of buffer to the reservoir,

• Flush the filter with the selected volume, through permeate recycle to waste (P-
VB-Recycle, Transfer_Purge_Valve to Waste),

• Set the system to total recycle (P-VB-Recycle, Transfer_Purge_Valve to Reser-
voir) for 5 minutes,
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• Empty the reservoir.

Note: If a CIP has been performed, we recommend performing a buffer condition-
ing after the water flush to ensure that the pH in the system is suitable for
any following product steps.
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6.3 Preproduct steps: Method Wizard dialogs

About this section
This section provides information on how to create preproduct steps in the Method
Wizard when using hollow fibres and flat sheet cassettes, and provides a description
of each step.

In this section

Section See page

6.3.1 Basic settings dialog 100

6.3.2 Preproduct step dialog 106

6.3.3 Visualization of the preproduct steps 109
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6.3.1 Basic settings dialog

Basics settings dialog overview
The image below shows an example of the Basic Settings dialog.

Basic Settings →Hollow Fibre

To enter the basic settings for use with hollow fibre filters, use the following proce-
dure:

Step Action

1 In Basic Settings, select Hollow Fibre.
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Step Action

2 In the Method list, select Concentration/Diafiltration.

3 In the Filter List, compatible GE hollow fiber filters are displayed. Select
the desired filter, or if using a hollow fiber from another manufacturer, se-
lect User-defined filter.

4 Select Preproduct process step.
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Step Action

5 The Hollow Fibre (specification per filter) area displays the recommen-
ded default values for the selected filter. The values can be edited as de-
sired.

Note:

If User-defined filter has been selected, enter the lumen diameter, number
of fibers, surface area, lumen hold-up volume, feed pressure limit, and TMP
limit. This information is usually available from the manufacturer.

Note:

When using TMP as the filtration control mode in a method, always choose
a TMP value in the product steps that is below the TMP limit. Otherwise, the
TMP limit may lead to a TMP pressure alarm, which will pause the run.

6 If several filters are assembled together in parallel, select in the System
setup section the number of filters (1 to 3). If only one filter is used, keep
the default value of 1.

7 If any extra tubing is used on the recirculation loop, calculate the extra vol-
ume added and enter the value in the Extra Tubing Volume box.
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Step Action

8 Select the reservoir size and tubing kit i.d. used in the recirculation loop.

Basic Settings →Flat Sheet

To enter the basic settings for use with flat sheet filters, use the following procedure:

Step Action

1 In the Basic Settings window, select Filter Type →Flat Sheet.

2 In the Method drop-down list, select Concentration\Diafiltration.

3 In the Filter List, User-defined filter is auto selected.

4 In the next list, select Concentration/Diafiltration.
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Step Action

5 Select Preproduct process step.

6 The Flat Sheet (specification per filter) displays the default values for a
user-defined flat sheet cassette. The end user must enter values for the
following information:

a. Surface Area

b. Pore Size

c. Filter Hold-Up Vol

d. Feed Pressure Limit

e. TMP Limit

This information is usually available from the manufacturer.

Note:

When using TMP as the filtration control mode in a method, always choose
a TMP value in the product steps that is below the TMP limit. Otherwise, the
TMP limit may lead to a TMP pressure alarm, which will pause the run.

7 If several filters are assembled together in parallel, select in the System
Setup section the number of filters (1-3). If only one filter is used, keep the
default value of 1.
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Step Action

8 If any extra tubing is used on the recirculation loop, calculate the extra vol-
ume added and enter the value in the Extra Tubing Volume box.

9 Select the reservoir size and tubing kit i.d. used in the recirculation loop.
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6.3.2 Preproduct step dialog

Rinsing

To include a rinsing step in the method, use the following procedure:

Step Action

1

Check the Rinsing box.

2 Select the rinsing volume; this is the volume of water which will be flushed
through the filter into the permeate. The default value is 2 mL per cm2 of fil-
ter surface area.

Filter CIP

To include a filter CIP step in the method, use the following procedure:

Step Action

1 Check the Filter CIP box.

2 Select either a one- or two-step CIP, with an optional water flush in be-
tween.

3 Enter the desired CIP circulation time in the Length of Time box.

Water flush

To include a water flush step in the method, use the following procedure:

Step Action

1 Check the Water Flush box.

6 Create preproduct steps using the Method Wizard
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Step Action

2 Select the flush volume; this is the volume of water which will be flushed
through the filter into the permeate. The default value is 2 mL per cm2 of fil-
ter surface area.

Note:

After a filter CIP, it is recommended to run a water flush.

Note:

If a water flux test will be performed, Rinsing or Water Flush should be per-
formed just before the water flux test.

Water flux test

To include a water flux test in the method, use the following procedure:

Step Action

1 Check the Water Flux Test box.

2 Select TMP or NFF (Normal Flow Filtration) as control mode.

a. The default TMP setting for all ultrafilters is 1 bar. For high molecular
weight hollow fiber ultrafilters (≥ 500 kD), it is recommended to set this

value to 0.5 bar.

b. NFF (feed pressure) is default for microfiltration hollow fibers with a cut
off of 0.1 μm and larger.

c. NFF control of feed flow is also possible.

Note:

When comparing status of a filter as a function of time and number of ex-
periments, we recommend using the same filtration mode parameter each
time you run the water flux test.
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Buffer conditioning

To include a buffer conditioning step in the method, use the following procedure:

Step Action

1 Check the Buffer Conditioning box.

2 Select the buffer rinse volume; this is the volume of buffer which will be
flushed through the filter into the permeate. The default value is 30 mL.
This can be edited to a maximum value of 300 mL for the small reservoir or
1000 mL for the large reservoir.

Note:

If a CIP has been performed, we recommend performing a buffer condition-
ing after the water flush to ensure that the pH in the system is suitable for
any following product steps.

6 Create preproduct steps using the Method Wizard
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6.3.3 Visualization of the preproduct steps
For information on specific instructions, for example Constant Retentate Volume,
see Chapter 14 Strategy instructions, on page 268.

Depending on the previous step, some of the steps begin with a Prepare System or
Prepare System and Reservoir block.

Prepare System and Reservoir
The Prepare System and Reservoir step fills and empties the reservoir completely
and thoroughly flushes the recirculation loop. The inlet valve position chosen de-
pends on the liquid of the specific step.

Stage Description

1 The transfer inlet used is primed to waste through the transfer purge
valve.

2 The reservoir is filled to the maximum volume (350 mL for the small res-
ervoir, 1100 mL for the large reservoir).

6 Create preproduct steps using the Method Wizard
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Stage Description

3 The reservoir is emptied through R-VB-Out2 (waste).

4 The reservoir is filled to a minimum working volume. A low transfer and
equal feed flow is set, and 50 mL is pumped out of the retentate to
waste through R-VB-Out2.

5 The tubing in the pathway between R-VB-Out2 and the reservoir is
rinsed by recirculating at a low feed flow rate for less than a minute.

6 Create preproduct steps using the Method Wizard
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Stage Description

6 The reservoir is emptied and refilled with the minimum working vol-
ume.

7 A low transfer and equal feed flow is set, and 50 mL is pumped out of
the retentate to waste through R-VB-Out2.

8 The reservoir is filled to a low volume.

6 Create preproduct steps using the Method Wizard
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Stage Description

9 The retentate is recirculated for one minute using a feed pressure con-
trol of 80% of the maximum feed pressure value (to a maximum of 3
bar).

10 The reservoir is emptied through R-VB-Out2.

Prepare system
The Prepare System step performs a flush of the recirculation loop.
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Stage Description

1 The transfer inlet used is primed to waste through the transfer purge
valve.

2 The reservoir is filled to a low volume.

3 The retentate is rinsed out R-VB-Out2 for the hold-up volume plus 5
mL.

6 Create preproduct steps using the Method Wizard
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Stage Description

4 The retentate is recirculated for one minute using a feed pressure con-
trol of 80% of the maximum feed pressure value (to a maximum of 3
bar).

5 The reservoir is emptied through R-VB-Out2 (Waste).

Rinsing
The Rinse step rinses storage solution from the filter.

Stage Description

1 The system is prepared according to the procedure described in Prepare
system, on page 112. The transfer inlet used is T-VB-In5 (water).
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Stage Description

2 The reservoir is filled with 100 mL water. Constant Retentate Volume
is activated. The crossflow rate is set at a feed pressure 80% of the max-
imum feed pressure value (to a maximum of 3 bar) and TMP regulation
of 1 bar is started. The volume input in the dialog is rinsed through the
filter out P-VB-Out1 (Waste).

3 Constant Retentate Volume is disabled. 10 mL of the reservoir vol-
ume is emptied through the permeate recycle (P-VB-Recycle) to waste
(Transfer_Purge_Valve Waste).

6 Create preproduct steps using the Method Wizard
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Stage Description

4 The rest of the reservoir volume is emptied through R-VB-Out2 and the
rinsing is complete.

Filter CIP
The Filter CIP step circulates cleaning solution to clean the system and the filter.

Stage Description

1 The system is prepared according to the procedure described in Prepare
system, on page 112. The transfer inlet used is T-VB-In6 or T-VB-In7
(CIP solution), depending on whether 1 or 2 CIP steps were selected.

2 The reservoir is filled with CIP solution to either the maximum volume
(small reservoir, 350 mL) or a specified fill volume (large reservoir, mini-
mum 200 mL (default) to 1100 mL).

3 Constant Retentate Volume is activated and the permeate valve is
opened to P-VB-Out1. The crossflow rate is set at a feed pressure of
80% of the maximum feed pressure value (to a maximum of 3 bar) and
flux rate filtration control of 30 LMH (flat sheet cassette, HF microfilter)
or TMP filtration control of 1 bar (HF ultrafilter) is started.

6 Create preproduct steps using the Method Wizard
6.3 Preproduct steps: Method Wizard dialogs
6.3.3 Visualization of the preproduct steps

116  ÄKTAcrossflow User manual 29360935 AA



Stage Description

4 The first 30 mL passes through the membrane out P-VB-Out1.

5 After 30 mL has passed through the membrane, the permeate valve is
set to P-VB-Recycle and the liquid is recycled back into the reservoir
for the specified recirculation time.

6 After the specified CIP recirculation time, Constant Retentate Volume
is disabled and the reservoir is emptied through R-VB-Out2.

6 Create preproduct steps using the Method Wizard
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Stage Description

7 If a Water Flush between CIP has been selected, the system is pre-
pared according to the procedure described in Prepare system, on page
112. The transfer inlet used is T-VB-In5 (water).

8 The reservoir is filled with 100 mL of water and 10 mL of the reservoir
volume is emptied through the permeate recycle (P-VB-Recycle) to
waste (Transfer_Purge_Valve Waste).

9 The reservoir is then emptied through R-VB-Out2.

10 If a CIP 2 step has been selected, the system is prepared according to
the procedure Prepare System described in Prepare system, on page
112. The transfer inlet used is T-VB-In7 (CIP 2 solution).

11 The reservoir is filled with either 100 mL CIP 2 solution (small reservoir)
or the specified fill volume (large reservoir) and the procedure descri-
bed above in steps 3 to 6 is repeated.

6 Create preproduct steps using the Method Wizard
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Water flush
If the previous step was a filter CIP, the system and reservoir are thoroughly flushed
according to the procedure described in Prepare System and Reservoir, on page 109

Otherwise, the system is prepared according to the procedure described in Prepare
system, on page 112. The transfer inlet used is T-VB-In5 (water).

Stage Description

1 The reservoir is filled with 100 mL water. Constant Retentate Volume
is activated, and the permeate valve is opened to P-VB-Out1. The
crossflow rate is set at a feed pressure 80% of the maximum feed pres-
sure value (to a maximum of 3 bar) and flux rate filtration control of 30
LMH (HF microfilter) or TMP filtration control of 1 bar (HF ultrafilter, flat
sheet cassette) is started. The filter is flushed with specified flush vol-
ume out P-VB-Out2 (default volume is 2 mL per cm2 of filter surface
area).
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Stage Description

2 After the specified flush through the filter, Constant Retentate Vol-
ume is disabled. If a Water Flux Test has been selected, the system
skips to the test; if not, 10 mL is emptied through the filter. P-VB is set
to Recycle and the liquid leaves the system through Trans-
fer_Purge_Valve Waste.

3 The reservoir is emptied through R-VB-Out2.

Water flux test
If the step prior to the water flux test is a water flush step, the reservoir remains filled
and the Water Flux Test is a continuation of the Water Flush step. If the water flux
test is used as a stand-alone step, the system is prepared according to the procedure
described in Prepare system, on page 112. The transfer inlet used is T-VB-In5 (wa-
ter). The reservoir is filled with 50 mL water, Constant Retentate Volume is activa-
ted, and the permeate valve is opened to P-VB-Out1.
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Stage Description

1 P-VB is set to Recycle and the Transfer_Purge_Valve is set to Reser-
voir. A permeate flow is started by the specified TMP control (HF ultra-
filter, flat sheet cassette; default value 1 bar) or in NFF mode (HF micro-
filter; default value is feed pressure, determined by the filter pore size).
When a stable flux has been achieved, the normalized water flux value
is measured by setting a Set_Eval_Mark with the parameter Normal-
ized_Water_Flux.

2 Before ending the step, 10 mL of water is flushed through the filter. P-
VB is set to Recycle and the liquid leaves the system through Trans-
fer_Purge_Valve Waste.
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Stage Description

3 The reservoir is then emptied through R-VB-Out2.

Buffer conditioning
The Buffer conditioning step conditions filter and system components before add-
ing product to minimize adverse chemical reactions.

Stage Description

1 The system is prepared according to the procedure described in Prepare
system, on page 112. The transfer inlet used is T-VB-In2 (conditioning
buffer). The reservoir is filled with a small volume of buffer.
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Stage Description

2 P-VB is set to Recycle and the Transfer_Purge_Valve is set to Waste.
The crossflow rate is set at a feed pressure 80% of the maximum feed
pressure value (to a maximum of 3 bar) and flux rate filtration control of
30 LMH (HF microfilter) or TMP filtration control of 1 bar (HF ultrafilter,
flat sheet cassette) is started. The specified buffer rinse volume is flush-
ed through the filter into the permeate (default value is 30 mL, but this
can be edited to a maximum value of 300 mL for the small reservoir or
1000 mL for the large reservoir).

3 The Transfer_Purge_Valve is switched to Reservoir and the buffer is
recycled for 5 minutes.
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Stage Description

4 The reservoir is emptied through R-VB-Out2.
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7 Create product steps using the
Method Wizard

About this chapter
This chapter provides information on how to create product steps for ultrafiltration
and microfiltration using the Method Wizard.

In this chapter

Section See page

7.1 Ultrafiltration 126

7.2 Microfiltration 144

7.3 Visualization of product steps 163
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7.1 Ultrafiltration

About this section
This section provides information on how to create product methods for Ultrafiltra-
tion using the Method Wizard.

In this section

Section See page

7.1.1 Introduction 127

7.1.2 Basic settings dialog 128

7.1.3 Product steps dialog 129

7.1.4 Concentration step dialog 132

7.1.5 Diafiltration step dialog 137

7.1.6 Recovery dialog 141
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7.1.1 Introduction

Concentration
During a concentration step, the volume of sample in the reservoir is reduced. The
product is retained at the retentate side of the membrane.

If the sample volume is larger than the reservoir volume, the reservoir can be contin-
uously fed with sample solution (Fed Batch).

Diafiltration
Diafiltration is a filtration process used for the removal of smaller ionic solutes, in
which one buffer is removed and replaced with an alternative buffer (Buffer Ex-
change). The product is retained at the retentate side.

A buffer exchange is typically run after a concentrating step using the same filter. This
allows for the combination of concentration and diafiltration into one method, using
one filter.

If no concentration is performed before a diafiltration step, for example, when diafil-
tration is the only step, the hold-up volume on the retentate side will dilute the sam-
ple. Therefore, if performing a diafiltration first, it is recommended to perform an ini-
tial concentration, especially when the sample volume is low. Enter a Concentration
Factor of 1 as the end point. See Concentration endpoint, on page 134.

Product recovery after
Concentration/Diafiltration

There are two alternatives to recover the product in the retentate:

• No Recovery: select this option if the retentate volume will be recovered man-
ually. The system will enter a Hold with a low recirculation rate to prevent sedi-
mentation, allowing the user to either recover immediately, or end the method
and then recover.

• Recovery: the reservoir is first emptied through R-VB-Out3, followed by a buffer
chase, allowing the maximum volume of undiluted sample to be recovered. A de-
fined number of flushes can then be selected and the retaining dilute product will
be emptied through R-VB-Out1.

For descriptions of the Recovery procedures, see Section 7.1.6 Recovery dialog, on
page 141.
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7.1.2 Basic settings dialog
Input the basic settings (filter type, specifications, tubing kit i.d., and size of reservoir)
as detailed in Section 6.3.1 Basic settings dialog, on page 100.

Select Product in the Steps selection.

7 Create product steps using the Method Wizard
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7.1.3 Product steps dialog
The following illustration shows the product steps dialog screen.

In the Product Steps dialog, a minimum working volume is displayed. The minimum
working volume is the system hold-up volume including the filter hold-up, with an ad-
dition of a small volume in the reservoir. This volume depends on the reservoir size,
tubing kit, and filter volume. This is the lowest working volume that is recommended.

Note: Minimum working volume will vary with reservoir size and tubing kit used
and is not the same as the system hold-up volume. To maintain smooth
processing, a small volume is added to the system hold-up volume in the
calculation of minimum working volume. For information on system hold-
up volume, see Appendix A.
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To set the concentration and diafiltration parameters, follow the steps below.

Step Action

1 In the Product Steps dialog, select up to 3 concentration and diafiltration

steps. 

Note:

For diafiltration, only 2 steps can be selected with any combination of steps;
this is due to the limited number of transfer valve block inlets that are used
as standard for diafiltration buffer.
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Step Action

2 Enter the sample volume. There are 3 options:

a. Enter a set volume.

Note:

If you enter a volume greater than the maximum volume of the chosen
reservoir, on the next page a Fill Volume must be entered, and the sys-
tem will operate in Fed Batch mode. In this case, the reservoir is continu-
ally refilled as a function of the permeate flow. This is possible only when
concentration is the first step. If the total sample volume fits into the
chosen reservoir size, the system will operate in Tank Batch mode.

b. Enter a set volume and check Use air sensor to terminate sample fill.
This will activate the air sensor found on T-VB-In1. If air is detected be-
fore the sample volume is reached, the air sensor terminates the sam-
ple load, but if no air is detected before the sample volume is reached,
the sample volume terminates the load.

c. Check Use air sensor to terminate sample fill but leave the sample
volume on the default of 80 000 mL. In this case, only air detection on T-
VB-In1 will terminate the sample load.
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7.1.4 Concentration step dialog
The following illustration shows the concentration steps dialog screen.

If a sample volume that is greater than the chosen reservoir volume (e.g., fed batch
operation) or if the Use air sensor to terminate sample fill option has been selec-
ted, the reservoir fill volume must be entered. The default fill volume is 200 mL for ei-
ther reservoir but the maximum fill volume will depend on the size of the reservoir
chosen. A reservoir minimum is also displayed; this is the minimum recommended
working volume for the reservoir (5 mL for the small reservoir, 8 mL for the large res-
ervoir).

Next step: Set the crossflow rate and filtration control mode.
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Feed and filtration control

There are four ways to create the crossflow, all of which are controlled by the feed
pump:

• Constant DeltaP

• Constant Feed Flow

• Constant Retentate Flow

• Shear rate (only when hollow fibre has been selected)

Step Action

1 Enter the value for the selected crossflow rate, for example a Feed Flow of
50 mL/min.

Note:

When using shear rate as crossflow rate for hollow fibers, the feed flow rate
that equals a chosen shear rate must be calculated in advance. The maxi-
mum feed flow rate on the system is 600 mL/min, and if a shear rate for the
selected hollow fiber exceeds this, the feed pump will run at 600 mL/min. No
error or alarm will be generated. For more information on shear rates, and
conversion to feed flow rate for a hollow fiber, refer to the Hollow fiber oper-
ating guide.
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Step Action

2 Enter the desired TMP control value in bar.

Note:

For ultrafilter hollow fibers and flat sheet cassettes, the only filtration con-
trol mode available is TMP control. This can be edited to permeate flux con-
trol in the Text Editor after the method has been created.

Note:

When using TMP as the filtration control mode in a method, always choose
a TMP value in the product steps that is below the TMP limit. Otherwise, the
TMP limit can lead to a TMP pressure alarm, which will pause the run.

Concentration endpoint

There are two ways to end a concentration step:

• Watch for Endpoint

• Retentate Volume/Concentration Factor

To place a watch on the UV to end the concentration step, use the following proce-
dure:

Step Action

1 Select UV Greater than or UV Less than from the drop-down list.

7 Create product steps using the Method Wizard
7.1 Ultrafiltration
7.1.4 Concentration step dialog

134  ÄKTAcrossflow User manual 29360935 AA



Step Action

2 Enter an endpoint value in the Level window. UNICORN will end the con-
centration step based on the specified UV signal (in mAU) in the permeate.

Note:

If the Watch for Endpoint setting is used, a maximum endpoint must still
be designated. UNICORN will end the concentration step when either the UV
level or maximum endpoint is met.

3 Set a maximum endpoint value for either Retentate Volume or Concen-

tration Factor. 

Step Action

1 Set the Watch for Endpoint option to OFF.

2 Under Max endpoint, select either Retentate Volume or Concentration
Factor.
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Step Action

3 Enter the value for the endpoint:

a. If a Retentate Volume is the desired endpoint, an applicable range will
be given which depends on the total retentate hold-up volume, the fill
volume, and the reservoir size.

Note:

It is not possible to end a concentration step on a volume greater than
the fill volume plus the hold-up volume minus 5 mL. There is also a mini-
mum retentate volume equal to the retentate hold-up volume plus 5 mL.
This makes sure that a small amount of liquid remains in the reservoir at
the end of the concentration step.

b. If a Concentration Factor is the desired endpoint, a concentration fac-
tor between 1 and 50 must be entered.

Note:

The expected sample volume and concentration factor must be estima-
ted to make sure that they are achievable with the reservoir volume and
retentate hold-up volume. For example, if you have an expected sample
volume of 1000 mL, and are using the small reservoir, it is not possible to
achieve a concentration factor of 2. The system will however not give an
error message or alarm, but will end the concentration when the sample
load reaches twice the fill volume plus the hold-up volume. Also, you
may not be able to reach a desired concentration factor due to system
minimum working volume limitation. For example, if the retentate hold-
up volume is 25 mL, the sample volume is 100 mL, and the desired con-
centration factor is 5, the system’s catastrophic ReservoirEmpty alarm
will pause the system when the level sensor detects an empty reservoir
at 25 mL. It is recommended to use a minimum reservoir volume of 5 mL,
although more may be required depending on crossflow rate.

Note:

A concentration factor of 1 means no concentration, which can be used
to compensate for an initial dilution due to liquid in the recirculation loop
on the retentate side. This can be utilized in the diafiltration of small vol-
umes as a planned single step. See Diafiltration, on page 127.
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7.1.5 Diafiltration step dialog
If diafiltration of a small volume is planned, it is recommended to perform a concen-
tration as an initial step. This is to avoid dilution of the sample due to the hold-up vol-
ume on the retentate side. Note also the sample volume limitation when performing
a diafiltration as a first step. For more information, see Diafiltration, on page 127 and 
Concentration endpoint, on page 134.

Feed and filtration control
See Feed and filtration control, on page 133.

Diafiltration endpoint
There are two ways to end a diafiltration step:

• Watch for Endpoint

• Permeate Volume/Diafiltration Exchange Factor
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Three signals can be monitored to end a diafiltration step:

• conductivity

• pH

• UV

Note: A maximum volume endpoint must be set using the Max Endpoint setting
even if a Watch for Endpoint condition has been set. UNICORN will end
the concentration step when either the monitor condition or maximum
endpoint condition is met.

Watch for endpoint

To place a watch to end the diafiltration step, use the following procedure:

Step Action

1 In the Watch for Endpoint drop-down menu, select the signal and condi-
tion from the following options:

a. Conductivity Greater than and Stable Conductivity

b. Conductivity Less than and Stable Conductivity

c. pH Geater than and Stable pH

d. pH Less than and Stable pH

e. UV Greater than

f. UV Less than

2 Either:

If UV endpoint has been selected, enter the monitor signal level at which
the diafiltration step should stop,

or

If conductivity or pH endpoint has been selected, enter the monitor signal
level at which the monitoring of the stable signal should start.
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Step Action

3 Enter the time the signal should be stable for the watch to be met (conduc-
tivity or pH).

4 Enter Delta Base, the allowed fluctuation (+ and – value) for the signal to
be considered stable (conductivity or pH).

Note: To end the diafiltration with a watch on pH, or UV signal, a maximum vol-
ume endpoint must still be designated. UNICORN will end the concentra-
tion step when either the monitor condition or maximum endpoint condi-
tion is met.

Permeate Volume/Diafiltration
Exchange Factor

To end the diafiltration step based on either a permeate volume or a diafiltration ex-
change factor:

Step Action

1 Set the Watch for Endpoint option to OFF.

2 Select either Permeate Volume or DF Exchange Factor.
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Step Action

3 Enter the value for the endpoint:

a. If a Permeate Volume is the desired endpoint, enter the total perme-
ate volume to end the diafiltration.

b. If a Diafiltration Factor is the desired endpoint, a value between 0 and

50 must be entered.

Note: Due to possible unknown sample volume when loading based on air detec-
tion, UNICORN cannot estimate the required volume of diafiltration buffer.
Make an approximate calculation to make sure that there is enough diafil-
tration buffer to achieve the desired diafiltration exchange factor. If the sys-
tem runs out of diafiltration buffer, the sample will concentrate until the
catastrophic Reservoir Empty alarm pauses the system.
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7.1.6 Recovery dialog

Recovery options
There are two recovery options: Recovery or No Recovery.

If No Recovery is selected, the system will go into a Hold with a retentate flow rate of
10 mL/min to avoid sedimentation. The material can be recovered manually either
during this Hold step, or select Continue in System Control to end the method. The
sample can then be recovered as desired.

Note: If you opt for No Recovery then no postproduct steps are allowed.

If Recovery is selected, the reservoir can be emptied by the following ways.

For flat sheet casettes, the reservoir is emptied through R-VB-Out3.

For hollow fibers, under Retentate Oulet select either:

• ProductFlush: the initial recovery is collected through R-VB-Out3 or

• Waste: the retentate is sent to waste through R-VB-Out2

If Waste is chosen, the product steps are terminated after an optional 5-minute re-
circulation with open TMP valve.
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Note: If an old type retentate valve is used on the system, make sure that any re-
covery vessels are not placed lower than the reservoir, as siphoning can oc-
cur.

If Recirculation before initial recovery (with no TMP) is checked, the retentate is
recirculated with an open R-PCV (TMP) valve for 5 minutes, to aid in the recovery
process. This recirculation sweeps any proteins bound to the membrane (concentra-
tion polarisation) or gel layer that formed during the concentration and diafiltration
process back into the bulk flow to enhance the yield. The retentate is then recovered
through R-VB-Out3, followed by a buffer chase This allows recovery of the undiluted
product in the reservoir and 70% of the undiluted material in the recirculation path-
way to the R-VB-Out3 port. The buffer used in the chase is either conditioning buffer
(T-VB-In2) when no diafiltration step has been included, or diafiltration buffer (T-
VB-In3 or T-VB-In4, according to the last diafiltration step before recovery).
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Buffer flush after recovery

If the retentate is recovered, this can be followed by a defined number of flushes. The
retaining product will be emptied through R-VB-Out1. To do this, use the following
procedure:

Step Action

1 Check the Buffer flushes collected through R-VB-Out1 box.

2 Select number of flushes. Up to two flushes can be selected.

3 Enter the volume for each flush.

Note:

The minimum flush volume represents the buffer volume that is present in
the recirculation loop after the buffer chase for primary recovery, and de-
pends on the hold-up volume of the system.

4 To perform recirculation, select the Recirculation before recovery op-
tion.

Recirculation can also be performed between buffer flushes.

Note:

The product will leave the system through R-VB-Out3 and the flush vol-
umes will leave through R-VB-Out1.
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7.2 Microfiltration

About this section
This section provides information on how to create product methods for Microfiltra-
tion using the Method Wizard.

In this section

Section See page

7.2.1 Introduction 145

7.2.2 Basic settings dialog 146

7.2.3 Product steps dialog 147

7.2.4 Concentration step dialog 150

7.2.5 Diafiltration step dialog 155

7.2.6 Recovery dialog 159
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7.2.1 Introduction
Depending on the application, the product of interest will either stay in the retentate
or pass through the filter to the permeate side.

Cell harvesting/washing
In cell harvesting and cell washing, the product of interest (the cells) will stay in the
retentate.

• A concentration step reduces the volume of the cell solution.

• A diafiltration step is run to wash the harvested cells.

Cell or lysate clarification
After cell harvesting, mechanical disruption of the cells releases the product of inter-
est from the cells and creates a lysate.

In a concentration step, cells, cell debris or other insoluble matter are retained by the
filter and the target product passes through the filter to the permeate.

Note: In this step, the product leaves the system through P-VB-Out2.

A diafiltration step is then performed to flush the rest of the product of interest
through the membrane.

Note: In this step, the product leaves the system through P-VB-Out3.
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7.2.2 Basic settings dialog
Input the basic settings (filter type, specifications, tubing kit i.d., and size of reservoir)
as detailed in Section 6.3.1 Basic settings dialog, on page 100.

Select Product in the Steps selection.
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7.2.3 Product steps dialog
The image below shows the Product Steps dialog window.

A minimum working volume is displayed. The minimum working volume is the sys-
tem hold-up volume including the filter hold-up, with an addition of a small volume in
the reservoir. This volume depends on the reservoir size, tubing kit, and filter volume.
This is the lowest working volume that is recommended.

Note: Minimum working volume will vary with reservoir size and tubing kit used
and is not the same as system hold-up volume. To maintain smooth pro-
cessing, a small volume is added to the system hold-up volume in the cal-
culation of minimum working volume. For information on system hold-up
volume, see the Appendix A.
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To enter information in to the Product Steps dialog, use the following procedure:

Step Action

1 In the Product Steps dialog, select up to 3 concentration and diafiltration

steps. 

Note:

For diafiltration, only 2 steps can be selected with any combination of steps.
This is due to the limited number of transfer valve block inlets that are used
as standard for diafiltration buffer.
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Step Action

2 Enter the sample volume. There are 3 options:

a. Enter a set volume.

Note:

If a volume greater than the maximum volume of the chosen reservoir is
entered, on the next page you will be required to enter a Fill Volume and
the system will operate in Fed Batch mode. In this case, the reservoir is
continually refilled as a function of the permeate flow. This is possible
when only concentration is the first step. Otherwise, if the total sample
volume fits into the chosen reservoir size, the system will operate in

Tank Batch mode.

b. Enter a set volume and check Use air sensor to terminate sample fill.
This will activate the air sensor found on T-VB-In1. if air is detected be-
fore the sample volume is reached, the air sensor terminates the sam-
ple load, but if no air is detected before the sample volume is reached,
the sample volume terminates the load.

c. Check Use air sensor to terminate sample fill but leave the sample
volume on the default of 80 000 mL. In this case, only air detection on T-
VB-In1 will terminate the sample load.
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7.2.4 Concentration step dialog

If a sample volume greater than the chosen reservoir volume has been selected for
fed batch operation, or if the Use air sensor to terminate sample fill option has
been selected, a reservoir fill volume must first be entered. The default fill volume is
200 mL for either reservoir but the maximum fill volume will depend on the size of the
reservoir chosen. A reservoir minimum is also displayed; this is the minimum recom-
mended working volume for the reservoir (5 mL for the small reservoir, 8 mL for the

large reservoir). 
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Feed and filtration control

There are four ways to create the crossflow, all controlled by the feed pump:

• constant DeltaP

• constant Feed Flow

• constant Retentate Flow

• Shear rate (only with hollow fibers)

To set the feed control settings, use the following procedure.

Step Action

1 Enter the value for the selected crossflow rate, for example a Shear of
6000 s-1.

Note:

When using shear rate as crossflow rate for hollow fibers, the feed flow rate
that equals a chosen shear rate must be calculated in advance; the maxi-
mum feed flow rate on the system is 600 mL/min, and if a shear rate for the
selected hollow fiber exceeds this, the feed pump will run at 600 mL/min. No
error or alarm will be generated. For more information on shear rates, and
conversion to feed flow rate for a hollow fiber, refer to the Hollow Fiber Oper-
ating Guide.

2 From the ControlMode drop down menu, select one of two available filtra-
tion control modes: TMP control or permeate flux control.

Note:

Permeate flux control is recommended for any pore size over 0.1 μm, to pre-
vent rapid blocking of the membrane. Low TMP control can often be used for
high molecular weight ultrafilters (such as 500 or 750 kD NMWCO).
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Step Action

3 Enter the desired flux control value in LMH or TMP control value in bar.

Note:

When using TMP as the filtration control mode in a method, always choose
a TMP value in the product steps that is below the TMP limit. Otherwise, the
TMP limit may lead to a TMP pressure alarm, which will pause the run.

Concentration endpoint

There are two ways to end a concentration step:

• Watch for Endpoint

• Retentate Volume/Concentration Factor

To place a watch on the UV to end the concentration step, use the following proce-
dure:

Step Action

1 Select UV Greater than or UV Less than from the drop-down list.
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Step Action

2 Enter an endpoint value in the Level window. UNICORN will end the con-
centration step based on the specified UV signal (in mAU) in the permeate.

Note:

If the Watch for Endpoint setting is used, a maximum endpoint must still
be designated. UNICORN will end the concentration step when either the UV
level or maximum endpoint condition is met.

3 Set a maximum endpoint value for either Retentate Volume or Concen-

tration Factor. 

Step Action

1 Set the Watch for Endpoint option to OFF.

2 Select either Retentate Volume or Concentration Factor under Max
endpoint.
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Step Action

3 Enter the value for the endpoint:

a. If a Retentate Volume is the desired endpoint, an applicable range will
be given which depends on the total retentate hold-up volume, the fill
volume, and the reservoir size.

Note:

It is not possible to end a concentration on a volume less than the fill vol-
ume plus the hold-up volume minus 5 mL. There is also a minimum re-
tentate volume equal to the retentate hold-up volume plus 5 mL. This
makes sure that a small amount of liquid remains in the reservoir at the
end of the concentration step.

b. If a Concentration Factor is the desired endpoint, a concentration fac-
tor between 1 and 50 must be entered.

Note:

The expected sample volume and concentration factor must be estima-
ted to make sure that they are achievable with the reservoir volume and
retentate hold-up volume. For example, if you have an expected sample
volume of 1000 mL, and are using the small reservoir, it is not possible to
achieve a concentration factor of 2. The system will however not give an
error message or alarm, but will end the concentration when the sample
load reaches twice the fill volume plus the hold-up volume. Also, you
may not be able to reach a desired concentration factor due to system
minimum working volume limitation. For example, if the retentate hold-
up volume is 25 mL, the sample volume is 100 mL, and the desired con-
centration factor is 5, the system’s catastrophic ReservoirEmpty alarm
will pause the system when the level sensor detects an empty reservoir
at 25 mL. It is recommended to use a minimum reservoir volume of 5 mL,
although more may be required depending on crossflow rate.

Note:

A concentration factor of 1 means no concentration, which can be used
to compensate for an initial dilution due to liquid in the recirculation loop
on the retentate side. This can be utilized in the diafiltration of small vol-
umes as a planned single step. See Diafiltration, on page 127.
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7.2.5 Diafiltration step dialog
If diafiltration of a small volume is planned, it is recommended to perform a concen-
tration as an initial step. This is to avoid dilution of the sample due to the hold-up vol-
ume on the retentate side. Note also the sample volume limitation when performing
a diafiltration as a first step. For more information, see Diafiltration, on page 127 and 
Concentration endpoint, on page 134.

Feed and filtration control
See, Section 7.2.4 Concentration step dialog, on page 150.

Diafiltration endpoint
There are two ways to end a diafiltration step:
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• Watch for Endpoint

• Permeate Volume/Diafiltration Exchange Factor

Three signals can be monitored to end a diafiltration step:

• conductivity

• pH

• UV

Note: A maximum volume endpoint must be set using the Max Endpoint setting
even if a Watch for Endpoint condition has been set. UNICORN will end
the concentration step when either the monitor condition or maximum
endpoint condition is met.

Watch for endpoint

To place a watch to end the diafiltration step, use the following procedure:

Step Action

1 In the Watch for Endpoint drop-down menu, select the signal and condi-
tion from the following options:

a. Conductivity Greater than and Stable Conductivity

b. Conductivity Less than and Stable Conductivity

c. pH Geater than and Stable pH

d. pH Less than and Stable pH

e. UV Greater than

f. UV Less than

2 Enter the Level at which the monitoring of the stable signal should start.

3 Enter the Time Stable, the time the signal should be stable for the signal
watch to be met (conductivity or pH).
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Step Action

4 Enter Delta Base, the allowed fluctuation (+ and – value) for the signal to
be considered stable.

Note: To end the diafiltration with a watch on the conductivity, pH, or UV signal, a
maximum volume endpoint must still be designated. UNICORN will end the
diafiltration step when either the monitor condition or maximum endpoint
condition is met.

Permeate Volume/Diafiltration
Exchange Factor

To end the diafiltration step based on either a permeate volume or a diafiltration ex-
change factor, use the following procedure:

Step Action

1 If Permeate Volume of DF Exchange Factor is to be the only endpoint
then the Watch for Endpoint option must be set to OFF.

2 Select either Permeate Volume or DF Exchange Factor and enter the
endpoint value.

Note: If a Diafiltration Exchange Factor is selected, a concentration factor be-
tween 1 and 50 must be entered.
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Note: Due to possible unknown sample volume when loading based on air detec-
tion, UNICORN cannot estimate the required volume of diafiltration buffer.
Make an approximate calculation to ensure that there is enough diafiltra-
tion buffer to achieve the desired diafiltration exchange factor. If the sys-
tem runs out of diafiltration buffer, the sample will concentrate until the
catastrophic Reservoir Empty alarm pauses the system.
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7.2.6 Recovery dialog

Recovery options
There are two options, Recovery or No Recovery.

If No Recovery is selected, the system will go into a Hold with a retentate flow rate of
10 mL/min to avoid sedimentation. The material can either be recovered manually
from the reservoir during the Hold, or select Continue in System Control to end the
method, allowing for manual recovery as desired.

Note: If you opt for No Recovery, no postproduct steps are allowed

Note: If an old type retentate valve is used on the system, be careful that any re-
covery vessels are not placed lower than the reservoir, as siphoning can oc-
cur.

If Recovery is selected, the reservoir can be emptied by the following ways.

For flat sheet casettes, the reservoir is emptied through R-VB-Out3.

For hollow fibers, under Retentate Oulet select either:

• ProductFlush: the initial recovery is collected through R-VB-Out3 or

• Waste: the retentate is sent to waste through R-VB-Out2
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Note: For clarification processes, the target product passes through the filter to
the permeate. The retentate can be directed to waste. If waste is chosen, the
product steps are terminated after an optional 5-minute recirculation with
open TMP valve.

If recovering the retentate with hollow fibers, select Product/Flush.
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If Recirculation before initial recovery (with no TMP) is checked, the retentate is
recirculated with an open R-PCV (TMP) valve for 5 minutes, to aid in the recovery
process. This recirculation sweeps any proteins bound to the membrane (concentra-
tion polarisation) or gel layer that formed during the concentration and diafiltration
process back into the bulk flow to enhance the yield. The retentate is then recovered
through R-VB-Out3, followed by a buffer chase This allows recovery of the undiluted
product in the reservoir and 70% of the undiluted material in the recirculation path-
way to the R-VB-Out3 port. The buffer used in the chase is either conditioning buffer
(T-VB-In2) when no diafiltration step has been included, or diafiltration buffer (T-
VB-In3 or T-VB-In4), according to the last diafiltration step before recovery.
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Buffer flush after recovery

If the retentate is recovered, this can be followed by a defined number of flushes and
the retaining product will be emptied through R-VB-Out1. To do this, use the follow-
ing procedure:

Step Action

1 Check the Buffer flushes collected through R-VB-Out1 box.

2 Select number of flushes. Up to two flushes can be selected.

3 Enter the volume for each flush.

Note:

The minimum flush volume represents the buffer volume that is present in
the recirculation loop after the buffer chase for primary recovery, and de-
pends on the hold-up volume of the system.

4 To perform recirculation, select the Recirculation before recovery op-
tion.

Recirculation can also be performed between buffer flushes.

Note:

The product will leave the system through R-VB-Out3 and the flush vol-
umes will leave through R-VB-Out1.
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7.3 Visualization of product steps
For information on the specific instructions, for example Constant Retentate Vol-
ume, see Chapter 14 Strategy instructions, on page 268.

Sample filling
Sample filling, either Tank Batch (sample fill) or Fed Batch (reservoir fill) must take
place before a concentration or diafiltration step.

Stage Description

1 To prime the sample inlet tubing, the transfer pump first fills the tubing
with 6 mL sample from T-VB-In1 (sample).

2 To prime the tubing from the transfer pump to the transfer purge valve
waste line, an additional 10 mL sample is filled into the tubing. Only the
initial 6 mL priming volume goes to waste.
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Stage Description

3 The Transfer_Purge_Valve is switched to Reservoir to fill with sam-
ple. The volume which is initially filled depends on whether a Tank
Batch or Fed Batch process is used. With a Tank Batch, the total sam-
ple volume minus 30 mL is filled at a high flow rate, followed by an addi-
tional 20 mL at a slow flow rate (to improve accuracy). This is followed
by the buffer chase detailed below, to bring in the remaining 10 mL
sample contained within the tubing to the reservoir.

4 The last 10 mL of the sample is chased with buffer (either conditioning
or diafiltration buffer, depending on the product steps) to the reservoir.

5 If the Use air sensor to terminate sample fill has been selected, the
air sensor is activated during the sample load. If air is detected, the
sample load is terminated early and the system moves to the next step.
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Stage Description

6 The sample is recirculated at the chosen crossflow rate until the deltaP
has stabilized for at least 1 minute, with a timeout after 5 minutes.

7 The appropriate permeate outlet is opened (P-VB-Out2 for a concen-
tration step or P-VB-Out3 for a diafiltration step) and the filtration con-
trol mode is started.

8 To prime the sample inlet tubing, the transfer pump first fills the tubing
with 6 mL sample from T-VB-In1 (sample).

7 Create product steps using the Method Wizard
7.3 Visualization of product steps

ÄKTAcrossflow User manual 29360935 AA 165



Stage Description

9 To prime the tubing from the transfer pump to the transfer purge valve
waste line, an additional 10 mL sample is filled into the tubing. Only the
initial 6 mL priming volume goes to waste.

10 With a Fed Batch process, the initial Reservoir fill volume minus 20
mL is filled at a high flow rate, followed by an additional 20 mL at a slow
flow rate. The sample load will finish at the end of the Fed Batch with
the buffer chase detailed below, to bring in the 10 mL sample contained
within the tubing to the reservoir..
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Stage Description

11 Constant retentate volume is activated. The selected crossflow is set,
the permeate P-VB-Out2 is opened, and the filtration control mode is
started.

12 A watch is put on the TransVol for the total sample volume minus 10
mL. When this is reached, the last 10 mL of the sample is chased with
buffer (either conditioning or diafiltration buffer, depending on the
product steps) to the reservoir.

13 If the Use air sensor to terminate sample fill has been selected, the
air sensor is activated during the sample load. If air is detected, the
sample load is terminated early and the system moves to the next step.

14 The same principle is used with Use air sensor to terminate sample
fill and unlimited sample volume; when air is detected, the sample load
is terminated and the system moves to the next step.

7 Create product steps using the Method Wizard
7.3 Visualization of product steps

ÄKTAcrossflow User manual 29360935 AA 167



Concentration
The concentration starts after the sample fill (Tank Batch) or reservoir fill (Fed
Batch) has finished, with the opening of the permeate pathway P-VB-Out2 and set-
ting of the filtration control mode parameter.

Stage Description

1 The concentration continues, with P-VB-Out2 open, until the desired
end point has been reached (either a specified concentration factor or
retentate volume) or the watch on the UV signal has been met.

Diafiltration
The diafiltration starts with a specific sample volume in the reservoir, either the
specified end point of the concentration step, or the fill volume in a diafiltration-only
method or method in which the diafiltration is the first step.
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Stage Description

1 Constant Retentate Volume is activated. The transfer valve inlet is
opened to either diafiltration buffer 1 or 2 (depending on step) (T-VB-
In3 or T-VB-In4) and the permeate pathway is switched to P-VB-Out3.
The crossflow rate and filtration control mode remain active or are
changed (if specified in the method).

2 Liquid leaving the system through P-VB-Out3 is replaced with diafiltra-
tion buffer through T-VB-In3 until the desired end point has been
reached (diafiltration exchange factor or permeate volume) or a watch
on the conductivity, pH, or UV signal has been met. If two diafiltration
steps are performed, the second step will use buffer from T-VB-In4.

Recovery, no flush
Product recovery without flush recovers cells from the ÄKTAcrossflow system.
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Stage Description

1 At the end of the final product step, the permeate pathway is closed
and the filtration control mode de-activated. If Recirculation before
initial recovery has been selected, the system will recirculate (using
the same crossflow rate used in the last product step) for 5 minutes.

2 To start the recovery, the reservoir is emptied through R-VB-Out3.
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Stage Description

3 The reservoir is then filled with 5 mL buffer (either conditioning from T-
VB-In2, or diafiltration buffer from T-VB-In3 or T-VB-In4, depending on
the product steps chosen).

4 At a transfer and retentate flow rate of 5 mL/min, buffer in the reservoir
is used to chase 70% of the undiluted product in the pathway between
the reservoir and R-VB-Out3 out through R-VB-Out3, adding to the
undiluted product recovered in the initial emptying of the reservoir.

Recovery, with buffer flushes
The Recovery with buffer flushes removes residual product from system without
risking precipitation of components on the membrane or flow path before product
recovery.
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Stage Description

1 At the end of the final product step, the permeate pathway is closed
and the filtration control mode de-activated. If Recirculation before
initial recovery has been selected, the system will recirculate (using
the same crossflow rate used in the last product step) for 5 minutes.

2 To start the recovery, the reservoir is emptied through R-VB-Out3.

3 The reservoir is filled with the volume of buffer specified in Volume
Flush 1 in the Recovery dialog. This buffer is either conditioning buffer
from T-VB-In2, if no diafiltration step was chosen, or diafiltration buffer
from T-VB-In3 or T-VB-In4, depending on the last diafiltration step.

7 Create product steps using the Method Wizard
7.3 Visualization of product steps

172  ÄKTAcrossflow User manual 29360935 AA



Stage Description

4 At a transfer and retentate flow rate of 5 mL/min, buffer in the reservoir
is used to chase 70% of the undiluted product in the pathway between
the reservoir and R-VB-Out3 out through RVB-Out3, adding to the un-
diluted product recovered in the initial emptying of the reservoir.

5 R-VB-Out3 is closed and the retentate valve block is set to R-VB-Recy-
cle. If Recirculate before flush recovery has been selected, the reten-
tate is recirculated for five minutes at the same crossflow rate chosen
for the last product step.

6 R-VB-Out1 is then opened, and the reservoir is emptied.
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Stage Description

7 If a second buffer flush has been selected, the reservoir is then filled
with the volume of buffer specified in Volume Flush 2 in the Recovery
dialog. This buffer is either conditioning buffer from T-VB-In2, if no dia-
filtration step was chosen, or diafiltration buffer from T-VB-In3 or T-
VB-In4, depending on the last diafiltration step.

8 At a transfer and retentate flow rate of 5 mL/min, buffer in the reservoir
is used to chase 70% of the dilute product in the pathway between the
reservoir and R-VB-Out1 out through R-VB-Out1, adding to the first
flush recovered in the emptying of the reservoir out R-VB-Out1.
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Stage Description

9 R-VB-Out3 is closed and the retentate valve block is set to recycle. If
Recirculate before flush recovery has been selected, the retentate is
recirculated for five minutes at the same crossflow rate chosen for the
last product step.Result: R-VB-Out1 is then opened, and the reservoir is
emptied.

10 At a transfer and retentate flow rate of 5 mL/min, buffer in the reservoir
is used to chase 70% of the dilute product in the pathway between the
reservoir and R-VB-Out1 out through R-VB-Out1, adding to the dilute
product recovered in the initial emptying of the reservoir out RVB-
Out1.

11 The rest of the reservoir volume is emptied through waste (R-VB-
Out2).
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8 Create postproduct steps using the
Method Wizard

About this chapter
This chapter describes the preproduct steps and how to create them in the Method
Wizard.

In this chapter

Section See page

8.1 Introduction 177

8.2 Postproduct steps: Description 178

8.3 Postproduct steps: Method Wizard dialogs 182
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8.1 Introduction
The ÄKTAcrossflow Method Wizard enables the simple creation of a series of steps
to be used after a process run. These steps include:

• Flush

• Clean-in-place

• Water Flush

• Water Flux Test

• Filter Storage

Note: A recommended storage solution for the system is 20% ethanol. The sys-
tem should not be stored in NaOH, as the pump seals are affected over
time.

Note: To completely exchange the solution in the system, perform the System
Sanitization method and use 20% ethanol instead of NaOH. It is impor-
tant to use a three-way-connector instead of a filter. See Section 11.1 Sys-
tem sanitization, on page 218 for more information.

Note: If the system requires more intensive cleaning, it may also be necessary to
perform a System Sanitization. See Section 11.1 System sanitization, on
page 218.
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8.2 Postproduct steps: Description

Flush
After a product run, this step flushes remaining product and contaminants out of the
filter before the CIP step. Select flush solution (either conditioning buffer from T-VB-
In2 or water from T-VB-In5). The flush volume is editable with a default value of 2 mL
per cm2 surface area of the filter. This step will:

• Prime the selected transfer inlet valve position (T-VB-In2 or T-VB-In5) to waste

• Fill the reservoir to the maximum volume (350 mL for the small reservoir and
1100 mL for the large reservoir), then empty the reservoir out R-VB-Out2

• Flush the recirculation loop twice and empty the reservoir

• Refill the reservoir to a small volume and flush 2 mL per cm2 surface area of the
filter out through permeate valve block position 1 (P-VB-Out1)

• Empty the reservoir

Filter CIP
The filter CIP postproduct step includes an option to perform two filter CIP proce-
dures with an optional water flush between. This step will:

• Prime the CIP transfer inlet valve positions tubing to waste.

Note: If CIP 1 only is chosen, only transfer valve block 6 (T-VB-In6) is primed.
If CIP 2 only is chosen, only transfer valve block 7 (T-VB-In7) is primed.
If both CIP 1 and CIP 2 are selected, both inlets will be primed.

• Fill the reservoir to the maximum volume (350 mL for the small reservoir and
1100 mL for the large reservoir), then empty the reservoir out R-VB-Out2

• Flush the recirculation loop twice and empty the reservoir

• Either fill the reservoir to the maximum volume (small reservoir) or fill to a speci-
fied fill volume (large reservoir)

• Rinse 30 mL CIP solution to waste through P-VB-Out1

• Recirculate the permeate back into the reservoir for the Length of Time specified
in the dialog

• Empty the reservoir

Empty the reservoir
If a water flush is chosen between CIP 1 and CIP 2, the system will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste
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• Add a small volume of water to the reservoir to rinse the retentate loop

• Empty the reservoir

• Refill the reservoir to a small volume and flush 10 mL water out through the per-
meate valve block position recycle (P-VB-Recycle) to waste (Trans-
fer_Purge_Valve to Waste)

• Empty the reservoir

If CIP 3 is chosen, this step will:

• Prime the transfer inlet valve position 7 (T-VB-In7) tubing to waste

• Add CIP solution to the reservoir to rinse the retentate loop

• Empty the reservoir

• Either fill the reservoir to the maximum volume (small reservoir) or fill to a speci-
fied fill volume (large reservoir)

• Rinse 30 mL CIP solution to waste through P-VB-Out1

• Recirculate the permeate back into the reservoir for the Length of Time specified
in the dialog

• Empty the reservoir

Note: The system will not be sanitized. For sanitization of the system, see Section
11.1 System sanitization, on page 218.

Note: If only a CIP 2 step is chosen, the procedure used by the system will be the
same as the CIP 1 step, using transfer inlet position 7 (T-VB-In7) instead of
transfer inlet position 6 (T-VB-In6).

Water flush
The postproduct water flush step will fill the reservoir to the maximum volume (350
mL for the small reservoir and 1100 mL for the large reservoir) and empty, to make
sure that any previous solution has been removed. It is always recommended to se-
lect a water flush after a filter CIP step where NaOH was used. This step should also
be used before a water flux test is performed. The default water flush volume is 2 mL
per cm2 surface area of the filter and can be edited. This step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste

• Fill the reservoir to maximum volume (350 mL for the small reservoir and 1100
mL for the large reservoir) and empty

• Add a small volume of water to the reservoir to rinse the retentate loop twice

• Empty the reservoir

• Refill the reservoir to a small volume and flush 2 mL water per cm2 surface area of
the filter out through permeate valve block position 1 (P-VB-Out1)
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• Empty the reservoir

Water flux test
A water flux test measures the water permeability of a filter, to control the quality
status of the filter. Permeate flux values are often normalized to 1 bar transmem-
brane pressure and corrected to a temperature of 25°C, and is then called the nor-
malized water permeability (NWP; also called normalized water flux, or NWF). By
comparing obtained water fluxes as a function of usage over time, it is possible to as-
sess the efficiency of the filter CIP determine the lifetime of a filter.

It is recommended to perform the test before a product step, and after a product
step and filter cleaning.

Always perform a water flush or rinse before a water flux test, to make sure that the
filter is thoroughly flushed with water.

The filtration control mode is dependent on the filter type used.

• For flat sheet cassettes, TMP control mode is used. The default TMP value is 1 bar,
but this can be edited by the user.

• For ultrafilter hollow fibers, TMP control mode is used. The default TMP value is 1
bar, but this can be edited by the user. It is recommended to set the TMP value to
0.5 bar or lower for high molecular weight hollow fiber ultrafilters (≥ 500 kD).

• For microfilter hollow fibers (cut off larger than 0.1 µm), Normal Flow Filtration
(NFF) mode is used. Feed flow or Feed pressure can be selected as a feed control
and a value is entered.

This step will:

• Prime the transfer inlet valve position 5 (T-VB-In5) tubing to waste

• Add a small volume of water to the reservoir to rinse the retentate loop

• Empty the reservoir

• Fill a small volume of water to the reservoir

• Set the system to total recycle (P-VB-Recycle, Transfer_Purge_Valve to Reser-
voir)

• Set the filtration control mode and wait until the flux has stabilized

• Measure the permeate flux and set a Set_Eval_Mark with the parameter
Normalized_Water_Flux for easy analysis in the Evaluation module.

Data from water flux testing can be analyzed in the Evaluation module of UNICORN.
In the example in Figure 8.1, on page 181, normalized water flux results from a series
of measurements are plotted against the number of performed runs with a filter. A
standardized temperature correction table compensates for temperature effects
due to viscosity. Results are compared to previous tests and provide information
about the quality status of the filter.
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Figure 8.1: Example of plotted normalized water flux values

Note: When comparing status of a filter as a function of time and number of uses,
use the same filtration mode parameter each time the water flux test is run.

Storage
The storage step replaces the liquid in the filter with a buffer that is suitable for stor-
ing the filter. This step will:

• Prime the transfer inlet valve position 8 (T-VB-In8) tubing to waste

• Add a small volume of storage solution to the reservoir to rinse the retentate loop

• Empty the reservoir

• Fill a small volume of storage solution to the reservoir

• Flush the filter with the selected volume, through permeate recycle to waste (P-
VB-Recycle, transfer purge valve to waste)

• Set the system to total recycle (P-VB-Recycle, Transfer_Purge_Valve to Reser-
voir) for 5 minutes

• Empty the reservoir

Note: See the filter manufacturer’s instructions for suitable filter storage solu-
tions. The system might require flushing after removing the filter to put in a
suitable storage solution, such as 20% ethanol. Do not store the
ÄKTAcrossflow in NaOH, as the pump seals may be affected.
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8.3 Postproduct steps: Method Wizard dialogs

About this section
This section provides information on how to create postproduct steps in the Method
Wizard when using hollow fibres and flat sheet cassettes, and provides a description
of each step.

In this section

Section See page

8.3.1 Postproduct step dialog 183

8.3.2 Visualization of the postproduct steps 187
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8.3 Postproduct steps: Method Wizard dialogs
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8.3.1 Postproduct step dialog

Postproduct step dialog overview
Input the basic settings (filter type, specifications, tubing kit i.d., and size of reservoir)
as detailed in Section 6.3 Preproduct steps: Method Wizard dialogs, on page 99. Select
Postproduct in the Steps selection.

The image below shows an example of the Postproduct setup dialog.
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Flush
To include a conditioning buffer or water flush in the method, check the Flush box.

Select the flush volume; this is the volume of solution which will be flushed through
the filter into the permeate. The default value is 2 mL per cm2 of filter surface area.

Pick the flush solution: conditioning buffer (T-VB-In2) or water (T-VB-In5).

Filter CIP

To include a Filter CIP step, use the following procedure.

Step Action

1 Check the Filter CIP box.

2 Select either a one- or two-step CIP, with an optional water flush in be-
tween.

3 Enter the desired CIP circulation time in the Length of Time box.

Water flush

To include a water flush step, use the following procedure.

Step Action

1 Check the Water Flush box.
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Step Action

2 Select the flush volume; this is the volume of water that will be flushed
through the filter into the permeate. The default value is 2 mL per cm2 of fil-

ter surface area.

Note:

After a filter CIP, running a water flush is recommended.

Water flux test

To include a water flux test step, use the following procedure.

Note: If a water flux test will be performed, a water flush should be performed just
before the water flux test.

Step Action

1 Check the Water Flux Test box.

2 Select either TMP or NFF (Normal Flow Filtration) as the control mode.

3 Enter a value for the Flux Test:

a. For TMP, a value of 1 bar is default for all ultrafilters; for high molecular
weight hollow fiber ultrafilters (≥ 500 kD), it is recommended to set this

value to 0.5 bar.

b. NFF (Feed Pressure) is default for microfiltration hollow fibers with a
cut off of 0.1 μm and larger.

c. NFF control of feed flow is also possible.

Note: When comparing status of a filter as a function of time and number of ex-
periments, it is recommended to use the same filtration mode parameter
each time the water flux test is run.
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Storage

To flush the filter with storage solution as part of the method, use the following pro-
cedure.

Step Action

1 Check the Filter Storage Solution box.

2 Select the storage solution rinse volume; this is the volume of storage solu-
tion which will be flushed through the filter into the permeate. The default
value is 30 mL, but this can be edited to a maximum value of 300 mL for the
small reservoir or 1000 mL for the large reservoir.
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8.3.2 Visualization of the postproduct steps
For information on specific instructions, for example Constant Retentate Volume, 
Chapter 14 Strategy instructions, on page 268.

All postproduct steps begin with a Prepare System and Reservoir block, except for
the Storage step and stand-alone Water Flux Test, which begin with the Prepare
System block. The Prepare System block is a quick flush of the recirculation loop,
while the Prepare System and Reservoir step fills and empties the reservoir com-
pletely and thoroughly flushes the recirculation loop. The inlet valve position chosen
depends on the liquid of the specific step.

Prepare system and reservoir
The Prepare System and Reservoir step fills and empties the reservoir completely
and thoroughly flushes the recirculation loop. The inlet valve position chosen de-
pends on the liquid of the specific step.

Stage Description

1 The transfer inlet used is primed to waste through the transfer purge
valve.
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Stage Description

2 The reservoir is then filled to the maximum volume (350 mL for the
small reservoir, 1100 mL for the large reservoir).

3 The reservoir is emptied through R-VB-Out2 (waste).

4 The reservoir is filled to a minimum working volume. A low transfer and
equal feed flow is set, and 50 mL is pumped out of the retentate to
waste through R-VB-Out2.
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Stage Description

5 The tubing in the pathway between R-VB-Out2 and the reservoir is
rinsed by recirculating at a low feed flow rate for less than a minute.

6 The reservoir is emptied and refilled with the minimum working vol-
ume.

7 A low transfer and equal feed flow is set, and 50 mL is pumped out of
the retentate to waste through R-VB-Out2.
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Stage Description

8 The reservoir is filled to a low volume.

9 The retentate is recirculated for one minute using a feed pressure con-
trol of 80% of the maximum feed pressure value (to a maximum of 3
bar).

10 Then, the reservoir is emptied through R-VB-Out2.
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Prepare system
The Prepare System step performs a flush of the recirculation loop.

Stage Description

1 The transfer inlet used is primed to waste through the transfer purge
valve.

2 The reservoir is filled to a low volume.
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Stage Description

3 The retentate is rinsed out R-VB-Out2 for the hold-up volume plus 5
mL.

4 The retentate is recirculated for one minute using a feed pressure con-
trol of 80% of the maximum feed pressure value (to a maximum of 3
bar).

5 The reservoir is emptied through R-VB-Out2 (Waste).
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Flush
The system is prepared according to the procedure Prepare System and Reservoir
described in Prepare System and Reservoir, on page 109. The transfer inlet used is ei-
ther T-VB-In2 (conditioning buffer) or T-VB-In5 (water).

Stage Description

1 The reservoir is filled with 100 mL solution. Constant Retentate Vol-
ume is activated. The crossflow rate is set at a feed pressure 80% of the
maximum feed pressure value (to a maximum of 3 bar) and TMP regula-
tion of 1 bar is started. The volume input in the dialog is rinsed through
the filter out P-VB-Out1 (Waste).

2 Constant Retentate Volume is disabled. 10 mL of the reservoir vol-
ume is emptied through the permeate recycle (P-VB-Recycle) to waste
(Transfer_Purge_Valve Waste).
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Stage Description

3 The rest of the reservoir volume is emptied through R-VB-Out2 and the
flush is complete.

Filter CIP
The system is prepared according to the procedure described in Prepare System and
Reservoir, on page 109. The transfer inlet used is T-VB-In6 or T-VB-In7 (CIP solution),
depending on whether 1 or 2 CIP steps were selected.

Stage Description

1 The reservoir is filled with CIP solution to either the maximum volume
(small reservoir, 350 mL) or a specified fill volume (large reservoir, mini-
mum 200 mL (default) to 1100 mL).

2 Constant Retentate Volume is then activated and the permeate valve
is opened to P-VB-Out1. The crossflow rate is set at a feed pressure
80% of the maximum feed pressure value (to a maximum of 3 bar) and
flux rate filtration control of 30 LMH (flat sheet cassette, HF microfilter)
or TMP filtration control of 1 bar (HF ultrafilter) is started.
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Stage Description

3 The first 30 mL passes through the membrane out P-VB-Out1.

4 After 30 mL has passed through the membrane, the permeate valve is
set to P-VB-Recycle and the liquid is recycled back into the reservoir
for the specified recirculation time.

5 After the specified CIP recirculation time, Constant Retentate Volume
is disabled and the reservoir is emptied through R-VB-Out2.
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Stage Description

6 If a Water Flush between CIP has been selected, the system is prepared
according to the procedure described in Prepare system, on page 112.
The transfer inlet used is T-VB-In5 (water).

7 The reservoir is then filled with 100 mL water and 10 mL of the reservoir
volume is emptied through the permeate recycle (P-VB-Recycle) to
waste (Transfer_Purge_Valve Waste).

8 The reservoir is then emptied through R-VB-Out2.

9 If a CIP 2 step has been selected, the system is prepared according to
the procedure described in Prepare system, on page 112. The transfer
inlet used is T-VB-In7 (CIP2 solution).

10 The reservoir is filled with either 100 mL CIP 2 solution (small reservoir)
or the specified fill volume (large reservoir) and the procedure descri-
bed above in steps 2 to 5 is repeated.
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Water flush
The system is prepared according to the procedure described in Prepare System and
Reservoir, on page 109.

Stage Description

1 The reservoir is filled with 100 mL water. Constant Retentate Volume
is activated, and the permeate valve is opened to P-VB-Out1. The
crossflow rate is set at a feed pressure 80% of the maximum feed pres-
sure value (to a maximum of 3 bar) and flux rate filtration control of 30
LMH (HF microfilter) or TMP filtration control of 1 bar (HF ultrafilter, flat
sheet cassette) is started. The filter is flushed with specified flush vol-
ume out P-VB-Out2 (default volume is 2 mL per cm2 of filter surface
area.)

2 After the specified flush through the filter, Constant Retentate Vol-
ume is disabled. If a Water Flux Test has been selected, the system
skips to the test; if not, 10 mL is emptied through the filter. P-VB is set
to Recycle and the liquid leaves the system through Trans-
fer_Purge_Valve to Waste.
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Stage Description

3 The reservoir is then emptied through R-VB-Out2.

Water flux test
If the step prior to the water flux test is a water flush step, the reservoir remains filled
and the water flux test is a continuation of the water flush step. If the water flux test
is used as a stand-alone step, the system is prepared according to the procedure de-
scribed in Prepare system, on page 112. The transfer inlet used is T-VB-In5 (water).

Stage Description

1 The permeate valve block, P-VB, is set to Recycle and the Trans-
fer_Purge_Valve is set to Reservoir. A permeate flow is started by the
specified TMP control (HF ultrafilter, flat sheet cassette; default value 1
bar) or in NFF mode (HF microfilter, default value is feed pressure, de-
termined by the filter pore size). When a stable flux has been achieved,
the normalized water flux value is measured by setting a
Set_Eval_Mark with the parameter Normalized_Water_Flux.
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Stage Description

2 Before ending the method, 10 mL water is flushed through the filter. P-
VB is set to Recycle and the liquid leaves the system through Trans-
fer_Purge_Valve to Waste.

3 The reservoir is then emptied through R-VB-Out2.

Storage
The system is prepared according to the procedure described in Prepare system, on
page 112. The transfer inlet used is T-VB-In8 (storage solution).
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Stage Description

1 The reservoir is filled with a small volume of storage solution.

2 The permeate valve block, P-VB, is set to Recycle and the transfer
purge valve is set to Waste. The crossflow rate is set at a feed pressure
80% of the maximum feed pressure value (to a maximum of 3 bar) and
flux rate filtration control of 30 LMH (HF microfilter) or TMP filtration
control of 1 bar (HF ultrafilter, flat sheet cassette) is started. The speci-
fied storage rinse volume is flushed through the filter into the permeate
(default value 30 mL, but this can be edited to a maximum value of 300
mL for the small reservoir or 1000 mL for the large reservoir).
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Stage Description

3 The Transfer_Purge_Valve is then switched to Reservoir and the stor-
age solution recycled for 5 minutes.

4 The reservoir is then emptied through R-VB-Out2.
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9 Process optimization in
Ultrafiltration

About this chapter
This chapter provides information on using the UF Process Optimization in the
Method Wizard.

Introduction
When filter type Flat Sheet is selected in the Method Wizard Basic Settings dialog,
a second method option (in addition to Concentration/Diafiltration) is available:
UF Process Optimization. This choice enables the creation of a TMP excursion
method that can be used to determine the optimal crossflow and TMP settings for an
ultrafiltration process.

Experimental plan

As an example, a 5 mg/mL antibody is to be concentrated to 50 mg/mL using a 100
cm2 filter. The experimental plan to determine the optimal crossflow rate and TMP
for the 10 fold concentration increase includes testing 3 different feed flow rates (QF)
with 5 TMP values at each crossflow rate. Because the optimal processing conditions
can vary with concentration, the optimization is performed on both dilute and con-
centrated material. When testing different optimization parameters, always start
with the least fouling conditions (high crossflow rate and low TMP), as the feed mate-
rial will be continually recycled during the 15 combinations of crossflow rate and TMP
tested.
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Antibody concentration
(mg/mL)

Set 1 Set 2 Set 3

5 QF (mL/min) 80 70 60

TMP setpoints (bar) 0.75, 1.0, 1.25, 1.5, 1.75

50 QF (mL/min) 80 70 60

TMP setpoints (bar) 0.75, 1.0, 1.25, 1.5, 1.75

Step Action

1 Fill in the Basic Settings data for the flat sheet cassette:

a. Surface Area

b. Pore Size

c. Filter Hold-Up Volume

d. Feed Pressure Limit

e. TMP Limit

f. Extra Tubing Volume

g. Reservoir Size

h. Tubing Kit
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Step Action

Click Next
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Step Action

2 In the UF Process Optimization dialog, input the following:

a. Buffer Conditioning before Start, if desired (default rinse volume is
30 mL, but this can be edited)

b. Sample Volume

Note:

The sample volume is the total volume in the reservoir + retentate holdup
volume.The system uses 31 mL extra sample volume to thoroughly flush
the retentate loop, so that the sample is not diluted at the start of the
process.

c. Number of crossflows

d. Feed Parameter (feed flow, retentate flow, or deltaP)

e. Crossflow 1, 2, and 3

f. Number and value of TMP Test Points
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Step Action

g. Retentate Recovery after the run (the retentate loop will be emptied
according to the procedure Recovery, no flush, on page 169).

9 Process optimization in Ultrafiltration

206  ÄKTAcrossflow User manual 29360935 AA



Step Action

3 Click Next. A summary of required solutions will be displayed.

Note:

The total sample volume displayed in the Summary contains 31 mL extra
sample volume for priming the recirculation loop.

4 To save the process optimization method, select File →Save As in the UNI-
CORN Method Editor.

5 Browse for a folder, enter a method name, select the system in the drop-
down menu, and click OK.

6 UNICORN will create a complete method, with each step contained with a
sub-block of a User Defined phase. To display the text instructions of the
created method, click the Text Instructions tab.
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Continuing the experiment
The suggested order of experiments is:

1. Run the method with the dilute protein solution.

2. Clean the filter.

3. Concentrate the protein.

4. Run the method with the concentrated protein concentration.

5. Clean and store the filter.

Evaluating results
The Filtration Analysis option in Evaluation allows for quick plotting and analysis of
the optimization run, see Chapter 12 Evaluating ÄKTAcrossflow results using Filtra-
tion Analysis, on page 227.

The image below shows an example result.

Figure 9.1: Evaluation of a TMP excursion run with a dilute glucoamylase solution
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10 Running ÄKTAcrossflow methods

About this chapter
This chapter describes how to make the final preparations before starting a run, how
to start the run, and what procedures to follow during the run.

In this chapter

Section See page

10.1 Final preparations 210

10.2 Start a run 213

10.3 During the run 215

10.4 Manual sampling during the run 216
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10.1 Final preparations

Introduction
This section describes the final preparations that should be done before starting a
run.

The Summary page created by the Method Wizard will list the required solutions,
the corresponding inlet positions, and volumes, as well as the outlet position usage.

Note: If the air sensor terminates the sample load, the maximum sample volume
will be the default 80,000 mL + 6 mL priming volume.

Solutions
Immerse the ends of the transfer inlet tubing in the appropriate solution containers.

Check that there are sufficient solution volumes available.

Note: Use ultra pure water when preparing solutions and buffers.
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Sample
Put the end of the sample inlet tubing into an appropriate sample container. If the air
sensor will terminate the sample load, ensure that the inlet tubing reaches the bot-
tom of the container, so that air is not prematurely detected (which will end the sam-
ple load without loading the entire sample volume).

Waste
Check that following outlet tubings are placed in waste containers:

• Transfer Purge Valve Waste

• R-VB-Out2

• P-VB-Out1

Check that the waste containers are not full and will accept the volume diverted to it
during the run.

Filter
Check that the correct filter is properly installed, with the correct tubing for feed, re-
tentate, and permeate. If you are blocking one of the permeate ports, we normally
suggest you block the permeate port closest to the feed with a stop plug.

Make sure that the filter is clean and of acceptable quality; utilize the Water Flux
Test to ensure cleaning efficiency.

Calibration
Calibrate the pH electrode and the level sensor before use. Refer to Section 3.8 Cali-
brate the pH electrode, on page 53.

WARNINGS and CAUTIONS
CIP method

When running a method using a CIP solution containing sodium hydroxide (NaOH):

WARNING
NaOH is corrosive and therefore dangerous to health. Avoid spill-
age and wear safety glasses, safety gloves, and protective lab
coat.
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CAUTION
Always ensure that the filters and system components are com-
patible with sodium hydroxide at the concentration, contact time,
and temperature used.

General

WARNING
Do not operate the ÄKTAcrossflow system at pressures above
the specified maximum pressure (5.2 bar).

10 Running ÄKTAcrossflow methods
10.1 Final preparations

212  ÄKTAcrossflow User manual 29360935 AA



10.2 Start a run
This section describes how to start an ÄKTAcrossflow run.

To begin the run, use the following procedure.

Step Action

1 In the System Control module, click File →Runand select the method you
wish to run.

Note:

Depending on user input, a Start Protocol may appear consisting of a
number of dialog boxes. (See UNICORN Method Manual for more informa-
tion).

2 Click Next or Back to go through the dialog boxes.
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Step Action

3 If the Result Name and Location dialog is selected, click the START but-
ton in this screen to initiate the method run. If the Result Name and Loca-
tion dialog is not selected in the Start Protocol, double-click on the meth-
od name inside the folder to initiate the method run.
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10.3 During the run
The method progress can be viewed in detail in UNICORN. The System Control mod-
ule displays the current status of the ÄKTAcrossflow and displays up to four view
panes for monitoring different aspects of the run.

To customize the view panes Run Data, Chart, Process Picture, and Run Log, drag
and drop them to desired location.

For more information about customizing the view panes, see the UNICORN System
Control Manual.

To stop the run before the end of programming, click the End button. You will be
asked if you wish to save the partial run result.

Note: If the run is in a Hold and is paused, you must click Hold to continue. Click-
ing Continue will bring the run out of Pause and Hold at the same time,
see the UNICORN System Control Manual.
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10.4 Manual sampling during the run
The instruction ManSample allows sampling from the retentate in the reservoir by
ensuring that concentration and diafiltration factors are correctly compensated.

To perform a manual sample, use the following procedure.

Step Action

1 In System Control select Manual →Execute Manual Instructions.

2 Under Recirc, select ManSample.

3 Enter the planned sample volume.

4 Open the lid of the reservoir.

5 Take a sample with an appropriate pipette device.

6 Immediately, click Execute in the ManSample dialog.

Note:

If ManSample is used when Constant Retentate Volume is active, the
system will start to compensate the lost volume immediately. Do not delay
in the execution of the ManSample instruction.

7 Close the lid.

Note:

To get an evaluation mark for Filtration Analysis in the result file, use the
manual instruction Permeate →Set_Eval_Mark with the parameter Ex-
tData_vs_Capacity.
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11 Post run procedures

About this chapter
This chapter describes how to sanitize the ÄKTAcrossflow after a run and how to
view and print the results.

In this chapter

Section See page

11.1 System sanitization 218

11.2 Viewing and printing the result 224

11 Post run procedures
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11.1 System sanitization
To make sure that the system is clean, for example process in run before storage, or
before a new filter is used, it is recommended to sanitize the system with a suitable
sanitization solution, such as 1 M NaOH. By repeating the System Sanitization
method with a different solution, the method can also be used to pH neutralize the
system after sanitization and to exchange the solution in the system to an appropri-
ate storage solution, for example 20% ethanol.

CAUTION
Always remove the filter and replace with a three-way connector
(18117059) when running the System Sanitization. the System
Sanitization method uses high flow rates and pressures that are
incompatible with most crossflow filters. Replace the pH elec-
trode with a dummy electrode and remove the reservoir float.

WARNING
The reservoir is overfilled during the sanitization. It is important to
have the correct Reservoir Cleaning Kit tubing plumbed to
waste; if this tubing is not secure, spillage will occur. NaOH is cor-
rosive and therefore dangerous to health. Avoid spillage and wear
safety glasses, safety gloves, and protective lab coat.

Note: The stirrer should be present in the reservoir during sanitization. However,
it must be replaced with a new aseptic one after the sanitization.

Sanitization of the pump rinsing
system

When performing a System Sanitization, the pump rinsing system should be sani-
tized by replacing the 20% ethanol rinsing solution with 1 M NaOH.

Sanitization of the reservoir float
The reservoir float must be sanitized separately. Remove it from the reservoir before
the System Sanitization. The float can be chemical sanitized or autoclaved.

11 Post run procedures
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Create a System sanitization
method

To create a System Sanitization method, use the following procedure.

Step Action

1 In the Method Editor, select the new method icon

2 Select the system.

3 Select the Method Wizard.

4 Click OK.
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Step Action

5 In the Basic Settings dialog, select the method System Sanitization.

6 Enter a Recirculation Time. A minimum recirculation time of 30 minutes is
recommended.
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Step Action

7 Select the Reservoir Size.

8 An optional purge with 70% ethanol can be used to remove trapped pock-
ets of air in the retentate valve block. If selected, you will be prompted to
manually add the 70% ethanol solution to the reservoir.

Note:

The information displayed in the Basic Settings dialog. All inlets and out-
lets must be placed into the sanitization solution and all outlets will be used.

CAUTION
70% ethanol can require the use of explosion-proof
areas and equipment.

9 Click Finish.

10 Save the method.

Run the System sanitization
method

WARNING
NaOH is corrosive and therefore dangerous to health. Avoid spill-
age and wear safety glasses, safety gloves, and protective lab
coat.
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CAUTION
Always make sure that the system components are compatible
with the chosen sanitization solution at the concentration, con-
tact time, and temperature used.

To run the System Sanitization method, use the following procedure.

Step Action

1 Prepare a sanitization solution which is compatible with the
ÄKTAcrossflow system, for example 1 M NaOH. If using the small (350 mL)
reservoir, 5000 mL is required; if using the large (1100 mL) reservoir, 7000
mL is required.

2 Fill the pump piston rinsing bottles with 1 M NaOH (2 × 200 mL).

3 Replace the filter with a three-way connector.

4 Replace the pH electrode with a dummy electrode.

5 Remove the float from the reservoir.

6 If an air filter is connected to the reservoir, remove the filter. Connect the
Reservoir Cleaning Kit (11003386) tubing to the closed lid of the reser-
voir.

Note:

To avoid siphoning waste liquid back into the reservoir, keep the reservoir
tubing above the liquid of waste solution in the waste bottle.

7 Place all inlet tubing into the prepared sanitization solution.

8 Place all outlet tubing into a waste container.
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Step Action

9 Run the method.

Note:

at the end of the System Sanitization method, the system will remain in
sanitization solution which must be rinsed out for further use or for storage.
Do not store the ÄKTAcrossflow in NaOH.

10 After the System Sanitization method, empty the system rinsing bottles
and fill them with 20% ethanol.

11 Repeat the method using ultra pure water or buffer instead of sanitization
solution.

12 After the run with ultra pure water or buffer, empty the system rinsing bot-
tles and fill them with 20% ethanol.

13 Replace the stirrer with a new aseptic one.
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11.2 Viewing and printing the result
This section describes the basics of how to view and print the result in the Evalua-
tion module.

View the result

To view the result, use the following procedure.

Step Action

1 Double click on the Evaluation icon to open the UNICORN Evaluation
module.

2 Locate the result file in the Results folder.
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Step Action

3 Double-click the file.

Result:

file opens in a chart window in the Evaluation module.

4 Charts can be included or excluded for analysis from the chart selection
pane.

Refer to the UNICORN Evaluation Manual for more information.

Print the result

To print the chart, use the following procedure.

Step Action

1 Select the chart you want to print in the chart selection pane.
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Step Action

2 Select the File →Printcommand.

3 Select the number of copies, printer, orientation, and check Include Chart.

4 Click on Print.

Refer to the UNICORN Evaluation Manual for more information.

Evaluation Classic
For more complex actions, such as report creation, procedures, and setting vertical
markers over a reference area (for example, to average flux rates across a product
run), Evaluation Classic is available under a separate UNICORN license. Refer to the
UNICORN Evaluation Manual for more information.
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12 Evaluating ÄKTAcrossflow results
using Filtration Analysis

The UNICORN Evaluation module contains a special analysis tool for filtration runs,
called Filtration Analysis. Five different operations are available for rapid analysis of
runs performed on the ÄKTAcrossflow system:

• Process Optimization

• Diafiltration Time Optimization

• Normalized Water Flux

• Capacity Plots

• Any vs Any

About this chapter
This chapter describes how to analyze results from the run using the UNICORN Eval-
uation module.

In this chapter

Section See page

12.1 Open a result file in the Evaluation module 228

12.2 Analysis operations 234

12 Evaluating ÄKTAcrossflow results using Filtration Analysis

ÄKTAcrossflow User manual 29360935 AA 227



12.1 Open a result file in the Evaluation module
To start the Filtration Analysis, first open a result file in Evaluation. To do this, use
the following procedure:

Step Action

1 In the UNICORN Evaluation module, select the result to be analyzed in the
result browser.

12 Evaluating ÄKTAcrossflow results using Filtration Analysis
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Step Action

2 Double-click on one result file or right-click on multiple result files to com-
pare the selected results.
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Step Action

3 Once the result file(s) is open, click on the Filtration Analysis button to
start the analysis.

Note:

If the result file is being analyzed for the first time, UNICORN will request
first to close the opened result to enter the Filtration Analysis module.

4 Close the opened result to enter the Filtration Analysis module. The Any
Vs Any algorithm is be applied to the selected results by default.

Note:

For each operation, specific curves for that operation are selected by default,
but these are user editable, by clicking on Formula Curves.

12 Evaluating ÄKTAcrossflow results using Filtration Analysis
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Step Action

5 Select/deselect the curves and charts to be displayed in Curve Selection
and Chart Selection on the right hand side.

Note:

ÄKTAcrossflow methods created by the Method Wizard contain multiple
charts to split the results between preproduct, product, and postproduct
steps. Additionally, each method begins with a chart 11, which is the data
generated at the beginning of a method wizard run in which the reservoir is
emptied to start the run. This can be de-selected as standard.
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Step Action

6 To apply a particular type of analysis, click on the analysis name in the Fil-
tration Analysis selection box.

Result:

The chart now shows the selected analysis.

Note:

If multiple files have been opened, the results appear as separate charts
which can be selected or removed by clicking on Chart Selection on the
right hand side.

12 Evaluating ÄKTAcrossflow results using Filtration Analysis
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Step Action

7 Analyses can be saved, and are denoted in the Results list with a Filtra-
tion Analysis symbol.
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12.2 Analysis operations

In this section

Section See page

12.2.1 Process optimization 235

12.2.2 Diafiltration time optimization 242

12.2.3 Normalized Water Flux (NWF) 245

12.2.4 Capacity plots 249

12.2.5 Any vs Any 254
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12.2.1 Process optimization
Process optimization is used to analyze a special type of process characterization
where a series of setpoints are tested. The most common experiments are excur-
sions of TMP at different feed conditions, such as crossflow rates or protein concen-
tration. In this operation, a new plot is made from user-defined points along original
data curves (e.g., permeate flux vs. TMP). Process optimization also allows the user to
overlay multiple plots (e.g., flux vs. TMP at different crossflow rates or protein con-
centrations). This capability can be used for any process parameter, but is most often
used to determine the optimal crossflow rate and TMP for a product concentration/
diafiltration step.

Generally, permeate flux increases with increasing TMP. However, as a concentration
polarization layer is formed at the membrane surface, the flux vs. TMP curve flattens.
Increasing the TMP beyond this flattening often leads to a flat line or decreasing
curve, where increasing the TMP does not increase the permeate flux, due to forma-
tion of a gel layer on the membrane surface and subsequent control of the gel layer
over the filtration process.

With this operation, data from up to 3 crossflow rates per result (with multiple TMP
values) can be overlaid.

Tip: For a comparison of more than 3 crossflow rates, split the optimization method
into multiple runs. The multiple results can then be opened and compared, allowing
filtration analysis to be performed on all crossflow rates in one operation.
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To start the Process Optimization, use the following steps:

Step Action

1 Either:

• Double-click on a single Flat Sheet UF Process Optimization result
file

or

• select multiple Flat Sheet UF Process Optimization result files, right
click, and Open/Compare.

Note:

In this example, two results generated from flat sheet cassette UF Process
Optimization methods are opened, one from dilute protein tested at 5 dif-
ferent TMPs each for 3 crossflow rates, and the second from concentrated
protein tested at the same 5 different TMPs each, for the same 3 crossflow
rates.

12 Evaluating ÄKTAcrossflow results using Filtration Analysis
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Step Action

2 Click on Filtration Analysis and if prompted, close without saving.

Result:

The result files are opened under the default Any vs Any operation.

3 Deselect the two 11 charts by clicking on the multi-colored icon next to
their names.

4 Select the Process Optimization operation.
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Step Action

5 In the UF Process Optimization method, as each TMP stabilized, the
method inserted an evaluation mark with the instruction Set_Eval_Mark
for ProcessOptimisation . In the section at the bottom of the page, select
each chart to see where the permeate flux evaluation marks were made in
the optimization run.

6 For each chart, click on a data point in the table to create a vertical marker
in the chart.

Note:

The data point can be changed if, based on visual determination of the flux
curve, another point on the curve is more suitable. Simply bring the mouse
cursor into the chart; a vertical marker appears. Right click to add another
data point to the table. Click on any table entry that you would like to ex-
clude. Scroll through all charts to make any desired changes to the data
points in the table.
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Step Action

7 For better visual inspection, click and drag on the chart to zoom into the
selected area.
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Step Action

Note:

A magnifying glass icon will appear in the upper right corner. Click the icon
to zoom out to the full chart again.

8 Once you are satisfied with the data point selection, click on the Expand
Result View in the bottom right hand corner.
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Step Action

9 Visually determine the most suitable crossflow rate and TMP value for a
run by observing the change in the permeate flux curve with increasing
TMP values.

Note:

The most appropriate combination of crossflow rate and TMP can be seen
where the flux is still increasing with increasing TMP, before the flux curve
starts to flatten. Additionally, under View →Data Points, a vertical marker
appears by moving the mouse cursor into the pane, showing the permeate
flux rates (color-coded to the individual charts) at a certain TMP value.

10 To present your data, utilize Copy to Clipboard. There are two options:

a. Presentation, which copies the chart to the clipboard in a presentation
size format.

b. Window, which copies the chart to the clipboard in screen size (same
as Ctrl+C).
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12.2.2 Diafiltration time optimization
For a given ultrafiltration process, the operation Diafiltration Time Optimization
allows the user to identify the factor of volume concentration where the least time is
required to complete the diafiltration. This is a function of the increase of concentra-
tion vs the subsequent decrease in permeate flux.

Diafiltration Time Optimization creates a plot of the diafiltration time optimization
parameter (concentration factor × flux) vs concentration factor. The concentration
factor that corresponds to the highest value of the DF time optimization parameter
(y) along the plot is the optimal concentration factor to perform a diafiltration (for the
conditions tested).

This filtration analysis is performed on a result file from a concentration process
which was run to the desired maximum concentration factor. To start the Diafiltra-
tion Time Optimization analysis, use the following procedure:

Step Action

1 Double-click on a result file in which a concentration to maximum desired
concentration factor has been performed.

2 Click on Filtration Analysis and if requested, exit without saving.

3 Deselect any chart that does not contain the concentration step.

4 Click on the Diafiltration Time Optimization operation.

5 Deselect the chart 11 under Chart Selection by clicking on the multi-col-
ored icon next to their names
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Step Action

6 Set the left and right boundary limits for the data. To see the effect that the
increasing concentration has on the permeate flux rate, use the left mouse
button to drag the boundary marker to the high point of the permeate flux
on the left.

Note:

The plotting region between the left and right markers is defined by
Start_Eval_Window and Stop_Eval_Window instructions in a concentra-
tion step of a product method.
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Step Action

7 Click on Expand Result View to observe the plotted graph of (concentra-
tion factor × flux) vs concentration factor.

8 Determine the concentration factor in which the diafiltration should be
performed by visual assessment. Make note of the concentration factor
that corresponds to the highest point on the y axis.
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12.2.3 Normalized Water Flux (NWF)
The membrane permeability can be tested using the Normalized Water Flux opera-
tion (also called the normalized water permeability or NWP, or clean water flux). This
test is used to make sure that the cleaning is effective and to determine the lifetime
of a filter. The Normalized Water Flux is calculated using the following formula:

Normalized water flux [Lm-2h-1bar-1] = (permeate flux × temperature correction fac-
tor)/TMP

The Normalized water flux operation enables the user to automatically calculate
the normalized water flux from a result file and to plot results from multiple filter cy-
cles on a single plot.

An industry standard temperature correction chart for crossflow filtration processes
is used. Temperature can be displayed in either Celsius or Fahrenheit.
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To test the membrane permeability with the Normalized Water Flux operation, use
the following procedure:

Step Action

1 Either:

a. double-click on a single result file containing a Water Flux Test step,or

b. select multiple result files, right click, and Open/Compare.

Note:

In this example, four result files that contain Water Flux Test steps are
opened.

2 Click on Filtration Analysis and if requested, exit without saving.
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Step Action

3 Select the NWF operation.

Note:

The resulting graph contains a Value Table in which the normalized water
flux values are listed, in order of date and time stamp.

4 If required, enter a new value in the Average Calculation Window (Avg).

Note:

The default value for the calculation window is 15 seconds before the mark-
er position. The values are expressed as the exact flux at the marker point,
with averages in parentheses based on the Average Calculation Window
(Avg). The values in the Value Table will automatically update, including
the Correction Factor, which is based on the averaged values.
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Step Action

5 Click on Expand Result View to observe the normalized water flux values
plotted over time, in order of result date and time stamp.
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12.2.4 Capacity plots
Capacity Plots allow the user to plot any process parameter vs the accumulating
permeate volume normalized to the surface area. Capacity is defined as liters of per-
meate volume per m2 surface area.

The capacity plot operation also accepts input of a system-external result from sam-
pling during a run (e.g., activity assay results or protein concentration determination).
This enables plotting of the external result vs capacity.

To start the process, use the following steps.

Step Action

1 Double-click on a result file containing either a concentration or a diafiltra-
tion product step.

Note:

Although most capacity plots are used for product steps, this operation can
be used on any result file to plot any process parameter vs capacity. The ex-
ample below will show the use of the capacity plot operation on a product
step.

2 Click on Filtration Analysis and if requested, exit without saving.

3 Deselect any chart which does not contain a product step.
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Step Action

4 Select the desired curve to plot against capacity. For example, in a concen-
tration step, permeate flux can be plotted as a function of filter capacity.
Adjust the left and right boundary limits to include the desired data.

5 The filter area is imported from the result and is used to calculate capacity.
It can, however, be edited, if desired.

Note:

A result file can contain more than one analysis window. When a product
method is created by the Method Wizard, every product step is defined by
Start_Eval_Window and Stop_Eval_Window instructions. The possible
analysis windows in this result represent a 3-product step process: concen-
tration, diafiltration, and concentration.
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Step Action

6 Click on Expand Result View to observe the chosen curve (in this example,
permeate flux) vs capacity.

Note:

Chart names can also be changed under Home →Rename Result Curve by
selecting the result name in the upper box and editing the name in the lower
box.
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Step Action

7 To plot External Data vs Capacity, select External in the drop-down
menu.

Result:

A table will open, into which the external data measured can be entered
offline (e.g., activity assay results or protein concentration).

8 Enter the permeate volume at which the offline measurement was made
and the value of the offline measurement by double-clicking in the pane
under the appropriate columns (PermVol and External ).
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Step Action

9 Enter the name of the external signal and the unit in the Set Unit/Define
External Signal box.

10 To exclude a data point, select the data point, right click, and click Exclude.

11 To add additional data points during the run, in System control click Man-
ual →Execute →Manual Instructions →Set Mark.

12 Click on Expand Result View in the bottom right hand corner to view the
plot.
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12.2.5 Any vs Any
The Any vs Any operation provides the capability to plot any process parameter
captures as a curve in a given result file on either the x axis against any other process
parameter captured as a curve on the y axis.

To perform this operation, use the following steps:

Step Action

1 Double-click on a result file.

2 Click on Filtration Analysis and if requested, exit without saving.

Note:

Any vs Any is displayed by default.

3 Deselect any chart which does not contain information of interest.

4 To choose the curves to plot on the x and y axes, select the drop-down me-
nus in the Formula Curves box.

Note:

If using the Any vs Any operation with a result generated from a method
created by the Method Wizard that contains product steps (concentration
and diafiltration), each step is defined by Start_Eval_Window and
Stop_Eval_Window instructions.

12 Evaluating ÄKTAcrossflow results using Filtration Analysis
12.2 Analysis operations
12.2.5 Any vs Any

254  ÄKTAcrossflow User manual 29360935 AA



Step Action

5 If analyzing a product run with multiple analysis windows, choose the ap-
propriate window in the drop-down menu in the Select Analysis Window
box.

'

Note:

In this example, the conductivity curve will be plotted as a function of the di-
afiltration factor, so Analysis Window 2 from the diafiltration step has
been selected.
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Step Action

6 Click on Expand Result View to observe the conductivity plotted as a
function of the diafiltration factor.

7 Rename the plot under Home →Rename Result Curve.
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13 Feedback tuning and PID
parameters

About this chapter
This chapter provides a description of the PID parameters used to control the feed
retentate and permeate pressure setpoints in the ÄKTAcrossflow.

In this chapter

Section See page

13.1 PID control 258

13.2 Description of the PI parameters and regulators 262

13.3 Setting up feedback tuning 263

13.4 Optimizing the PI parameters 264
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13.1 PID control
Whenever an automated process step requires the control of pressure (feed reten-
tate and permeate pressure), the UNICORN control software of ÄKTAcrossflow em-
ploys PID-type controllers to control the pressure to its setpoint. Recommended de-
fault settings for the controllers (P, PI, or PID type) are listed in table on page 259.
These settings provide fast response and robust control for most operating situa-
tions. However, the following controllers may require adjustment depending on the
type and behavior of the filter:

Feed pump control
FeedPressure_PI, DeltaP_PI, and EmptyResFeed_PI.

These three controllers ramp the flow rate of the feed pump to achieve a desired
pressure. The default settings are appropriate for flat sheet cassettes that give high-
er back pressure than hollow fiber cartridges at a given flow rate. When using hollow
fiber cartridges, the action of the Integral controller (I parameter) can be increased
(by reducing the figure for the I parameter) to yield a faster pump response and
shorter ramp time, respectively. For the alternative settings, see table on page 259.

When creating methods with the Method Wizard, the alternative settings for PID
control detailed in table on page 259 are automatically used.

TMP control
TMP_PID_PermeatePump and TMP_PID_RetentateControlValve.

During TMP control, the permeate pump controls the permeate pressure by adjust-
ing the flow rate of the permeate pump. Depending on membrane area, filter cut-off,
and process conditions, the magnitude of the permeate flow rate may vary in a wide
range from less than 1 mL/min to 50 mL/min and higher. Two settings are recom-
mended to provide fast and robust control, see also table on page 259.

During non-product process steps when the membrane is not exposed to process
fluids, thus avoiding the risk for membrane fouling or gel-layer formation, a high per-
meate flow rate and linear pressure-flow relationship is typical. Under these condi-
tions, "fast" PID settings are recommended.

During non-product process steps when the membrane is not exposed to process
fluids, thus with a risk of membrane fouling or gel-layer formation, slower but more
robust control results in low permeate flow rates and a non-linear pressure-flow re-
lationship. Under these conditions, “slow” PID settings are selected as default values
in the strategy to provide maximum robustness of the control.
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Table 13.1: Recommended settings for PID control.

Con-
trol el-
ement

PID settings P I D

Feed
pump
control

Hollow fibers:

FeedPressure_PI Del-
taP_PI EmptyRes-
Feed_PI

Flat sheet cassettes:

FeedPressure_PI Del-
taP_PI EmptyRes-
Feed_PI

 

0.050.050.05

 

0.050.050.05

 

502020

 

150150150

 

N/AN/
AN/A

 

N/AN/
AN/A

TMP
control

TMP_PID_Retentate-
ControlVal-
veTMP_PID_Permeate-
Pump (membrane not
exposed to pro-
teins)TMP_PID_Perme-
atePump (membrane
exposed to pro-
teins)TMP_PID_Perme-
atePump (hollow fibres)

0.10.1 0.03 0.05 2020 300 75 10 0 0

PUF
control

PUF_PI_RetentateCon-
trolValve PUF_PI_Per-
meatePump

0.010.001 20200 N/AN/
A

Flux
control

Flux_PI_RetentateCon-
trolValve

0.1 20 N/A

NFF
control

pNFF_PI 0.20.05 20150 N/AN/
A

Level
control

Const_RVol_P 50 N/A N/A
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Tuning and troubleshooting of
PID control

Typically, only control settings for Feed Pump or Permeate Pump need to be adjus-
ted. The control settings for the Retentate Control Valve given in table on page 259
should not be modified at all. Common methods for PID optimization (e.g., Ziegler-
Nichols method) can be applied.

In most situations, good results are obtained when using the following rules of
thumb:

• Slower control: increase I parameter, decrease P parameter

• Faster control: decrease I parameter, increase P parameter

No drastic changes should be applied. An appropriate measure is to change parame-
ter I up or down by a factor of 2, while initially keeping the P parameter constant.

PI parameters for larger filter
areas

When using larger filter areas, for example, > 100 cm2, it is necessary to optimize the
PI parameters.

When optimizing the parameters to obtain a faster regulation, a recommended start
is given below.

• Decrease I parameter by a factor of 2

• Increase P parameter by a factor of 1.2

When the regulation is too fast, which can result in, for example, noisy curves, it may
be necessary to slow down the control by doing the following.

• Increase I parameter and decrease P parameter

Hardware components using PI
and PID parameters

The following table describes the PI and PID parameters that are used for hardware
components and instructions.

Table 13.1: Hardware components using PI parameters.

Hardware component Instruction

Feed pump Feedpump_PIDeltaP_PI

Retentate Control
Valve

TMP_PID_RetentateControlValve Flux_PI_Reten-
tateControlValve PUF_PI_RetentateControlValve
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Hardware component Instruction

Permeate Pump TMP_PID_PermeatePump PUF_PI_PermeatePump
pNFF_PI

Reservoir ConstRVol_P EmptyResFeed_PI
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13.2 Description of the PI parameters and regulators
table on page 262 describes the three PID parameters used.

Table 13.1: PID parameters

Pa-
ra-
me-
ter

Description

P The P parameter reduces the effect of an error but does not completely
eliminate it. A simple P-regulator results in a stable stationary error be-
tween actual and requested flow or pressure.

I The I parameter eliminates the stationary error, but results in a slight in-
stability leading to oscillations in the actual flow or pressure. The I pa-
rameter can have values between 0 and infinity. Smaller values have a
greater effect and a value of infinity has no effect.

Note:

The value infinity is set as 9999 in UNICORN.

D In certain cases, the D parameter can reduce the oscillations introduced
by a PI-regulator. D can have values between 0 and infinity, where larger
values have a greater effect and a value of 0 has no effect.

Note:

Most often, a simple PI-regulator is preferable for control of pressure, and
the ÄKTAcrossflow is therefore configured by default with the D parame-
ter set to zero.
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13.3 Setting up feedback tuning
UNICORN uses PI feedback tuning, where P and I are parameters that determine the
tuning characteristics.

There are two ways to apply the feedback tuning instructions:

• In the Method Editor module.

• In the System Control module, reached with the commands Manual →Execute
Manual Instructions or System →Settings.

Instruction groups
The PI instructions are found in the following Instruction groups described in the ta-
ble below.

Instruction name Instruction group

FeedPressure_PI System: Settings: Specials Method/Manual: Re-
circulation

TMP_PID_RetentateControl-
Valve

System: Settings: Specials Method/Manual:
Permeate

TMP_PID_PermeatePump System: Settings: Specials Method/Manual:
Permeate

Flux_PI_RetentateControl-
Valve

System: Settings: Specials Method/Manual:
Permeate

PUF_PI_RetentateControl-
Valve

System: Settings: Specials Method/Manual:
Permeate

PUF_PI_PermeatePump System: Settings: Specials Method/Manual:
Permeate

pNFF_PI System: Settings: Specials Method/Manual:
Permeate

DeltaP_PI System: Settings: Specials Method/Manual: Re-
circulation

ConstRVol_P System: Settings: Specials Method/Manual:
Transfer

EmptyResFeed_PI System: Settings: Specials Method/Manual: Re-
circulation
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13.4 Optimizing the PI parameters
The objective to optimize the PI parameters is to obtain a sufficiently fast and
smooth regulation without over-pressurization.

PI values that are too weak may lead to a smooth but slow ramping

PI values that are too aggressive may lead to a fast but unstable ramping.

Example: Regulation of the Feed
pump

In this example, the Feedpump_PI instruction was adjusted during manual operation
of the system. The Feed pump was run using different PI parameter values to obtain
a set Feed pressure.

PI settings Curve example
(Feed pump
flow)

1) Settings: The I parameter was set to a high val-
ue (1000), which means it has minimal effect of
the regulation.

The P parameter was set to a high value (1.0).

Result: Uncontrolled regulation with high fluctu-
ations.

2) Settings: The I parameter was kept to 1000.
The P parameter was set to 0.5.

Result: The size of the first step is too large.
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PI settings Curve example
(Feed pump
flow)

3) Settings: The I parameter was maintained at
1000. The P parameter was set to 0.2.

Result: The size of the first step is still too large.

4) Settings: The I parameter was maintained at
1000. The P parameter was set to 0.1.

Result: The size of the first step is still too large.

5) Settings: The I parameter was maintained at
1000. The P parameter was set to 0.05.

Result: The size of the step seems to be correct.

6) Settings: The P parameter is maintained at
0.05. The optimization of the I parameter starts a
value of 500 and continues with 200.

Result: The slope of the curve increases with de-
creased I values.
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PI settings Curve example
(Feed pump
flow)

7) Settings: The I parameter is further decreased
from 200 to 100. The P parameter is maintained
at 0.05

Result: Increased slope is obtained.

8) Settings: The P parameter was maintained at
0.05 and the I parameter was set to 25.

Result: The curve indicates a too high flow before
it stabilizes. The I parameter should be in-
creased.

9) Settings: The I parameter is increased to 50
and the P parameter is maintained at 0.05

Result: The PI parameters are optimized and a
smooth and fast regulation is obtained.

Example: Regulation of the
Permeate pump

In this example, the TMP_PI_PermeatePump instruction was adjusted during man-
ual operation of the system. TMP Control was set to 1 Bar and was monitored at dif-
ferent PI values.
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PI settings Curve example
(TMP)

1) Settings: The P parameter was set to 1. The I
parameter was set to 100.

Result: Pressure peaks were observed both in
the beginning of the regulation and when the
TMP was reached.

2) Settings: The P parameter was decreased to
0.2. The I parameter was decreased to 50.

Result: Smooth regulation up to set the TMP and
no pressure peaks were observed when the TMP
was reached.
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14 Strategy instructions

About this chapter
This chapter provides details on all of the system instructions for the ÄKTAcrossflow.

In this chapter

Section See page

14.1 System settings and instruction boxes 269

14.2 Recirculation instructions 272

14.3 Permeate instructions 280

14.4 Transfer instructions 289

14.5 Alarms, Warnings, and Monitors 292

14.6 Fraction collector instructions 310

14.7 Monitor UPC-980 311

14.8 Watch instructions 313

14.9 Calibration 314
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14.1 System settings and instruction boxes

System setting: the order of
instructions within each group

Alarms/
Warnings

Specials Monitors Curves

UVpHCond-
Feed_Press
Trf_Press-
DeltaPTMP-
Flux-
ShearpNFF-
ValvesFlow-
pathAirSen-
sorZeroLe-
vel

RetentateHoldUpVolPressur-
eOffsetRPCVoffset RPCVhys-
teresis PPCV_SetpTo-
tal_Membrane_Area Lu-
men_Diameter Total_Num-
ber_of_Fibers AuxOut1Aux-
Out2AuxOut3AuxOut4Feed-
Pressure_PI Del-
taP_PITMP_PID_Retentate-
ControlValve TMP_PID_Per-
meatePumpFlux_ PI_Retenta-
teControlValve PUF_PI_Re-
tentateControlValve
PUF_PI_Permeate-
PumppNFF_PIEmptyRes-
Feed_PI ConstRVol_PFrac-
Parameters1 Frac_Number-
ing_Mode1 Reservoir_Size

AveragingTimeUV-
Pressure_Filter_Fac-
tor CondTempComp-
CondRefTemp
pHTempCompAirSen-
sorWatchPar_UV
WatchPar_pH Watch-
Par_CondWatch-
Par_Feed_Press
WatchPar_Re-
ten_Press WatchPar_
PermPress Watch-
Par_FeedFlow Watch-
Par_Ret_Flow Watch-
Par_ PermFlow
WatchPar_TrfFlow
WatchPar_ RetVol
WatchPar_ ResVol
WatchPar_ PermVol
WatchPar_ TransVol
WatchPar_ DeltaP
WatchPar_ TMP
WatchPar_ Flux
WatchPar_ Shear
WatchPar_ pNFF
WatchPar_ConcFact
WatchPar_DF_X_Fact
WatchPar_
%Flux_Drop

UVCond Feed-
Flow RetFlow
PermFlow
TrfFlow
Feed_Press
RetenPress
PermPress
pHTemp Del-
taP TMP Flux
Shear Con-
cFact
DF_X_Fct Re-
tVol ResVol
PermVol
TransVol Con-
vRatio pNFF
AuxIn1 Aux-
Out1

1 Fractionation instructions are only shown when Fraction Collector has been selected in Administration →System
Properties.
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Instruction box: the order of
instructions within each group

Recirc Permeate Transfer Alarms, Warnings,
and Monitors

Watch1

FeedFlowRet-
FlowFeedpres-
sureDeltaP-
ShearReten-
tate_Valve_Block
EmptyReservoir-
EmptyReservoir-
AbortConcentra-
tion_FactorMix-
erSpeedSet_Re-
sVol_Totalizer-
ManSample2

FeedPres-
sure_PIDel-
taP_PIEmptyRes-
Feed_PIRetenta-
teHoldupVol

TMP_Control-
Flux_ControlPer-
meate_Valve_blo
ckPermeate_Un-
restric-
ted_FlowNFF_Co
nstant-
FlowNFF_Con-
stantPressureS-
tart_Eval_Win-
dowS-
top_Eval_Win-
dowS-
et_Eval_MarkS-
et_PermVol_To-
taliz-
er
%Flux_Drop_Cal
cTotal_Mem-
brane_Sur-
face_AreaLu-
men_Diameter-
vTotal_Num-
ber_Of_Fi-
bersTMP_PI_Re-
tentateControl-
ValveTMP_PIPer-
meatePump-
Flux_PI_Retenta-
teControlValve-
PUF_PI_Retenta-
teControlValve-
PUF_PI_Permea-
tePumppNFF_PI-

Trans_Flow-
Con-
stant_Ret_Volu-
meTrans-
fer_Valve_Block-
sTrans-
fer_Purge_Valve-
Set_TrfVol_Total-
izerDF_Exchan-
geFactorMe-
thod_Base1 Con-
stRVol_P

AutoZeroUVAvera-
ginfTimeUVPres-
sure_Filter_FactorA-
larm_UVAlarm_pHA-
larm_CondA-
larm_FeedPressA-
larm_TrfPressA-
larm_DeltaPA-
larm_TMPAlarm_Flux-
Alarm_pNFFA-
larm_ShearA-
larm_ValvesA-
larm_FlowpathA-
larm_AirSensorA-
larm_ZeroLevel-
WatchPar_UVWatch-
par_pHWatch-
Par_CondWatch-
Par_FeedPressWatch-
Par_RetenPress-
WatchPar_Perm-
PressWatchPar_Feed-
FlowWatchPar_Re-
ten_FlowWatch-
Par_PermFlowWatch-
Par_TrfFlowWatch-
par_ResVolWatch-
par_RetVolWatch-
par_PermVolWatch-
par_TransfVolWatch-
par_DeltaPWatch-
par_TMPWatch-
par_FluxWatch-
par_ShearWatch-
par_pNFFWatch-
par_ConcFactor-

Hold_Until-
Watch_UV-
Watch_pHWatch
_Cond-
Watch_Feed-
PressWatch_Re-
tenPress-
Watch_Perm-
Press-
Watch_Feed-
FlowWatch_Re-
ten_Flow-
Watch_Perm-
Flow-
Watch_TrfFlow-
Watch_RetVol-
Watch_ResVol-
Watch_PermVol-
Watch_Trans-
fVolWatch_Del-
taP-
Watch_TMPWat
ch_Flux-
Watch_Shear-
Watch_pNFFWa
tch_ConcFact-
Watch_DF_X_Fa
ctWatch_Flux_Dr
opWatch_Air-
Sensor-
Watch_ZeroLe-
velWatch_Aux-
In1Watch_Aux-
In2Watch_Aux-
In3Watch_Aux-
In4Watch_Off
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Recirc Permeate Transfer Alarms, Warnings,
and Monitors

Watch1

Fractionation3

Fractionation-
Stop3 ResetTu-
beNumberFeed-
Tube3

Watch-
par_DF_X_FctWatch-
par_%Flux_DropUV-
lampOFFLevelSensor-
Calibration

1 Only in Method Editor.
2 Only in System control.
3 Fractionation instructions are only shown when Fraction Collector has been selected in Administration →System

Properties.
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14.2 Recirculation instructions

FeedFlow

Instruction nameFeed-
Flow

FormulaQf GroupMethod/Manual
→Recirc

Parameter 1 nameFlow-
Rate

ModeControl Mode
Direct

Position name (default un-
derlined)0.0 mL/min
(0-600)

Instruction Help textStarts the flow on the Feed Pump. Feed Flow should stabi-
lize at 98% of set value before a new instruction is executed.

To stall a new instruction until the DeltaP has stabilized, a Watch_Stable Signal
DeltaP should be programmed in the methods. Instruction resets RetFlow, Feed-
Pressure, DeltaP, and Shear.

RetFlow

Instruction nameRet-
Flow

FormulaQr = Qf-Qp GroupMethod/Manual
→Recirc

Parameter 1 nameFlow-
Rate

ModeControl Mode
Direct

Position name (default un-
derlined)0.0 mL/min
(0-600)

Instruction Help textStarts the flow on the Feed Pump. RetFlow should stabilize
at 98% of the set value before a new instruction is executed. Instruction resets
FeedFlow, FeedPressure, DeltaP, and Shear.

To stall a new instruction until the DeltaP has stabilized, a Watch_Stable Signal
DeltaP should be programmed in the methods. Instruction resets FeedFlow,
FeedPressure, DeltaP, and Shear.

FeedPressure

Instruction nameFeed-
Pressure

FormulaPf GroupMethod/Manual
→Recirc
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Parameter 1 namePres-
sure

ModeControl Mode
Direct

Position name (default un-
derlined)0.00 bar (0.00 -
5.20)

Instruction Help textStarts the flow on the Feed Pump until the Feed Pressure
setpoint is reached. The FeedPressure should stabilize at 98% of the set value be-
fore a new instruction is executed.

To stall a new instruction until the DeltaP has stabilized, a Watch_Stable Signal
DeltaP should be programmed in the methods. Instruction resets FeedFlow, Ret-
Flow, DeltaP, and Shear.

DeltaP

Instruction nameDel-
taP

FormulaDeltaP = Pf -
Pr

GroupMethod/Manual
→Recirc

Parameter 1
namePressure

ModeControl Mode
PID

Position name (default un-
derlined)0.00 bar (0.00 -
5.20)

Instruction Help textStarts the flow on the Feed Pump until the Pf-Pr reaches
the DeltaP setpoint. The DeltaP should stabilize at 98% of the set value before a
new instruction is executed.

To stall a new instruction until the DeltaP has stabilized, a Watch_Stable Signal
DeltaP should be programmed in the methods. Instruction resets FeedFlow, Ret-
Flow, Shear, and FeedPressure.

Shear

Instruction name
Shear

Formula Shear = (4 × Qf)/(No. of Fi-
bers × π × (fiberradius)3)

Group Method/
Manual →Recirc

Parameter 1
nameFlowRate

ModeControl
Mode PID

Note:

Only for hol-
low fibers

Position name
(default under-
lined) 0 s-1 (0 - 20
000)
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Instruction Help text

This instruction is used for hollow fiber cartridges only and starts the flow on the
Feed Pump until the flow rate that equals a shear rate for a particular hollow fiber
cartridge is reached (which is dependent upon the fiber lumen diameter and num-
ber of individual fibers contained within the cartridge). The Shear should stabilize
at 98% of the set value before a new instruction is executed.

To stall a new instruction until the DeltaP has stabilized, a Watch_Stable Signal
DeltaP should be programmed in the methods. Instruction resets FeedFlow, Ret-
Flow, FeedPressure, and DeltaP.

Retentate_Valve_Block

Instruction nameReten-
tate_Valve_Block

GroupMethod/Manual →Recirc

Parameter nameMacro Position name (default underlined)R-
VB_Recycle, R-VB-Out1, R-VB-Out2,
R-VB-Out3

Instruction Help

Selects the position for the Retentate Valve Block, either R-VB-Recycle, R-VB-
Out1 (port located prior to filter device), R-VB-Out2, or R-VB-Out3. When Feed-
Flow > 0 or Constant_Retentate_Volume is active, no action is allowed. A warn-
ing will be raised.

Alarm help text 1: Retentate_Valve_Block instruction not allowed during Con-
stant_Retentate_Volume

Alarm help text 2: Retentate_Valve_Block instruction not allowed when Feed
setpoint > 0

Alarm help text 3: Retentate_Valve_Block instruction not allowed during Emp-
tyReservoir

Alarm help text 4: Retentate_Valve_Block instruction not allowed during NFF

RPCVoffset

Instruction nameRPCVoffset GroupSystem →Settings →Specials

Parameter namePressure Position name (default under-
lined)350, (0 - 999)
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Instruction Help

Sets offset on Retentate Control Valve used by system during TMP_Control,
Flux_Control, and Permeate_Unrestricted_Flow

Reservoir_Size

Instruction nameReservoir_Size GroupSystem →Settings →Specials

Parameter 1 nameSize Position name (default underlined)350
mL, (350, 1100 mL)

Instruction Help

Sets reservoir size to 350 or 1100 mL.

EmptyReservoir

Instruction nameEmptyReservoir GroupMethod/Manual →Recirc

Parameter 1 nameRetValveOutlet

Parameter 2 nameMaxFeedPres-
sure

Parameter 2 nameMaxFeedFlow

Position name (default underlined)R-VB-
Out1, R-VB-Out2, R-VB-Out3

 0.000 bar (0.00 - 5.20 bar)

  600 mL/min (0 - 600 mL/min)

Instruction Help

Instruction uses R-VB-Out to open a retentate outlet and FeedPump to empty
the reservoir in a controlled manner. In order to perform this, the FeedFlow is re-
duced when the reservoir level is below a certain value and R-VB-Out creates a
back pressure of approximately 2 bar to avoid siphoning. When the zero level is
reached, defined as just below reservoir bottom surface, FeedFlow is immediate-
ly stopped.

EmptyReservoirAbort

Instruction nameEmptyReservoir-
Abort

GroupMethod/Manual →Recirc
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Parameter 1 nameRetValvePort

Parameter 2 nameFeedFlow

Position name (default underlined)R-VB-
Recycle

 0.000 bar (0.00 - 5.20 bar)

  0.0 mL/min (0.0 - 600.0 mL/min)

Instruction Help

EmptyReservoirAbort aborts the sequence initiated by the EmptyReservoir in-
struction.

Instruction immediately stops the FeedFlow, and sets R-VB-Out to the Recycle
position. The Watch EmptyResFinished signal is then generated.

Concentration_Factor

Instruction nameConcentration_Fac-
tor

GroupMethod/Manual →Recirc

Parameter 1 nameMode

Parameter 2 nameType

Position name (default underlined)Off,
On

 FedBatch, TankBatch

Instruction Help

Starts the Concentration Factor calculation. Use a watch command in the meth-
od to set the endpoint on concentration factor. FedBatch cannot be operated
without a Set_ResVol_Totalizer volume entered.

Detailed information can be found in User Manual.

MixerSpeed

Instruction nameMixerSpeed GroupMethod/Manual →Recirc

Parameter 1 nameSpeed Position name (default underlined)Auto
(0 - 600 rpm)

Instruction Help

Sets the reservoir mixer speed. Auto adjusts the mixer speed to the reservoir size
(set in System →Settings) and linearly adjusts the speed to the current ResVol.
Minimum speed is 80 rpm; maximum speed is 200 rpm for the 350 mL reservoir
and 300 rpm for the 1100 mL reservoir.
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Set_ResVol_Totalizer

Instruction nameSet_ResVol_Totaliz-
er

GroupMethod/Manual →Recirc

Parameter 1 nameSpeed Position name (default underlined)0.0
mL (0.00 - 5 000.00)

Instruction Help

Sets a desired volume for the reservoir volume totalizer. The totalizer value is cal-
culated based on pump actions. Flow from the Transfer Pump will increase the
value, if it is directed to the reservoir. Permeate flow measured by the Permeate
Pump, if a permeate outlet valve is open, will decrease the volume, but not if the
Permeate_Valve_Block is in the Recycle position and the Trans-
fer_Purge_Valve is in position Reservoir. FeedFlow with an open retentate valve
position will also decrease the totalizer volume.

ManSample

Instruction nameManSample GroupManual →Recirc

Parameter 1 nameVolume Position name (default underlined)0.00
mL (0.00 - 100.00)

Instruction Help

Reduces reservoir volume totalizer with the volume of removed sample at the
moment of execution of the instruction. For more information, see Section 10.4
Manual sampling during the run, on page 216. For correct concentration and dia-
filtration factor calculations, it is important that the ManSample instruction is
executed immediately after taking the sample from the reservoir.

FeedPressure_PI

Instruction nameFeedPressure_PI GroupSystem:Settings:SpecialsMethod/
Manual: Recirc

Parameter 1 nameP

parameter 2 nameI

Position name (default underlined)0.05
(0.00 - 10 000.00)

 150.00 sec (0.00 - 10 000.00
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Instruction Help

These parameters are used to tune the feedback control when FeedPressure-
control is active.

DeltaP_PI

Instruction nameDeltaP_PI GroupSystem:Settings:SpecialsMe-
thod/Manual: Recirc

Parameter 1 nameP

Parameter 2 nameI

Position name (default underlined)0.05
(0.00 - 10 000.00)

 150.00 sec (0.00 - 10 000.00

Instruction Help

These parameters are used to tune the feedback control during DeltaP. For more
information, see Chapter 13 Feedback tuning and PID parameters, on page 257.

EmptyResFeed_PI

Instruction nameEmptyResFeed_PI GroupSystem:Settings:SpecialsMe-
thod/Manual: Recirc

Parameter 1 nameP

Parameter 2 nameI

Position name (default underlined)0.05
(0.00 - 10 000.00)

 150.00 sec (0.00 - 10 000.00

Instruction Help

These parameters are used to tune the feedback control during EmptyReservoir.
For more information, see Chapter 13 Feedback tuning and PID parameters, on
page 257.

RetentateHoldupVol

Instruction nameRetentateHoldup-
Vol

GroupSystem:Settings:SpecialsMe-
thod/Manual: Recirc
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Parameter nameVolume Position name (default under-
lined)18.20 mL (0.00 - 100.00)

Instruction Help

See Section A Membrane and cartridge selection, on page 333 for more informa-
tion.
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14.3 Permeate instructions

TMP_Control

Instruction
nameTMP_Control

FormulaTMP = ((Pf +
Pr/2)-Pp)

GroupMethod/Manual
→Permeate

Parameter 1 nameFlow-
Rate

ModeControl Mode
PID

Note:

No overshooting (max
10% of setpoint)

Position name (default
underlined)0.00 bar
(0.00 - 5.20)

Instruction Help:Adjusts the Retentate_Control_Valve and the Permeate
Pump to maintain a TMP setpoint. Prior to activation of TMP control, make sure
that DeltaP is stable. Resets, Flux_Control and Permeate_Unrestricted_Flow.

Flux_Control

Instruction
nameFlux_Control

FormulaFlux =
(Qp[l/h])/(A[m2])

GroupMethod/Manual
→Permeate

Parameter 1 nameFlux

 

 

Parameter 2 nameTMPli-
mit

ModeControl Mode
PID

Note:

Pp ≤ Pr

Position name (default
underlined)0.0 LMH (0.0 -
4800.0)

 

 

Off (0.01 - 5.20 bar)

Instruction Help:

Starts the flow on the Permeate Pump as a flux rate. If the permeate pressure is <
0.2 bar, the Retentate Control Valve will lift the permeate pressure to the offset
value.

When the TMPlimit is activated, the system will pause the run if the setpoint is
reached.

Resets TMP_Control and Permeate_Unrestricted_Flow. The Retentate Con-
trol Valve will lift the permeate pressure to 95% of the offset value before the flux
rate is ramped up in a 30 second interval.
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Permeate_Valve_Blocks

Instruction namePermeate_Valve_Block GroupMethod/Manual →Permeate

Parameter 1 nameMacro Position name (default under-
lined)Closed, P-VB-Recycle, P-VB-
Out1, P-VB-Out2, P-VB-Out3

Instruction Help

Selects the position for the Permeate_Valve_Block to P-VB-Recycle, P-VB-
Out1, P-VB-Out2, or P-VB-Out3.

No valve block action allowed when P-VB-recycle is used and a permeate control
mode is active. A warning will be raised.

During Constant_Retentate_Volume, the P-VB-recycle position is not allowed.
A warning will be raised.

It is possible to change the Permeate_Valve_Block position between P-VB-
Out1, PVB-Out2, and P-VB-Out3 when the permeate flow is greater than 0.
When opening a new valve outlet, the old outlet will remain open for approxi-
mately one second before closing.

Permeate_Valve_Block will remain in position at Pause and the flow on the Per-
meate Pump goes down to 0 mL/min.

Warning Help text 1

Instruction ignored. No valve block action allowed when P-VB-recycle is used and
permeate control mode is active.

Warning help text 2

Instruction ignored. P-VB-recycle is not allowed during Constant_reten-
tate_volume.

Permeate_Unrestricted_Flow

Instruction namePer-
meate_Unrestric-
ted_Flow

FormulaPp GroupMethod/Manual
→Permeate

Parameter 1 namePres-
sure

ModeControl Mode
PID

Note:

Pp ≤ Pr

Position name (default un-
derlined)Disabled, Ena-
bled
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Instruction Help text:

Starts the flow on the Permeate Pump at the offset permeate pressure. If Pr > Pp,
the Pr value is used as the offset Pp. The Retentate Control Valve lifts Pr to the
offset Pp if Pr < offset. Resets TMP_Control and Flux_Control.

Normal_Flow_Filtration
NFF_ConstantFlow

Instruction
nameNFF_ConstantFlow

FormulaQf GroupMethod/Manual
→Permeate

Parameter 1 nameFlow ModeControl Mode
Direct

Position name (default
underlined)Off 0.0
mL/min (0.0 - 600.0)

Instruction Help text:Starts the Feed Pump at the constant feed flow setpoint
and the Permeate Pump at 20% of the constant feed flow setpoint. The Reten-
tate Pressure Control Valve is closed to close the retentate loop. The Permeate
Pressure Control Valve is opened completely.

Instruction ignored if the feed flow > 0 mL/min

NFF_ConstantPressure

Instruction nameNFF_Con-
stantPressure

FormulaPf GroupMethod/Manual
→Permeate

Parameter 1 namePres-
sure

ModeControl Mode
PID

Position name (default
underlined)Off 0.0 bar
(0.00 - 5.20)

Instruction Help text:Starts the flow on the Feed Pump to run at the chosen con-
stant pressure setpoint and starts the Permeate Pump at the offset permeate
pressure. If Pr > Pp, the Pr value is used as the offset. The Retentate Control
Valve lifts the Pr to the offset if Pr < offset. Resets TMP_Control and Flux_Con-
trol.

PressureOffset

Instruction namePressureOffset GroupSystem →Settings →Specials
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Parameter namePressure Set point (default underlined)0.2 bar (0.2 -
1.0 bar)

Instruction Help text:Sets the permeate offset pressure used by system during
TMP_Control, Flux_Control and Permeate_Unrestricted_Flow.

Evaluation Instructions
Start_Eval_Window

Instruction nameStart_Eval_Window GroupMethod/Manual →Permeate

Parameter nameMode Position name (default underlined)0
= Any vs. any, 1 = Capacity, 2 = DFTi-
meOpt

Instruction Help text:Starts collection of chosen sets of data for the Filtration
Analysis tool in Evaluation. Several sets of data Windows can be defined during
a run. For more information, see Chapter 12 Evaluating ÄKTAcrossflow results us-
ing Filtration Analysis, on page 227.

Stop_Eval_Window

Instruction nameStop_Eval_Window GroupMethod/Manual →Permeate

Parameter nameMode Position name (default underlined)0
= Any vs. any, 1 = Capacity, 2 = DFTi-
meOpt

Instruction Help text:Stops collection of chosen sets of data for the Filtration
Analysis tool in Evaluation. Several sets of data Windows can be defined during
a run. For more information, see Chapter 12 Evaluating ÄKTAcrossflow results us-
ing Filtration Analysis, on page 227.

Set_Eval_Mark

Instruction nameSet_Eval_Mark GroupMethod/Manual →Permeate

Parameter nameMode Position name (default underlined)0 =
ProcessOptimization, 1 = ExtData_vs_Ca-
pacity, 2 = NormalisedWaterFlux
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Instruction Help text:Sets a mark for data collection for the Filtration Analysis
tool in Evaluation. Several Mark instructions can be defined during a run.

Set_PermVol_Totalizer

Instruction nameSet_PermVol_Total-
izer

GroupMethod/Manual →Permeate

Parameter nameVolume Set point (default underlined)0.00 mL
(0.00 - 5 000.00)

Instruction Help text:Sets a desired volume for the permeate volume totalizer.
The totalizer value is calculated based on the action of the Permeate Pump. The
totalizer volume increases with permeate flow.

%Flux_Drop_Calculation

Instruction name%Flux_Drop_Calcula-
tion

GroupMethod/Manual →Permeate

Parameter nameMode Position name (default under-
lined)Off, On

Instruction Help text:Upon activation, this instruction latches onto the current
permeate flux rate and sets it as the reference value. The instruction calculates
the % drop of the current flux value based on the reference value. A increase in
flux values does not register and the %Flux_Drop_Calculation value will remain
at 0.

Total_Membrane_Surface_Area

Instruction nameTotal_Mem-
brane_Surface_Area

GroupMethod/Manual →Permeate Sys-
tem →Settings →Specials

Parameter nameArea Position name (default underlined)50 cm2 (1
- 1 200 cm2)

Instruction Help text:Used in the calculation of the permeate flux value with the
equation: Flux=(Qp[l/h])/(A[m]).
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Lumen_Diameter

Instruction nameLumen_Diame-
ter

GroupMethod/Manual →Permeate Sys-
tem →Settings →Specials

Parameter nameDiameter Set point (default underlined)1.00 mm (0.1
- 10.0)

Instruction Help text:Together with Total_Number_Of_Fibers, the Shear rate
can be calculated with the formula Shear = (4 × Qf) / (number of fibers × π × (fiber-
radius)3)

Total_Number_of_Fibers

Instruction nameTotal_Num-
ber_of_Fibers

GroupMethod/Manual →Permeate Sys-
tem →Settings →Specials

Parameter nameQuantity Position name (default underlined)1 (1 - 1
000)

Instruction Help text:Together with the Lumen_Diameter, the Shear rate can be
calculated with the formula Shear = (4 × Qf) / (number of fibers × π × (fiberra-
dius)3)

PPCV_Setp

Instruction namePPCV_Setp GroupSystem →Settings →Specials

Parameter namePressure Set point (default underlined)700 (0 -
999)

Instruction Help text:Sets the offset on the Permeate Control Valve used by
system during TMP_Control, Flux_Control and Permeate_Unrestricted_Flow .

TMP_PI_RetentateControlValve

Instruction nameTMP_PI_Retentate-
ControlValve

Group

Method/Manual →Permeate Sys-
tem →Settings →Specials
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Parameter 1 nameP

Parameter 2 nameI

Parameter 3 nameD

Setpoint name (default under-
lined)0.10 (0.00 - 10 000.00)

 

20.00 sec (0.00 - 10 000.00)

 

1.00 sec (0.00 - 10 000.00)

Instruction Help text:These parameters are used to tune the feedback control
when TMP_Control is active. For details, see Chapter 13 Feedback tuning and PID
parameters, on page 257 .

Flux_PI_RetentateControlValve

Instruction nameFlux_PI_Retentate-
ControlValve

GroupMethod/Manual →Permeate
System →Settings →Specials

Parameter 1 nameP

Parameter 2 nameI

Setpoint name (default under-
lined)0.10 (0.00 - 10 000.00)

 

20.00 sec (0.00 - 10 000.00)

Instruction Help text:These parameters are used to tune the feedback control
when Flux_Control is active. For details, see Chapter 13 Feedback tuning and PID
parameters, on page 257.

PUF_PI_RetentateControlValve

Instruction namePUF_PI_Retentate-
ControlValve

GroupMethod/Manual →Permeate
System →Settings →Specials

Parameter 1 nameP

Parameter 2 nameI

Setpoint name (default under-
lined)0.10 (0.00 - 10 000.00)

 

20.00 sec (0.00 - 10 000.00)

Instruction Help text:These parameters are used to tune the feedback control
when Permeate_Unrestricted_Flow is active. For details, see Chapter 13 Feed-
back tuning and PID parameters, on page 257.
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PUF_PI_PermeatePump

Instruction namePUF_PI_Permeate-
Pump

GroupMethod/Manual →Permeate
System →Settings →Specials

Parameter 1 nameP

Parameter 2 nameI

Setpoint name (default under-
lined)0.001 (0.00 - 10 000.00)

 

200.00 sec (0.00 - 10 000.00)

Instruction Help text:These parameters are used to tune the feedback control
when Permeate_Unrestricted_Flow is active. For details, see Chapter 13 Feed-
back tuning and PID parameters, on page 257.

pNFF_PI

Instruction namepNFF_PI GroupMethod/Manual →Permeate Sys-
tem →Settings →Specials

Parameter 1 nameP

Parameter 2 nameI

Setpoint name (default underlined)0.050
(0.000 - 10 000.000)

 

150.00 sec (0.000 - 10 000.000)

Instruction Help text:These parameters are used to tune the feedback control
when Normal_Flow_Filtration is active. For details, see Chapter 13 Feedback
tuning and PID parameters, on page 257.

Fractionation

Instruction nameFractionation GroupMethod/Manual →Permeate

Parameter nameFracSize Setpoint name (default underlined)0.0
mL (0.0 - 50.0)

Instruction Help text:Starts fraction collection if the fraction size specified by the
FracSize parameter is > 0 mL. The tube change is delayed by the delay volume
specified in System →Settings →Specials →FracParameters. The fractionation
is stopped with the instruction FractionationStop.

FeedTube
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Instruction nameFeedTube GroupMethod/Manual →Permeate

Instruction Help text:During fractionation, the FeedTube instruction moves the
tube rack forward one tube after the delay volume specified in System →Settings
→Specials →FracParameters →DelayVol has been collected and a fraction mark
is given. When Fractionation is not used, FeedTube moves the rack instantly and
no fraction mark is given.

FractionationStop

Instruction nameFractionationStop GroupMethod/Manual →Permeate

Instruction Help text:Stops the fraction collection after the delay volume speci-
fied in System →Settings →Specials →FracParameters →DelayVol has been
collected.

ResetFracNumber

Instruction nameResetFracNumber GroupMethod/Manual →Permeate

Warning Help: ResetFracNumber is not allowed during fractionation. Instruc-
tion ignored.
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14.4 Transfer instructions

Transfer Flow

Instruction nameTransfer Flow GroupMethod/Manual →Transfer

Parameter nameFlowRate Position name (default underlined)0.0
mL (0.0 - 200.0)

Instruction Help text:Starts the flow on the Transfer pump at the set flow rate.

Constant_Retentate_Volume

Instruction nameCon-
stant_Retentate_Vol-
ume

Formula:

Qt = Qp

GroupMethod/Manual
→Transfer

Parameter nameMode Mode:

Control Mode

Position name (default un-
derlined)CRV_Off, CRV_On

CRV_On = liquid level in the reservoir is kept constant at the level detected when
the instruction is activated by adjusting the transfer flow to compensate for de-
tected changes in the reservoir level. CRV_Off = immediate inactivation of the in-
struction. If the retentate valve is open when executing Constant_Reten-
tate_Volume, a warning will be raised and the instruction will be ignored. If P-VB-
recycle is open when executing Constant_Retentate_Volume CRV_On, a warn-
ing will be raised and the instruction ignored

Warning Help text 1

Constant_Retentate_Volume is not allowed with Retentate_Valve_Block
open. Instruction ignored.

Warning Help text 2

Constant_Retentate_Volume is not allowed with P-VB-recycle position open.
Instruction ignored.

Transfer_Valve_Blocks

Instruction nameTrans-
fer_Valve_Blocks

GroupMethod/Manual →Transfer
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Parameter nameMacro Position name (default under-
lined)Closed, T-VB-In1, T-VB-In2, T-VB-
In3, T-VB-In4, T-VB-In5, T-VB-In6, T-VB-
In7, T-VB-In8

Instruction Help text:Selects the position for the Transfer_Valve_Blocks, T-VB-
In1, T-VB- In2, T-VB- In3, T-VB- In4, T-VB- In5, T-VB- In6, T-VB- In7, T-VB- In8

The inlet valves will not be set to their default position (Closed) at End until the
flow on the pump has gone down to 0 mL/min.

Transfer_Purge_Valve

Instruction nameTrans-
fer_Purge_Valve

GroupMethod/Manual →Transfer

Parameter name Instruction Position name (default underlined)
To_Reservoir, Waste

Instruction Help text:

Selects transfer flow direction to Reservoir or Waste. The Waste position is use-
ful when cleaning the transfer inlets .

Set_TrfVol_Totalizer

Instruction nameSet_TrfVol_Totaliz-
er

GroupMethod/Manual →Transfer

Parameter nameVolume Position name (default under-
lined)0.00 mL (0.00 - 5 000.00)

Instruction Help text:Sets a desired volume for the transfer volume totalizer. The
totalizer value is calculated based on the action of the Transfer Pump. The total-
izer volume increases with transfer flow.

DF_Exchange_Factor

Instruction nameDF_Exchange_Fac-
tor

GroupMethod/Manual →Transfer
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Parameter nameMode Position name (default underlined)Off,
On

Instruction Help text:The DiaFiltration Exchange Factor calculates the rela-
tionship between the total buffer volume introduced into the reservoir during a
diafiltration step and the retentate volume when the diafiltration was started.

MethodBase

Instruction nameMethodBase GroupMethod →Transfer

Parameter nameBase Position name (default underlined)Per-
meatePump, FeedPump, Transfer-
Pump

Instruction Help:Sets the base for method volume calculation to the chosen
pump.

ConstRVol_P

Instruction nameConstRVol_P GroupMethod/Manual →Transfer
System →Settings →Specials

Parameter nameP Position name (default under-
lined)50.000 mbar, (0.000 - 10
000.000)

Instruction Help:The P parameter affects the response of the CRV algorithm. A
higher value causes faster transfer flow increase to compensate for a decreasing
reservoir level, and vice versa. The P parameter also affects how quickly the start
level is restored after the CRV instruction is turned off. Note: A higher P parameter
value amplifies the noise in the level sensor signal, which may cause instability.
For details, see Chapter 13 Feedback tuning and PID parameters, on page 257.
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14.5 Alarms, Warnings, and Monitors

AutozeroUV

Instruction nameAutoZeroUV GroupMethod/Manual
→Alarms&Monitors

Instruction Help:Sets the relative AU to zero.

AveragingTime

Instruction nameAveragingTimeUV GroupSystem:Settings:MonitorsMe-
thod/Manual:Alarms&Monitors

Parameter nameAvTimeUV Position name (default under-
lined)0.02, 0.04, 0.08, 0.16, 0.32, 0.64,
1.30, 2.60, 5.10, 10

Instruction Help:Filters the noise in the UV signal. Averaging time is the time in-
terval used for calculating the moving average of the absorbance signal. A long
averaging time will smooth out noise efficiently, but will also distort the peaks.

Pressure_Filter_Factor

Instruction namePressure_Filter_Fac-
tor

GroupSystem:Settings:MonitorsMe-
thod/Manual:Alarms&Monitors

Parameter nameAvTimeUV Position name (default underlined)30
(NoFilter, 2–100)

Instruction Help:When active all pressure signals are filtered to avoid overshoot-
ing and hysteresis during pressure regulating operations, i.e., all control modes.

Alarm_UV

Instruction nameAlarm_UV GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

14 Strategy instructions
14.5 Alarms, Warnings, and Monitors

292  ÄKTAcrossflow User manual 29360935 AA



Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)6000.000
mAU (-6000.000–6000.000)

Setpoint (default under-
lined)-6000.000 mAU (-6000.000–
6000.000)

Instruction Help:Sets the alarm limits for the UV signal.

Alarm_pH

Instruction nameAlarm_pH GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)14.00 pH
(0.00–14.00)

Setpoint (default underlined)0.00 pH
(0.00–14.00)

Instruction Help:Sets the alarm limits for the pH signal.

Alarm_Cond

Instruction nameAlarm_Cond GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)999.99
mS/cm (0.00–1000.00)

Setpoint (default underlined)0.00
mS/cm (0.00–1000.00)

Instruction Help:Sets the alarm limits for the conductivity signal.
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Alarm_FeedPress

Instruction nameAlarm_FeedPress GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)5.20 bar
(0.00–5.20)

Setpoint (default underlined)0.00 bar
(0.00–5.20)

Instruction Help:Sets the alarm limits for pressure from the feed pump. When
reached, the system is set to Pause

Alarm Help: HighAlarm: The feed pressure has exceeded the HighAlarm limit
LowAlarm: The feed pressure has fallen below the LowAlarm limit.Pressure lim-
its are set by AlarmFeed_Press.

Alarm_TrfPress

Instruction nameAlarm_TrfPress GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)5.20 bar
(0.00–5.20)

Setpoint (default underlined)0.00 bar
(0.00–5.20)

Instruction Help:Sets the alarm limits for pressure from the transfer pump.
When reached, the system is set to Pause.

Alarm Help: HighAlarm: The transfer pressure has fallen below the HighAlarm
limit. LowAlarm: The transfer pressure has fallen below the LowAlarm limit
Pressure limits are set by AlarmFeed_Press.Press Acknowledge on the error
message window, then press Continue.
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Alarm_DeltaP

Instruction nameAlarm_DeltaP GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)5.20 bar
(0.00–5.20)

Setpoint (default underlined)0.00 bar
(0.00–5.20)

Instruction Help:Sets the alarm limits for the DeltaP (Pf-Pr). When reached, the
system is set to Pause.

Alarm Help: HighAlarm cause: the DeltaP has exceeded the HighAlarm lim-
it.LowAlarm cause: the DeltaP has fallen below the LowAlarm limit.Pressure
limits are set by Alarm_DeltaP .

Alarm_TMP

Instruction nameAlarm_TMP GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)5.20 bar
(0.00-5.20)

Setpoint (default underlined)0.00 bar
(0.00-5.20)

Instruction Help:Sets the alarm limits for transmembrane pressure (TMP).
When reached the system is set to Pause.

Alarm Help text: HighAlarm cause: The TMP has exceeded the HighAlarm lim-
itLowAlarm cause: The TMP has fallen below the LowAlarm limitPressure limits
are set by Alarm_TMP .
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Alarm_Flux

Instruction nameAlarm_Flux GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)120 000.0
LMH (0.0-120 000.0)

Setpoint (default underlined)0.0 LMH
(0.0-120 000.0)

Instruction Help:Sets the alarm limits for the permeate flux rate. When reached
the system is set to Pause.

Alarm Help text: HighAlarm cause: The permeate flux rate has exceeded the
HighAlarm limitLowAlarm cause: The permeate flux rate has fallen below the
LowAlarm limitPressure limits are set by Alarm_Flux .

Alarm_pNFF

Instruction nameAlarm_pNFF GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)5.20 bar
(0.00-5.20)

Setpoint (default underlined)0.00 bar
(0.00-5.20)

Instruction Help:Sets the alarm limits for pNFF (feed pressure - permeate pres-
sure). When reached the system is set to Pause.

Alarm Help: HighAlarm cause: The pNFF has exceeded the HighAlarm lim-
itLowAlarm cause: The pNFF has fallen below the LowAlarm limitPressure limits
are set by Alarm_pNFF .
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Alarm_Shear

Instruction nameAlarm_Shear GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode

Parameter 2 nameHigh Alarm

Parameter 3 nameLow Alarm

Position name (default underlined)Dis-
abled, Enabled

Setpoint (default underlined)20 000 s-1

(0-20 000)

Setpoint (default underlined)0 s-1

(0-20 000)

Instruction Help:Sets the alarm limits for shear rate. When reached the system is
set to Pause.

Alarm Help: HighAlarm cause: The shear rate has exceeded the HighAlarm lim-
itLowAlarm cause: The shear rate has fallen below the LowAlarm limitPressure
limits are set by Alarm_pNFF .

Alarm_Valves

Instruction nameAlarm_Valves GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter nameT_VB1

T_VB2

R_VB

P_VB

Position name (default underlined)Dis-
abled, Enabled

Disabled, Enabled

Disabled, Enabled

Disabled, Enabled

Instruction Help text:Enables/disables the transfer, retentate, and permeate
valve alarms..

Alarm Help:If a valve is not responding, an alarm is raised and the system is set to
Pause.

Wait at least 5 seconds, then press the Continue button. If the alarm persists, try
to restart the system. If the alarm still persists, check if the valve is damaged. If the
valve is damaged, contact your GE service representative.
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Alarm_FlowPath

Instruction nameAlarm_FlowPath GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode Position name (default underlined)En-
abled, Disabled

Instruction Help:Enables/Disables the transfer and permeate flow path alarms.
The Alarm_FlowPath checks for closed flow paths (all transfer inlets closed, all
permeate outlets closed) when transfer or permeate flow is > 0. An alarm will be
raised and the system is set to Pause.

Alarm 1 Help: TrfFlow > 0 and inlets are closed

Alarm 2 Help: PermFlow > 0 and outlets are closed

Alarm_Airsensor

Instruction nameAlarm_Airsensor GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameMode Position name (default underlined)Dis-
abled, Enabled

Instruction Help:Sets the alarm for air sensor. An alarm will set the system to
Pause if air is detected in air sensor flow cell.

WatchPar_UV

Instruction nameWatchPar_UV GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 mAU
(0.00-6000.00)

  0.00 mAU (0.00-6000.00)
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Instruction Help:Watch on UV signal. The DeltaPeak setting affects only the
Less than or valley and Peak max conditions when using the Watch instruction
(see the UNICORN User Manual for more information). As a general guideline, set
the value to 2-3 times the noise level and 5-10% of the smallest expected peak
height. Delta_Base setting affects only the Stable signal condition. For this con-
dition to be activated, the signal may not vary by more than the Delta_Base value
up or down over the time interval specified in the Stable signal condition in the
Watch instruction.

WatchPar_Cond

Instruction nameWatchPar_Cond GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00
mS/cm (0.00-999.90)

  0.00 mS/cm (0.00-999.90)

Instruction Help:Watch on conductivity signal. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_FeedPress

Instruction nameWatchPar_Feed-
Press

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)
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Instruction Help:Watch on at pressure reported at the filter feed port. The Del-
ta_Peak setting affects only the Less than or valley and Peak max conditions
when using the Watch instruction (see the UNICORN User Manual for more infor-
mation). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_RetenPress

Instruction nameWatchPar_Reten-
Press

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)

Instruction Help text:Watch on the pressure reported at the filter feed port. The
Delta_Peak setting affects only theLess than or valley and Peak max conditions
when using the Watch instruction (see the UNICORN User Manual for more infor-
mation). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_PermPress

Instruction nameWatchPar_Perm-
Press

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)
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Instruction Help:Watch on the pressure reported at the filter permeate port. The
Delta_Peak setting affects only the Less than or valley and Peak max condi-
tions when using the Watch instruction (see the UNICORN User Manual for more
information). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_FeedFlow

Instruction nameWatchPar_Feed-
Flow

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0
mL/min (0.0-600.0)

  0.0 mL/min (0.0-600.0)

Instruction Help:Watch on the feed flow rate. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_RetFlow

Instruction nameWatchPar_RetFlow GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDeltaPeak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0
mL/min (0.0-600.0)

  0.0 mL/min(0.0-600.0)
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Instruction Help:Watch on the retentate flow rate. The Delta_Peak setting af-
fects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.

WatchPar_PermFlow

Instruction nameWatchPar_Perm-
Flow

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0
mL/min (0.0-200.0)

  0.0 mL/min (0.0-200.0)

Instruction Help:Watch on the permeate flow rate. The Delta_Peak setting af-
fects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.

WatchPar_TrfFlow

Instruction nameWatchPar_TrfFlow GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0
mL/min (0.0-200.0)

  0.0 mL/min (0.0-200.0)
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Instruction Help:Watch on the transfer flow rate. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_RetVol

Instruction nameWatchPar_RetVol GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00
mL/min (0.00-80 000.00)

  0.00 mL/min (0.00-80 000.00)

Instruction Help:Watch on the total retentate volume. The Delta_Peak setting
affects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.

WatchPar_ResVol

Instruction nameWatchPar_ResVol GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 mL
(0.00-80 000.00)

  0.00 mL (0.00-80 000.00)
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Instruction Help:Watch on the reservoir volume. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_PermVol

Instruction nameWatchPar_PermVol GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 mL
(0.00-80 000.00)

  0.00 mL (0.00-80 000.00)

Instruction Help:Watch on permeate volume. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_TransVol

Instruction nameWatchPar_TransVol GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 mL
(0.00-80 000.00)

  0.00 mL (0.00-80 000.00)
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Instruction Help:Watch on the transfer volume. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_DeltaP

Instruction nameWatchPar_DeltaP GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)

Instruction Help:Watch on the feed DeltaP value. The Delta_Peak setting affects
only the Less than or valley and Peak max conditions when using the Watch in-
struction (see the UNICORN User Manual for more information). As a general
guideline, set the value to 2-3 times the noise level and 5-10% of the smallest ex-
pected peak height. Delta_Base setting affects only the Stable signal condition.
For this condition to be activated, the signal may not vary by more than the Del-
ta_Base value up or down over the time interval specified in the Stable signal
condition in the Watch instruction.

WatchPar_TMP

Instruction nameWatchPar_TMP GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)
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Instruction Help:Watch on the transmembrane pressure. The Delta_Peak set-
ting affects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.

WatchPar_Flux

Instruction nameWatchPar_Flux GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0 LMH
(0.0-12 000.0)

  0.0 LMH (0.0-12 000.0)

Instruction Help:Watch on the permeate flux rate reported by the permeate
pump. The Delta_Peak setting affects only the Less than or valley and Peak
max conditions when using the Watch instruction (see the UNICORN User Man-
ual for more information). As a general guideline, set the value to 2-3 times the
noise level and 5-10% of the smallest expected peak height. Delta_Base setting
affects only the Stable signal condition. For this condition to be activated, the
signal may not vary by more than the Delta_Base value up or down over the time
interval specified in the Stable signal condition in the Watch instruction.

WatchPar_Shear

Instruction nameWatchPar_Shear GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0 s-1

(0-20 000)

  0 s-1 (0-20 000)
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Instruction Help:Watch on the shear rate reported by the feed pump. The Del-
ta_Peak setting affects only the Less than or valley and Peak max conditions
when using the Watch instruction (see the UNICORN User Manual for more infor-
mation). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_pNFF

Instruction nameWatchPar_pNFF GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00 bar
(0.00-5.20)

  0.00 bar (0.00-5.20)

Instruction Help:Watch on the pNFF (feed pressure - permeate pressure). The
Delta_Peak setting affects only the Less than or valley and Peak max condi-
tions when using the Watch instruction (see the UNICORN User Manual for more
information). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_%_Flux_Drop

Instruction nameWatchPar_
%_Flux_Drop

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.0%
(0.0-100.0)

  0.0% (0.0-100.0)
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Instruction Help:Watch on the % flux drop reported by the permeate pump. The
Delta_Peak setting affects only the Less than or valley and Peak max condi-
tions when using the Watch instruction (see the UNICORN User Manual for more
information). As a general guideline, set the value to 2-3 times the noise level and
5-10% of the smallest expected peak height. Delta_Base setting affects only the
Stable signal condition. For this condition to be activated, the signal may not vary
by more than the Delta_Base value up or down over the time interval specified in
the Stable signal condition in the Watch instruction.

WatchPar_ConFactor

Instruction nameWatchPar_ConFac-
tor

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00
(0.00-50.00)

  0.00 (0.00-50.00)

Instruction Help text:Watch on concentration factor. The Delta_Peak setting
affects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.

WatchPar_DF_X_Fact

Instruction nameWatch-
Par_DF_X_Fact

GroupSystem:Settings:Alarms
Method/Manual:Alarms&Monitors

Parameter 1 nameDelta_Peak

Parameter 2 nameDelta_Base

Setpoint (default underlined)0.00
(0.00-50.00)

  0.00 (0.00-50.00)
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Instruction Help:Watch on the diafiltration factor. The Delta_Peak setting af-
fects only the Less than or valley and Peak max conditions when using the
Watch instruction (see the UNICORN User Manual for more information). As a
general guideline, set the value to 2-3 times the noise level and 5-10% of the
smallest expected peak height. Delta_Base setting affects only the Stable signal
condition. For this condition to be activated, the signal may not vary by more than
the Delta_Base value up or down over the time interval specified in the Stable
signal condition in the Watch instruction.
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14.6 Fraction collector instructions

FracParameters

Instruction nameFracParameters GroupSystem →Settings →Specials

Parameter 1 nameDelayVol

Parameter 2 nameTubeChange

Setpoint (default underlined)0.000 mL
(0.000-10.000)

 Tube, DropSync, WasteBetweenTubes

Instruction Help:Parameter settings for the fraction collector. The delay volume
is defined as the volume from the UV cell to the end of the tubing for the fraction
collector. Collection of the flow during tube change can be handled in different
ways. Tube: no synchronisation of collection. DropSync: tube change synchron-
ised to drop release (this should only be used at flow rates generating drops).
WasteBetweenTubes: the flow will be diverted to waste when moving between
tubes.

FracNumberingMode

Instruction nameFracNumbering-
Mode

GroupSystem →Settings →Specials

Parameter nameMode Setpoint (default underlined)Reset,
Continue

Instruction Help:Determines whether fraction number is reset at the end of a
method or not. Reset sets Tube No to 1 after method end. Continue continues
numbering from the last tube in the previous method.
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14.7 Monitor UPC-980

UV Monitor
UVLampOff

Instruction nameUVLampOff GroupMethod/Manual
→Alarms&Monitors

Instruction Help:Sets the UV lamp permanently to OFF. To restart UV lamp, the
system and computer must be re-booted.

pH
pHTempComp

Instruction namepHTempComp GroupSystem →Settings →Monitors

Parameter namepHTempComp Position name (default under-
lined)OFF, ON

Instruction Help:Sets the temperature compensation ON or OFF. For more ac-
curate measurements during temperature changes, the pH measurement can be
temperature compensated. When using pHTempComp it is important that the
temperature of the pH electrode is the same as that of the conductivity flow cell
since that is where the temperature is measured.

Cond
CondTempComp

Instruction nameCondTempComp GroupSystem →Settings →Monitors

Parameter nameCompFactor Position name (default under-
lined)2.0% (0.0-9.9)
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Instruction Help:Relates conductivity to temperature. The compensation con-
sists of a compensation factor, together with a reference temperature (CondRef-
Temp). All conductivity values will automatically be converted to the set refer-
ence temperature. The factor is expressed in percentage increase of conductivity
per °C increase in temperature. If the CompFactor is unknown, a general approxi-
mate value of 2% can be set for many common salt buffers. 0% = off.

CondRefComp

Instruction nameConRefTemp GroupSystem →Settings →Monitors

Parameter nameRefTemp Position name (default under-
lined)25.0°C (0.0-99.9)

Instruction Help:Sets the reference temperature to which the measured con-
ductivity values will be converted. CondRefTemp is active when a factor of Con-
dTempComp is selected.
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14.8 Watch instructions
It is possible to set Watch and Watch_Off instructions on the following signals:UV,
pH, Cond, Feed_Press, RetenPress, PermPress, FeedFlow, RetFlow, PermFlow,
TrfFlow, RetVol, PermVol, TransVol, DeltaP, TMP, Flux, Shear, pNFF, ConcFac-
tor, DF_X_Fact, FluxDrop, Airsensor, ZeroLevel, AuxIn1, AuxIn2, AuxIn3, and
AuxIn4.

It is possible to set a Hold_Until instruction on the following signals:UV, pH, Cond,
Feed_Press, RetenPress, PermPress, FeedFlow, RetFlow, PermFlow, TrfFlow,
RetVol, PermVol, TransVol, DeltaP, TMP, Flux, Shear, pNFF, ConcFactor,
DF_X_Fact, FluxDrop, Airsensor, ZeroLevel, AuxIn1, AuxIn2, AuxIn3, and AuxIn4.
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14.9 Calibration

ZeroLS

MonitorZeroLS FunctionZero calibration of level sen-
sor

Text 1Sets the level sensor reading to zero. See Help

UPC
pH

MonitorpH FunctionCalibration of the pH electrode

Text 1Calibrate pH electrode for buffer 1. See Help. Calibrate pH electrode for buf-
fer 2. See Help.

Parameter 1 nameReference value 1

Parameter 2 nameReference value 2

Input (default underlined)0.0000 pH
(0-14)

Input (default underlined)0.0000 pH
(0-14)

ResultCalibrated electrode slope

ResultAsymmetry potential at pH 7

Value 10.0%

Value 20.0 mV

Instruction Help

The pH Monitor is calibrated using standard buffer solutions in a two point cali-
bration. The difference between the buffers should be at least 1 pH unit. A new
electrode typically has a slope of 95-102% and an asymmetry potential within ±
30mV. As a rule, when an electrode has an asymmetry potential outside of ±
60mV and a slope lower than 80%, and no improvements can be achieved by
cleaning, it should be replaced.

Cond_Calib

MonitorCond_Calib FunctionCalibration of the conductivi-
ty cell constant

Text 1Determination of cell constant for Cond cell. See Help.
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Parameter nameReference value 1 Input (default underlined)1.0000
mS/cm (1-999.9)

ResultCalibrated electrode slope Value1/cm

Instruction Help

Calibration of conductivity cell. Normally it is not necessary to adjust the cell con-
stant as the flow cell is pre-calibrated on delivery. Set CondTempComp to 0 in
System →Settings prior calibration. The temperature sensor must be calibrated
before adjusting the cell constant. Fill the flow cell with calibration solution of 1.00
M NaCl. Wait until the temperature is constant in the range 20-30 °C. Enter the
theoretical conductivity value according to graph in the Operating Instructions .

Cond_Cell

MonitorCond_Cell FunctionEnter a new cell constant

Text 1Add cell constant value of a new Cond cell. See Help.

Parameter nameReference value Input (default underlined)40.0 1/cm
(0.1-300)

Instruction Help

When replacing the current cell with a new conductivity cell, enter the new cell
constant (shown on the packaging.) In case the packaging has been discarded,
perform the Cond_Calib.

Cond_Temp

MonitorCond_Temp FunctionTemperature sensor

Text 1Calibrate the temperature sensor in the conductivity flow cell. See Help.

Parameter nameReference value Input (default underlined)0.000°C
(-5-60)
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Instruction Help

Calibration of the temperature sensor in the conductivity flow cell is only neces-
sary if very high accuracy measurements are needed. Place the conductivity flow
cell together with a precision thermometer inside a box or empty beaker to make
sure that they are not exposed to drafts. Leave them for 15 min to let the temper-
ature stabilize. Read the temperature on the thermometer and enter this as the
reference value.

TrfPress

MonitorTrfPress FunctionPressure calibration

Text 1Sets the pressure reading on the transfer pressure sensor to zero. See Help.

Parameter nameReference value Input (default underlined)0.00 bar
(-5.0-60.0)

Instruction Help

Calibrate pressure offset according to step 1:Calibrate pressure offset for Trans-
fer pump. Click the Start Calibration button. For details see ÄKTA Instrument
Handbook
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15 System components

About this chapter
This chapter contains information on the component parts of the ÄKTAcrossflow.

In this chapter

Section See page

15.1 Pump P-982 and P-984 318

15.2 Valves 321

15.3 Reservoirs 326

15.4 pH electrode and cell holder 328

15.5 Monitor UPC-980 and UV cell 329

15.6 Conductivity cell 330

15.7 Sensors 331
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15.1 Pump P-982 and P-984
Pump P-982 and P-984 are high performance laboratory pumps for use in applica-
tions where accurately controlled liquid flow is required. Twin reciprocating pump
heads work in unison to deliver a smooth and pulse-free flow.

P-982 is used as the transfer pump (module A) and as the permeate pump (module
B), P-984 is used as the feed pump (module A and B).

Pump Pressure range Flow rate range

P-982 (two pump heads) 0–52 kPa (5.2 bar, 75.4 psi) 0.1–200 mL/min

P-984 (four pump heads) 0–52 kPa (5.2 bar, 75.4 psi) 1–600 mL/min

Pump heads
The individual pump heads are identical but are actuated in opposite phase to each
other by individual stepper motors controlled by a microprocessor. This gives a con-
tinuous, low pulsation liquid delivery.

Each pump head is equipped with an inlet check valve and an outlet check valve for
the liquid flow. In addition, each pump head has an outlet check valve for the rinsing
system flow.

Inlet

Outlet to
pressure sensor PF

Outlet check
valve

Inlet check
valve

Feed pump P-984

 

Liquid is drawn up into the pump head through a non-return inlet check valve by the
action of the piston being withdrawn from the pump chamber.

On the delivery stroke of the piston, the inlet check valve is sealed by the pressure
developed and liquid is forced out through a similar check valve at the outlet.
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Outlet
check valve

Inlet
check valve

Pump head 
front

O-ring

O-ringGlass 
tube

Liquid 
chamber

Rinse 
chamber

Drainage 
hole

Return
spring

Rinsing system 
check valve

Piston

Leakage between the pump chamber and the drive mechanism is prevented by a pis-
ton. The piston is continuously lubricated by the presence of liquid. To prevent any
deposition of salts from aqueous buffers on the pistons, the low pressure chamber
behind the piston can be flushed continuously with a low flow of 20% ethanol.

The pump head is made of titanium alloy.
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Pump principle
Each piston is driven by a simple robust cam (eccentric). These cams are driven by
stepper motors via timing belts. The motor speed is varied to achieve linear move-
ment and compensation for compressibility. This produces the particular motor
sound. This system guarantees an accurate, low pulsation flow over the entire flow
rate range, independent of the back pressure. When an increase in flow rate is pro-
grammed, the motor speed accelerates gradually, giving a soft start and building up
speed to the flow rate required. When a decrease in flow rate is programmed, the
motor speed slows rapidly to the lower flow rate.

User
Interface

Slave
CPU

Inlet

Pump A Pump B
Outlet Inlet

Pressure
Transducer

Main
CPU

Stepper
Motor

Timing Belt

Eccentric

Piston

Pump Head

Slave
CPU
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15.2 Valves

Membrane valves
Each valve block comprises three or four stepper-motor actuated membrane valves
with open/close functionality. The valves are located in valve blocks to minimize
holdup volumes and dead volumes.

A valve block consists of a connection block containing the ports and the mem-
branes, and a mechanical housing containing the stepper motors, cams and actuat-
ing pistons. The membranes are made of EPDM.

The valve blocks have different numbers of inlet and outlet ports depending on their
position in the flow path.

• Inlet valves T-VB-In: 1–4

• Inlet valves T-VB-In: 5–8

• Outlet valves P-VB-Out: recycle, 1, 2, 3 (pressure relief valve)

One of the outlet valves, P-VB-Out 3, is used as pressure relief valve with the opening
pressure 7 bar (102 psi).

Rocker valve
The valve block comprises three stepper motor actuated diaphragm open/close
valves. The diaphragm valve type comprises a membrane coated rocker.

The rocker closes against the flow through the inlet port with the closing force con-
trolled by the stepper motor. This design results in linear control characteristics of
the valve.

The valve block has different numbers of inlet and outlet ports depending on its posi-
tion in the flow path.
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• Outlet valves R-VB-Out: 1 (pressure relief valve), 2, 3.

One of the outlet valves, R-VB-Out 1, is used as pressure relief valve with the opening
pressure 7 bar (102 psi).

Valve block types
There are four different types of membrane valve blocks. The valve blocks have UNF
5/16" female ports. The following illustrations show the flow path in the valve blocks
and where the valves are located. The valves are normally closed, with the exception
of the open recirculation valve in the retentate valve block.

• Transfer valve block 1, T-VB-In 1, 2, 3 and 4

To
transfer pump

From buffer/sample containers and air sensor

21 3 4

To
transfer valve block 2

• Transfer valve block 2, T-VB-In 5, 6, 7 and 8

15 System components
15.2 Valves

322  ÄKTAcrossflow User manual 29360935 AA



To
transfer valve block 1

From buffer/sample containers

78 6 5

Note: In transfer valve block 1 and 2, only one valve can be open at a time.

• Retentate valve block, R-VB-Out 1, 2 and 3

From
pressure 
sensor PR

To valve R-PCV

2 3

From
pressure 
sensor PF

1

To CFF 
cassette/
cartridge

• Permeate valve block, P-VB-Out 1, 2, 3 and recycle

From pH cell

To permeate containers and recycle

1 32Re
cy

cl
e
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2-way transfer purge valve
The 2-way valve is a diaphragm type and comprises a membrane coated rocker. Ac-
tuated by a solenoid, the rocker blocks one of the two outlet ports in a flip-flop man-
ner.

Outlet

Outlet

Inlet

The inlet port is positioned at the side of the valve body, while the outlet ports are
positioned at the top and bottom of the valve body.

The transfer purge valve directs the liquid flow either from transfer line or permeate
recycle towards the reservoir (default) or waste.

Pressure modulating valves R-
PCV and P-PCV

The pressure control valves enable a throttling of the liquid flow in order to raise the
pressure upstream the valve.

Mechanically, these valves are similar to the 2-way valve such that the throttling of
the flow is achieved by the membrane coated rocker. However, compared to the 2-
way switch valve, the pressure control valve has only one inlet and one outlet port.

The rocker closes against the flow through the inlet port with the closing force con-
trolled by the solenoid. This design results in linear control characteristics of the
valve. Furthermore, the pressure upstream of the valve is maintained irrespective of
changes in flow rate.
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Outlet

Inlet

• Retentate control valve (R-PCV)The retentate control valve R-PCV is used to ac-
curately control the retentate pressure over the pressure range 0.1 to 5.2 bar.
Hereby, the transmembrane pressure (TMP) can be adjusted. In addition, the R-
PCV can operate as open/close valve in product recovery and system cleaning
procedures.

• Permeate control valve (P-PCV)The main task of the permeate control valve P-
PCV is to modulate the pressure downstream of the permeate pump in order to
guarantee accuracy in the permeate flow rate.For proper operation of the check
valves, the pressure downstream of the pump must be greater than the pressure
upstream the pump. Therefore, the P-PCV is controlled such that it always main-
tains a higher pressure downstream of the pump.

Flow restrictor in transfer line
A flow restrictor is positioned downstream of the transfer pump for proper operation
of the check valves at the pump heads. The restrictor generates a minimum constant
back pressure of 3 bar.
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15.3 Reservoirs
The reservoir accommodates the liquid/sample to be processed. It provides a gentle,
but efficient mixing of the process liquid with returning retentate and additional liq-
uid added via the transfer line. Permeate may be recycled into the reservoir for ach-
ieving steady-state conditions during process development studies.

The reservoirs are equipped with a float to prevent vortex formation and foaming
such that operation at lowest recirculation volume with high flow rate is facilitated.

There are two sizes of reservoirs:

• 350 mL (375 mL without float)

• 1100 mL (1200 mL without float) (optional)

Each reservoir has connections for the liquid flow positioned at the reservoir bottom
end plate. There is one outlet for delivering liquid to the feed pump via a manifold. The
outlet is placed off-centre at the bottom of the reservoir to prevent vortex formation.
The outlet is connected to a conduit/manifold that distributes the liquid to the four
pump heads of the feed pump. The retentate return is positioned such that liquid is
injected tangentially to the bottom surface.

The lid can be easily opened, for example for manual sampling of the retentate. It also
has a connection for ventilation.

To open the lid:

Step Action

Move the lower part of the jointed hook outwards while pushing slightly
the lid downwards.

Vent

Lid

Hook
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The reservoir is mounted on a reservoir holder which comprises a motor unit for a
magnetic stirrer-bar. The stirrer can be used with both reservoirs to improve mixing
characteristics. Recommended dimensions for the stirrer are:

• 350 mL reservoir: length of stirrer 30 mm and o.d. 6 mm

• 1100 mL reservoir: length of stirrer 35 mm and o.d. 6 mm

The appropriate mixing rate is a function of application and retentate volume and can
be adjusted by the control software. At low retentate volume, the stirrer and the float
will be in contact such that the stirrer will rotate the float.

Under these conditions, a low mixing rate is selected as default by the control soft-
ware. At higher retentate volume where the float is not in contact with the stirrer, the
user can select a higher mixing rate. The following rates are recommended as maxi-
mum mixing rates that provide sufficient mixing for all conditions:

• 350 mL reservoir: 200 rpm

• 1100 mL reservoir: 300 rpm

As default, the UNICORN control software adjusts the mixing rate automatically de-
pending on the actual retentate volume.

An air filter (vent filter) can be connected to the top of the reservoir.

The reservoir consists of the following material:

• glass tube: borosilicate

• bottom end plate, top flange and lid: polyetherimide

• sealing lid: thermoplastic elastomer

• float: polypropylene

• stirrer: polytetrafluoroethylene
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15.4 pH electrode and cell holder
The pH electrode is optimized for continuous pH measurement in the permeate flow
path. The electrode is of the sealed combination double junction type. It contains a
sealed Ag/AgCl reference, which cannot be refilled, an internal electrolyte bridge of 4
M KCl saturated with Ag/AgCl, an outer electrolyte bridge of 1 M KNO3, an annular
ceramic reference junction, and a low profile pH membrane.

The pH electrode has a glass tip and the cell holder is made of titanium. The whole as-
sembly is replaceable.

The pH electrode should be calibrated regularly. This procedure is described in Sec-
tion 3.8 Calibrate the pH electrode, on page 53.
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15.5 Monitor UPC-980 and UV cell
The UV cell is designed for continuous measurement of UV absorbance. The UV mon-
itoring system provides high performance detection for the wavelength of 254 or 280
nm. Additional filters can be purchased to provide monitoring of the wavelengths
313, 365, 405, 436, and 546 nm. With the optional zinc lamp, the wavelength 214 nm
can be monitored.

The UV cell housing is made of PEEK. Other wetted parts are made of glass and titani-
um.

UV optical unit
The UV optical unit houses the lamp (Zn or Hg), the wavelength filter and the UV flow
cell. The light beam is directed through a flow-through cuvette to a photodetector.
The photodetector current is fed to the signal processing circuitry in the module.

Lamp

Filter

Optical Unit

Lens Beam splitter Flow cell

Inlet

Photodetector

Outlet
Photodetector

Vr Vs

Microprocessor

Analogue outputs

UPC-900

The reference signal comes from the same point in the lamp as the signal measuring
the sample, thus assuring a stable baseline by eliminating the effects of variations in
lamp intensity.

The Hg lamp emits light only at certain wavelengths. It does not emit light at 280 nm,
so for this wavelength, the light is converted at a fluorescent surface before it passes
the filter. On the lamp housing, there is a special exit for 280 nm light, which means
that the lamp position needs to be changed when working with this wavelength.

For 214 nm wavelength, a Zn lamp is used. This lamp is larger than the Hg lamp and is
therefore mounted in a larger lamp housing.

The lamp connectors are keyed to inform the monitor software of which lamp type is
connected.
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15.6 Conductivity cell
The cell has two cylindrical titanium electrodes positioned in the flow path of the cell.
An alternating voltage is applied between the electrodes and the resulting current is
measured and used to calculate the conductivity of the buffer. The system controls
the AC frequency and increases it with increasing conductivity between 50 Hz and 50
kHz, giving maximum linearity and true conductivity values.

The conductivity is automatically calculated by multiplying the measured conduc-
tance by the cell constant of the cell. The cell constant is precalibrated on delivery but
can be measured with a separate calibration procedure. This procedure is described
in Section 3.9 Calibrate the conductivity cell, on page 55.

One of the electrodes has a small temperature sensor for measuring the tempera-
ture of the buffer in the cell. Temperature variations influence the conductivity and in
some applications, when very precise conductivity values are required, it is possible
to program a temperature compensation factor that recalculates the conductivity to
a set reference temperature.
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15.7 Sensors
The ÄKTAcrossflow system is equipped with four pressure sensors, one level sensor,
and one air sensor.

Pressure sensors

Pres-
sure
sensor
PF

Located close to the CFF cassette/car-
tridge in the feed line to measure the feed
pressure.

Pres-
sure
sensor
PR

Located close to the CFF cassette/car-
tridge in retentate line to measure the re-
tentate pressure.

Pres-
sure
sensor
PP

Located close to the CFF cassette/car-
tridge in the permeate line to measure
the permeate pressure.

Pres-
sure
sensor
PT

Located upstream of the reservoir, the
transfer pressure sensor is used to main-
tain safe operation by measuring the
pressure in the reservoir.

The liquid chamber in the PT sensor hous-
ing is equipped with a thin titanium mem-
brane. A strain gauge is attached to the
rear side of the membrane. When the liq-
uid pressure increases, the titanium
membrane bulges, which is detected by
the strain gauge.

The pressure is shown on the computer display. To protect the system, a maximum
and minimum pressure limit can be set in UNICORN for pressure sensors PF, PR and
PP.
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The pressure sensors have a pressure range of 0–10 bar (100 kPa, 145 psi). The pres-
sure sensor housing is made of PEEK. Other wetted parts are made of titanium and
stainless steel.

Reservoir level sensor
The reservoir level sensor is located in the reservoir bottom end plate. The level sen-
sor also has the function of low volume alarm for the reservoir.

The signal of the level sensor is used to maintain a consistent volume in the reservoir
during constant volume operations (fed batch concentration and diafiltration). Fur-
thermore, the level sensor facilitates efficient product removal procedures at the end
of the filtration process in case that any entrainment of air in the recirculation line is
not desirable.

The level sensor has a pressure range of 0–100 mbar (10 kPa, 1.45 psi).

A temperature sensor is integrated with the reservoir level sensor, and allows for
continuous measurement of the liquid feed to the CFF cassette/cartridge.

CAUTION
The reservoir level sensor is highly sensitive. Do not insert any ob-
jects into the cavity in the bottom end plate of the reservoir since
this may damage the level sensor.

Air sensor 925
The sample air sensor is a high precision monitor designed for continuous monitoring
of air bubbles in the flow path for the sample inlet. The air sensor is made of PEEK.

The air sensor makes sure that the maximum volume of external feed can be trans-
ferred into the system without any risk for introducing air into the transfer line. When
air is detected, the system is either paused, or performs an action that is set in the
method.

Avoiding air in the transfer line is necessary to provide the high volume accuracy of
the transfer pump and thereby the accuracy of the retentate volume content.
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Appendix A

Membrane and cartridge selection

Cell processing
When selecting membranes for clarification, smaller pore size filters resist fouling
more than filters with larger pore sizes such as 0.45 or 0.65 μm. A general guideline is
to select the smallest pore size ratings that is at least 10× larger than the size of the
target protein in it largest state or longest dimension. When working with lysates,
which can contain a wide range of particle sizes and many types of proteins and
sticky cell components, choosing a small pore size can help prevent fouling of the
membrane pores.

When selecting cartridges, the presence of particles in the feed stream requires the
selection of short path length cassettes (30 to 60 cm) with large lumen diameters
(0.75 to 1.0 mm). See Section B Tubing specifications, on page 334.

Concentration and diafiltration
A membrane with a molecular weight cutoff that is too large will allow the molecule
of interest to pass through and significantly reduce yields. Conversely a membrane
with too small an molecular weight cutoff will reduce flux and lead to slower process-
ing times, oversized systems, increased capital cost, and plant space requirements,
working volume and hold-up volume. For typical membrane-based crossflow appli-
cations, the membrane pore size selection is based on the size of the target mole-
cule.

The general guideline for selecting a membrane for product concentration is to start
with a molecular weight cutoff that is 3 to 5 times smaller than the target molecule.
For example, a 50 kD or 30 kD membrane would be a suitable choice to retain IgG
(160 kD), and a 30 kD or 10 kD membrane would be a suitable choice for albumin (66
kD).
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Appendix B

Tubing specifications

The ÄKTAcrossflow is supplied with two tubing kits for the recirculation line to ac-
commodate applications and filters run at low and high flow rates as follows:

• Tubing with an inner diameter of 1.7 mm (Small) for low flow rate applications
(typically < 80 mL/min feed flow rate)

• Tubing with an inner diameter of 2.9 mm (Large) for high flow rate applications
(typically > 80 mL/min feed flow rate)

The system holdup volume and thus the working volume is minimized when using
tubing with the small diameter.

Note: The working volume is reservoir volume + system holdup volume + cas-
sette/cartridge holdup volume.

Table 16.1: Recommended combinations of filters and tubing diameters

Filter cassette/cartridge Application Recommended tubing

Flat sheet, 100 cm2 UF/DF S = i.d. 1.7 mm

Flat sheet > 100 cm2 UF/DF L = i.d. 2.9 mm1

Hollow fiber, Start AXH UF/DF S = i.d. 1.7 mm

Hollow fiber, Start AXM UF/DF S = i.d. 1.7 mm2

Hollow fiber, Start AXM MF L = i.d. 2.9 mm

1 Small i.d. tubing might be applicable depending on application.
2 Large i.d. tubing may be applicable for high flow/high viscosity.

Table 16.2: Recommended tubing for Start AXM hollow fiber membrane cartridges

Tub-
ing

length
(mm)

o.d.
(mm)

i.d.
(mm)

Vol-
ume
(mL)

Mate-
rial

Location
from

Location to

F1S 300 3 1.7 0.68 PVDF Valve block R-
VB

Cartridge,
feed inlet
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Tub-
ing

length
(mm)

o.d.
(mm)

i.d.
(mm)

Vol-
ume
(mL)

Mate-
rial

Location
from

Location to

F1L 300 4.76
(3/16")

2.9 1.98 ETFE

R1S 200 3 1.7 0.45 PVDF Cartridge, re-
tentate

outlet

Sensor PR, in-
let

R1L 200 4.76
(3/16")

2.9 1.32 ETFE

P1S 155 3 1.7 0.35 PVDF Cartridge,

permeate
outlet

Sensor PP, in-
let

P1L 150 4.76
(3/16")

2.9 0.99 ETFE

Table 16.3: Recommended tubing for Start AXH hollow fiber membrane cartridges

Tub-
ing

length
(mm)

o.d.
(mm)

i.d.
(mm)

Vol-
ume
(mL)

Mate-
rial

Location
from

Location to

F1S 200 3 1.7 0.45 PVDF Valve block R-
VB

Cartridge,
feed inlet

R1S 200 3 1.7 0.45 PVDF Cartridge, re-
tentate

outlet

Sensor PR, in-
let

P1S 155 3 1.7 0.35 PVDF Cartridge,

permeate
outlet

Sensor PP, in-
let

Retentate volume setup
The retentate volume is the sum of the retentate holdup volume and the liquid vol-
ume in the reservoir:

RetVol = RetentateHoldupVolume + ResVol

The reservoir volume in the ÄKTAcrossflow system is based on pumped volumes re-
ported by the pumps. In order to calculate the correct retentate volume, user-de-
fined input on the retentate holdup volume is required. The retentate holdup volume
is the sum of system holdup volume (in components and tubing) and the retentate
volume in the filter:
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RetentateHoldupVolume = system holdup volume + filter volume

The system holdup volume depends on the tubing configuration.

System holdup volume and
recommended minimum working
volume

Recircula-
tion tub-
ing kit

Feed tub-
ing

Retentate
tubing

Permeate
tubing

System
holdup
volume
(mL) 1

Minimum working vol-
ume (mL) 2

350 mL
reservoir

1100 mL
reservoir

Small i.d.

(1.7 mm)

F1S 200 R1S 200 P1S 155 18.2 24 (22.2) 40 (26.2)

Small i.d.

(1.7 mm)

F1S 300 R1S 200
P1S 155 18.4 24 (22.4) 45 (26.4)

F1S 200 R1S 300

Large i.d.

(2.9 mm)

F1L 200 R1L 300 P1L 150 25.8 32 (29.8) 50 (33.8)

F1L 300 R1L 200

1 System holdup volumes do not account for filter volume: RetentateHoldupVolume = system holdup volume + filter vol-
ume.

2 Recommended minimum working volume accounts for accuracy in control and measurement of the retentate volume.
The figures in brackets state typical values for the lowest possible working volume (excluding filter volume).
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Hollow fiber cartridges with UNF
fittings

Name Cut-
off

Inner
diam-
eter
(mm)

Lengt
h
(cm)

Num-
ber of
fibers

Nom-
inal
area
(cm2)

Feed
flow
rate
2000-
16000
s-1

Flux
range
low =
10
LMH

Flux
range
high =
80
LMH

30-200L
/m2 vol
chal-
lenge

Start
AXH

3 kD 0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

10 kD 0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

30 kD 0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

100
kD

0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

300
kD

0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

500
kD

0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.12-0.8
0

Start
AXH

750
kD

0.5 60 4 40 8.5-66
mL/mi
n

0.7
mL/mi
n

5.3
mL/mi
n

0.13-0.8
4

Start
AXM

500
kD

1.0 30 6 50 70-60
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

750
kD

1.0 30 6 50 70-60
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0
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Name Cut-
off

Inner
diam-
eter
(mm)

Lengt
h
(cm)

Num-
ber of
fibers

Nom-
inal
area
(cm2)

Feed
flow
rate
2000-
16000
s-1

Flux
range
low =
10
LMH

Flux
range
high =
80
LMH

30-200L
/m2 vol
chal-
lenge

Start
AXM

3 kD 0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

10 kD 0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

30 kD 0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

100
kD

0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

300
kD

0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

500
kD

0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXH

750
kD

0.5 30 12 50 25-20
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

0.1
μm

1.0 30 6 50 70-60
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

B Tubing specifications

338  ÄKTAcrossflow User manual 29360935 AA



Name Cut-
off

Inner
diam-
eter
(mm)

Lengt
h
(cm)

Num-
ber of
fibers

Nom-
inal
area
(cm2)

Feed
flow
rate
2000-
16000
s-1

Flux
range
low =
10
LMH

Flux
range
high =
80
LMH

30-200L
/m2 vol
chal-
lenge

Start
AXM

0.2
μm

1.0 30 6 50 70-60
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

0.45
μm

1.0 30 6 50 70-60
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0

Start
AXM

0.65
μm

0.75 30 8 50 40-32
0
mL/mi
n

0.8
mL/mi
n

6.7
mL/mi
n

0.15-1.0
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Appendix C

Technical specifications

Transfer pump and permeate
pump P-982

Flow rate 0.1–200 mL/min

Increment 0.1 mL

Pressure 0–520 kPa (5.2 bar, 75.4 psi)

Flow rate accuracy 0.5% actual volume within range (2–200 mL/min, 3.0
- 5.0 bar)

Pulsation   Max. ± 10% at inlet side (with inlet flow 10 mL/min, 4
bar)

Max. ± 20% at outlet side (with outlet flow 10 mL/
min, 4 bar)

Flow rate reproducibility rsd < 0.15% (0.1–200 mL/min, 3.0 - 5.0 bar)

Viscosity 0.8 - 5.0 cP

Internal volume 3050 μL including check valves

Feed pump P-984

Flow rate 0.1–600 mL/min

Increment 0.1 mL

Pressure 0–520 kPa (5.2 bar, 75.4 psi)

Flow rate accuracy < ± 2% actual volume within range (2 - 600 mL/min,
2.0 - 5.2 bar)
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340  ÄKTAcrossflow User manual 29360935 AA



Pulsation   Max. ± 10% at inlet side (with inlet flow 10 mL/min, 4
bar)

Max. ± 20% at outlet side (with outlet flow 10 mL/
min, 4 bar)

Flow rate reproducibility rsd < 0.3% (2 - 600 mL/min, 2.0 - 5.2 bar)

Viscosity 0.8–5.0 cP

Internal volume 6100 μL including check valves

Liquid exchange be-
tween product side and
rinsing system

< 4.5 ppm of pumped volume

UV measurement, Monitor
UV-980

UV cell path length 2 mm

UV cell flow area 1.6 mm2

UV cell total holdup vol-
ume

0.21 mL

Baseline adjust Adjustable 0–100% of full scale

Static drift ± 100 × 10-6 AU/h at 254 nm

Autozero range -0.2–2.0 AU

Absorbance range 0.01–5 AU

pH measurement, Monitor pH/
C-980

pH range 0–14

(spec. valid between 2 and 12)
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Accuracytemperature
compensatednot tem-
perature compensated

  ± 0.1 pH units within 4°C - 40°C

± 0.2 pH units within 15°C - 25°C

± 0.5 pH units within 4°C–15°C and 25°C–40°C

Response time Max. 10 s (0–95% of step)

Long-term drift Max. 0.1 pH units/10 h

Flow rate sensitivity Max. 0.1 pH units within

0–100 mL/min

Max. pressure 0.5 MPa (5 bar, 72 psi)

Internal volume, pH cell
holder

240 μL

Conductivity measurement,
Monitor pH/C-980

Conductivity range 1 μS/cm to 250 mS/cm

Deviation from theoreti-
cal conductivity

Max. ± 2% of full scale calibrated range or ±10 μS/cm
whichever is greater in the range 1 μS/cm to 250
mS/cm

Reproducibilityshort-
termlong-term

  Max. ± 1% or ± 5 μS/cm

Max. ± 3% or ± 15 μS/cm

Noise Max. ± 0.5% of full scale calibrated range

Response time Max. 3 s (0–95% of step)

Flow rate sensitivity ± 1% within 0–400 mL/min

Max. pressure 2 MPa (20 bar, 290 psi)

Internal volume, conduc-
tivity cell

180 μL

Membrane valves

Max. pressure 520 kPa (5.2 bar, 75.4 psi)
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Internal volume

T-VB 1 and 2

P-VB

 570 μL (closed)

570 μL (closed)

Valve principle Stepper motor-controlled membrane

Rocker valve

Max. pressure 520 kPa (5.2 bar, 75.4 psi)

Internal volume

R-VB, retentate side

R-VB, feed side

540 μL (closed)

390 μL (closed)

Valve principle Stepper motor-controlled membrane

Control valves R-PCV and P-PCV

Max. pressure 520 kPa (5.2 bar, 75.4 psi)

Internal volume

R-VB, retentate side

R-VB, feed side

 540 μL, 520 μL (closed)

540 μL, 520 μL (closed)

Valve principle Solenoid-actuated rocker

Flow restrictor (Transfer line)

Back pressure Min. 3 bar

Internal volume 570 μL

Valve principle Spring-loaded cone
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Transfer purge valve

Max. pressure 520 kPa (5.2 bar, 75.4 psi)

Internal volume 600 μL, 580 μL (closed)

Valve principle Solenoid-actuated rocker, membrane coated

Reservoirs

Max. volume

Without float

With float

 375 mL, 1200 mL350 mL, 1100 mL

Mixing principle Magnetic stirrer

Pressure sensors PF, PR, PP

Pressure range Up to 1 MPa (10 bar, 145 psi)

Pressure accuracy ± 0.01 bar

Internal volume:PF

PR, PP

 565 μL

340 μL

Pressure sensor PT

Pressure range 0–2.5 MPa (25 bar, 362 psi)

Pressure accuracy < ± 2%

Internal volume 294 μL

Reservoir level sensor

Pressure range 0–100 mbar (10 kPa, 1.45 psi)
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Reproducibility in empty
reservoir detection

± 0.2 mL

Drift under constant re-
tentate volume opera-
tion

± 0.1 mbar (10 Pa) over 4 hours, valid for temperature
changes ≤ 1 ºC/hour (for water, a hydrostatic pres-
sure of 10 Pa corresponds to approx. 2.8 mL in the
small reservoir, and 6.4 mL in the large reservoir)

Temperature sensor
Integrated with reservoir level sensor

Accuracy ± 1°C

(valid for temperature difference < 5°C between liq-
uid temperature and ambient temperature)

Air sensor 925

Max. pressure 2.5 MPa (25 bar, 362 psi)

Internal volume 190 μL
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Buffer conditioning
description, 97
preproduct step dialog, 108
preproduct visualization,
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C

Cell harvesting, 15
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D

Diafiltration
visualization, 168

F

Filter CIP
description, 94, 178
postproduct visualization,
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preproduct visualization,
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assembly, 33
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description, 24

Flush
description, 178
postproduct visualization,
193

H

Hollow fibre cartridges
assembly, 33
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recommended, 337–339

I
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L

Level sensor
calibration, 47

Lysate clarification, 16

M

Microfiltration
desciption, 15

N

Notes and tips, 8

P

pH electrode
calibration, 53

Piston rinse system
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sanitization, 218
use, 39

Pressure sensor
calibration, 52

R

Reservoir
float sanitization, 218

Rinsing
description, 94
preproduct step dialog, 106
preproduct visualization,
114

S

Safety notices, 7
Storage
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T

Temperature sensor
calibration, 55

Transmembrane pressure, 11
Tubing

connect to cartridge, 34
Typographical conventions, 8

U

Ultrafiltration
description, 13
experimental planning, 202
results, 208

UNICORN
base, 60
create method, 62
method description, 59
system control module, 89
text instructions, 73
watch and hold, 60

W

Water flush
description, 95, 179
postproduct visualization,
197
preproduct step dialog, 106
preproduct visualization,
119

Water flux test
description, 96, 180
postproduct visualization,
198
preproduct step dialog, 107
preproduct visualization,
120
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